OpenEdge Management and OpenEdge Explorer: Configuring Multi-tenancy
These materials and all Progress® software products are copyrighted and all rights are reserved by Progress Software Corporation. The information in these materials is subject to change without notice, and Progress Software Corporation assumes no responsibility for any errors that may appear therein. The references in these materials to specific platforms supported are subject to change.

Apama, Business Empowerment, Business Making Progress, Corticon, Corticon (and design), DataDirect (and design), DataDirect Connect, DataDirect Connect64, DataDirect XML Converters, DataDirect XQuery, Empowerment Center, Fathom, Making Software Work Together, OpenEdge, Powered by Progress, PowerTier, Progress, Progress Control Tower, Progress Dynamics, Progress Business Empowerment, Progress Empowerment Center, Progress Empowerment Program, Progress OpenEdge, Progress Profiles, Progress Results, Progress RPM, Progress Software Business Making Progress, Progress Software Developers Network, ProVision, PS Select, RulesCloud, RulesWorld, SequeLink, SpeedScript, Stylus Studio, Technical Empowerment, WebSpeed, Xcalia (and design), and Your Software, Our Technology—Experience the Connection are registered trademarks of Progress Software Corporation or one of its affiliates or subsidiaries in the U.S. and/or other countries. AccelEvent, Apama Dashboard Studio, Apama Event Manager, Apama Event Modeler, Apama Event Store, Apama Risk Firewall, AppsAlive, AppServer, BusinessEdge, Cache-Forward, DataDirect Cloud, DataDirect Spy, DataDirect SupportLink, Future Proof, High Performance Integration, OpenAccess, ProDataSet, Progress Arcade, Progress ESP Event Manager, Progress ESP Event Modeler, Progress Event Engine, Progress Responsive Process Management, Progress Software, PSE Pro, SectorAlliance, SeeThinkAct, SmartBrowser, SmartComponent, SmartDataBrowser, SmartDataObjects, SmartDataView, SmartDialog, SmartFolder, SmartFrame, SmartObjects, SmartPanel, SmartQuery, SmartViewer, SmartWindow, WebClient, and Who Makes Progress are trademarks or service marks of Progress Software Corporation and/or its subsidiaries or affiliates. Any other marks contained herein may be trademarks of their respective owners.

Third party acknowledgements — See the table of contents for the "Third Party Acknowledgements" appendix.

For the latest documentation updates see OpenEdge Product Documentation on PSDN (http://communities.progress.com/pcos/docs/DOC-16076).
Contents

Preface .......................................................... 7

1. Introducing multi-tenancy in OpenEdge Management and OpenEdge Explorer 17
   Working with multi-tenancy in the Database Administration Console ........ 18
   Additional OpenEdge Management/OpenEdge Explorer enhancements ......... 22
   Common terminology ......................................... 25
      Tenant ......................................................... 25
      Area .......................................................... 25
      Partition ..................................................... 25
      Group ........................................................ 25
      Default area ............................................... 25
      Allocation .................................................. 26

2. Configuring database connections ........................................ 27
   Understanding database connection types .................................... 28
      Reviewing the remote configuration requirements ...................... 29
   Ungluing OpenEdge Management/OpenEdge Explorer from OpenEdge .. 29
   Setting up the local host machine ....................................... 30
   Setting up the remote container ....................................... 30
   Establishing a database connection ..................................... 31
      Setting up the connection ..................................... 31
   Providing database connection user credentials .......................... 35
      User credentials considerations ................................ 35
   Database connection credentials for a regular tenant or super-tenant ... 35
   Security administrators ........................................... 36
   Filtering of database connections by container name ..................... 37

3. Managing multi-tenant databases ........................................ 39
   Enabling a database for multi-tenancy .................................. 40
   Managing a multi-tenant database ..................................... 41
      Viewing database connection details ................................ 41
      Reviewing database features .................................... 42
      Reviewing the database security summary ............................ 42
Contents

4. Working with tenants .................................................. 79
   Creating a new tenant for a multi-tenant database .......... 80
   Allocating tenant partitions ........................................ 80
   Specifying an alternate buffer pool .............................. 81
   Using a tenant configuration program ......................... 81
   Creating a new tenant or tenant program............. 82
   Editing a tenant ......................................................... 88
   Adding a tenant domain .............................................. 90
   Adding a user to a tenant ........................................... 92
   Generating a tenant program from an existing tenant .... 93
   Deleting a tenant ....................................................... 94
   Deleting a tenant domain .......................................... 95
   Deleting a tenant user .............................................. 96
   Enabling a table for multi-tenancy .............................. 97
   Selecting one or more tables to enable for multi-tenancy .... 97
   Enabling or disabling access to tenant data ............. 100
   Determining if tenant data access is enabled ...... 100
   Enabling or disabling access .................................... 101
   Deallocating tenant tables ...................................... 102

5. Updating tenant schema .............................................. 105
   Uploading schema for a multi-tenant database .......... 106
   Selecting and loading the data definition file. ........ 106
   Previewing the contents of an uploaded data definition file ...... 107
   Configuring an area working set ................................ 110
   Editing storage area assignments for regular tenants .... 112
   Committing changes to a multi-tenant database .......... 113
   Monitoring data definition file updates to the database .... 115

6. Managing users and domains in a multi-tenant database ....... 117
   Managing users in a multi-tenant database ............. 118
   Managing domains in a multi-tenant database ........... 121
   Managing authentication systems .............................. 124
   Managing multi-tenant database table security for users ... 126
   Reviewing user data security permissions ................. 129
   Configuring database security options ...................... 130
   Configuring database security administrators ............. 131
   Setting up a database connection login ...................... 132
   Reviewing user access in the Data Administration Console ...... 133
<table>
<thead>
<tr>
<th>Figures</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Figure 1</td>
<td>Management console menu bar</td>
<td>22</td>
</tr>
<tr>
<td>Figure 2</td>
<td>Multiple tabs open in the management console</td>
<td>22</td>
</tr>
<tr>
<td>Figure 3</td>
<td>Database Administration menu options</td>
<td>23</td>
</tr>
<tr>
<td>Figure 4</td>
<td>Database Administration New options</td>
<td>23</td>
</tr>
<tr>
<td>Figure 5</td>
<td>Connections breadcrumbs</td>
<td>23</td>
</tr>
<tr>
<td>Figure 6</td>
<td>Multi-tenancy Tasks viewlet in OpenEdge Explorer</td>
<td>24</td>
</tr>
<tr>
<td>Figure 7</td>
<td>Area details</td>
<td>68</td>
</tr>
<tr>
<td>Figure 8</td>
<td>Domain details</td>
<td>69</td>
</tr>
<tr>
<td>Figure 9</td>
<td>Schema details</td>
<td>70</td>
</tr>
<tr>
<td>Figure 10</td>
<td>Tenants list</td>
<td>70</td>
</tr>
<tr>
<td>Figure 11</td>
<td>Tenant’s users list</td>
<td>73</td>
</tr>
<tr>
<td>Figure 12</td>
<td>Domains list</td>
<td>74</td>
</tr>
<tr>
<td>Figure 13</td>
<td>Partitions details</td>
<td>75</td>
</tr>
<tr>
<td>Figure 14</td>
<td>Sort and column selection options</td>
<td>76</td>
</tr>
<tr>
<td>Figure 15</td>
<td>Properties pane</td>
<td>77</td>
</tr>
<tr>
<td>Figure 16</td>
<td>Asynchronous task status when editing a tenant</td>
<td>89</td>
</tr>
<tr>
<td>Figure 17</td>
<td>Data definition file preview</td>
<td>107</td>
</tr>
<tr>
<td>Figure 18</td>
<td>Hats By Eloise data definition preview</td>
<td>112</td>
</tr>
<tr>
<td>Figure 19</td>
<td>Multi-tenancy Tasks viewlet</td>
<td>115</td>
</tr>
<tr>
<td>Figure 20</td>
<td>Tenant templates list</td>
<td>145</td>
</tr>
</tbody>
</table>
Preface

This Preface contains the following sections:

- Purpose
- Audience
- Organization
- Using this manual
- Typographical conventions
- Examples of syntax descriptions
- OpenEdge messages
Preface

Purpose

This manual describes how you can use the Database Administration Console in OpenEdge Management and OpenEdge Explorer to configure and manage OpenEdge databases that are enabled for multi-tenancy. Not only can you manage tenants and multi-tenant data from the management console, you can do so in a newly designed user interface that incorporates efficient and easy-to-use navigational improvements.

Audience

This manual is intended for OpenEdge Management and OpenEdge Explorer users as well as OpenEdge Management database and system administrators.

Organization

Chapter 1, “Introducing multi-tenancy in OpenEdge Management and OpenEdge Explorer”

Describes how to work with multi-tenancy. The chapter also describes the management console navigational enhancements and defines some commonly used terms related to multi-tenancy.

Chapter 2, “Configuring database connections”

Describes database connection types, how to establish a connection to a database, and how to filter database connections. The chapter also provides information about providing required user credentials when working with multi-tenancy enabled databases.

Chapter 3, “Managing multi-tenant databases”

Describes how to enable a database for multi-tenancy and how to manage the database’s areas, domains, groups, schemas, and tenants.

Chapter 4, “Working with tenants”

Describes how to work with tenants, such as creating, editing, or deleting a tenant; enabling a table for multi-tenancy; or enabling or disabling access to tenant data.

Chapter 5, “Updating tenant schema”

Describes how to upload and commit schema changes to a database enabled for multi-tenancy; how to configure an area working set; and how to edit storage area assignments for regular tenants.
Chapter 6, “Managing users and domains in a multi-tenant database”

Describes how to manage users and domains, manage multi-tenant database table security for users, and how to configure database security administrators.

Chapter 7, “Working with tenant templates”

Describes how to create, use, and edit tenant templates; view a list of tenant templates; and create a tenant from a template.

Chapter 8, “Working with sequences”

Describes how to work with sequences, edit sequence values, and export sequences for a tenant.

Chapter 9, “Working with tenant groups”

Describes how to create, use, and edit tenant groups or group programs; remove a tenant from a group; and search for and view available groups.

Chapter A, “Third Party Acknowledgements”

Using this manual

OpenEdge® provides a special purpose programming language for building business applications. In the documentation, the formal name for this language is ABL (Advanced Business Language). With few exceptions, all keywords of the language appear in all UPPERCASE, using a font that is appropriate to the context. All other alphabetic language content appears in mixed case.

For the latest documentation updates, see the OpenEdge Product Documentation category on PSDN (http://communities.progress.com/pcom/docs/DOC-16074).

References to ABL compiler and run-time features

ABL is both a compiled and an interpreted language that executes in a run-time engine. The documentation refers to this run-time engine as the ABL Virtual Machine (AVM). When the documentation refers to ABL source code compilation, it specifies ABL or the compiler as the actor that manages compile-time features of the language. When the documentation refers to run-time behavior in an executing ABL program, it specifies the AVM as the actor that manages the specified run-time behavior in the program.

For example, these sentences refer to the ABL compiler’s allowance for parameter passing and the AVM’s possible response to that parameter passing at run time: “ABL allows you to pass a dynamic temp-table handle as a static temp-table parameter of a method. However, if at run time the passed dynamic temp-table schema does not match the schema of the static temp-table parameter, the AVM raises an error.” The following sentence refers to run-time actions that the AVM can perform using a particular ABL feature: “The ABL socket object handle allows the AVM to connect with other ABL and non-ABL sessions using TCP/IP sockets.”
References to ABL data types

ABL provides built-in data types, built-in class data types, and user-defined class data types. References to built-in data types follow these rules:

- Like most other keywords, references to specific built-in data types appear in all **UPPERCASE**, using a font that is appropriate to the context. No uppercase reference ever includes or implies any data type other than itself.
- Wherever `integer` appears, this is a reference to the `INTEGER` or `INT64` data type.
- Wherever `character` appears, this is a reference to the `CHARACTER`, `LONGCHAR`, or `CLOB` data type.
- Wherever `decimal` appears, this is a reference to the `DECIMAL` data type.
- Wherever `numeric` appears, this is a reference to the `INTEGER`, `INT64`, or `DECIMAL` data type.

References to built-in class data types appear in mixed case with initial caps, for example, `Progress.Lang.Object`. References to user-defined class data types appear in mixed case, as specified for a given application example.

Typographical conventions

This manual uses the following typographical conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold</strong></td>
<td>Bold typeface indicates commands or characters the user types, provides emphasis, or the names of user interface elements.</td>
</tr>
<tr>
<td><em>Italic</em></td>
<td>Italic typeface indicates the title of a document, or signifies new terms.</td>
</tr>
<tr>
<td><strong>SMALL, BOLD CAPITAL LETTERS</strong></td>
<td>Small, bold capital letters indicate OpenEdge key functions and generic keyboard keys; for example, <code>GET</code> and <code>CTRL</code>.</td>
</tr>
<tr>
<td><code>KEY1+KEY2</code></td>
<td>A plus sign between key names indicates a <strong>simultaneous</strong> key sequence: you press and hold down the first key while pressing the second key. For example, <code>CTRL+X</code>.</td>
</tr>
<tr>
<td><code>KEY1 KEY2</code></td>
<td>A space between key names indicates a <strong>sequential</strong> key sequence: you press and release the first key, then press another key. For example, <code>ESCAPE H</code>.</td>
</tr>
<tr>
<td><strong>Syntax:</strong></td>
<td></td>
</tr>
<tr>
<td>Fixed width</td>
<td>A fixed-width font is used in syntax statements, code examples, system output, and filenames.</td>
</tr>
<tr>
<td><em>Fixed-width italics</em></td>
<td>Fixed-width italics indicate variables in syntax statements.</td>
</tr>
<tr>
<td><strong>Fixed-width bold</strong></td>
<td>Fixed-width bold indicates variables with special emphasis.</td>
</tr>
</tbody>
</table>
Examples of syntax descriptions

In this example, ACCUM is a keyword, and aggregate and expression are variables:

Syntax

```
ACCUM aggregate expression
```

FOR is one of the statements that can end with either a period or a colon, as in this example:

```
FOR EACH Customer NO-LOCK:
    DISPLAY Customer.Name.
END.
```
In this example, **STREAM stream**, **UNLESS-HIDDEN**, and **NO-ERROR** are optional:

**Syntax**

```
DISPLAY [ STREAM stream ] [ UNLESS-HIDDEN ] [ NO-ERROR ]
```

In this example, the outer (small) brackets are part of the language, and the inner (large) brackets denote an optional item:

**Syntax**

```
INITIAL [ constant [ , constant ] ]
```

A called external procedure must use braces when referencing compile-time arguments passed by a calling procedure, as shown in this example:

**Syntax**

```
( &argument-name )
```

In this example, **EACH**, **FIRST**, and **LAST** are optional, but you can choose only one of them:

**Syntax**

```
PRESELECT [ EACH | FIRST | LAST ] record-phrase
```

In this example, you must include two expressions, and optionally you can include more. Multiple expressions are separated by commas:

**Syntax**

```
MAXIMUM ( expression , expression [ , expression ] ... )
```

In this example, you must specify **MESSAGE** and at least one **expression** or **SKIP [ (n) ]**, and any number of additional **expression** or **SKIP [ ( n )]** is allowed:

**Syntax**

```
MESSAGE { expression | SKIP [ ( n ) ] } ... 
```

In this example, you must specify **{include-file, then optionally any number of argument of &argument-name = "argument-value", and then terminate with }**:

**Syntax**

```
( include-file 
  [ argument | &argument-name = "argument-value" ] ... )
```
Long syntax descriptions split across lines

Some syntax descriptions are too long to fit on one line. When syntax descriptions are split across multiple lines, groups of optional and groups of required items are kept together in the required order.

In this example, WITH is followed by six optional items:

Syntax

```
WITH [ ACCUM max-length ] [ expression DOWN ]
[ CENTERED ] [ n COLUMNS ] [ SIDE-LABELS ]
[ STREAM-IO ]
```

Complex syntax descriptions with both required and optional elements

Some syntax descriptions are too complex to distinguish required and optional elements by bracketing only the optional elements. For such syntax, the descriptions include both braces (for required elements) and brackets (for optional elements).

In this example, ASSIGN requires either one or more field entries or one record. Options available with field or record are grouped with braces and brackets:

Syntax

```
ASSIGN { [ FRAME frame ] { field [ = expression ] }
[ WHEN expression ] } ...
| { record [ EXCEPT field ... ] }
```

OpenEdge messages

OpenEdge displays several types of messages to inform you of routine and unusual occurrences:

- **Execution messages** inform you of errors encountered while OpenEdge is running a procedure; for example, if OpenEdge cannot find a record with a specified index field value.
- **Compile messages** inform you of errors found while OpenEdge is reading and analyzing a procedure before running it; for example, if a procedure references a table name that is not defined in the database.
- **Startup messages** inform you of unusual conditions detected while OpenEdge is getting ready to execute; for example, if you entered an invalid startup parameter.
After displaying a message, OpenEdge proceeds in one of several ways:

- Continues execution, subject to the error-processing actions that you specify or that are assumed as part of the procedure. This is the most common action taken after execution messages.

- Returns to the Procedure Editor, so you can correct an error in a procedure. This is the usual action taken after compiler messages.

- Halts processing of a procedure and returns immediately to the Procedure Editor. This does not happen often.

- Terminates the current session.

OpenEdge messages end with a message number in parentheses. In this example, the message number is 200:

```
** Unknown table name table. (200)
```

If you encounter an error that terminates OpenEdge, note the message number before restarting.
Obtaining more information about OpenEdge messages

In Windows platforms, use OpenEdge online help to obtain more information about OpenEdge messages. Many OpenEdge tools include the following Help menu options to provide information about messages:

- Choose Help→Recent Messages to display detailed descriptions of the most recent OpenEdge message and all other messages returned in the current session.
- Choose Help→Messages and then type the message number to display a description of a specific OpenEdge message.
- In the Procedure Editor, press the HELP key or F1.

On UNIX platforms, use the OpenEdge pro command to start a single-user mode character OpenEdge client session and view a brief description of a message by providing its number.

To use the pro command to obtain a message description by message number:

1. Start the Procedure Editor:

   OpenEdge-install-dir/bin/pro

2. Press F3 to access the menu bar, then choose Help→Messages.

3. Type the message number and press ENTER. Details about that message number appear.

4. Press F4 to close the message, press F3 to access the Procedure Editor menu, and choose File→Exit.
Introducing multi-tenancy in OpenEdge Management and OpenEdge Explorer

OpenEdge Management/OpenEdge Explorer now includes multi-tenancy configuration functionality, which allows you to manage and work with databases enabled for multi-tenancy. From the management console, you can access the Database Administration Console and perform a variety of different tasks, such as adding a local or remote database connection definition; creating new tenants and viewing their areas, domains, and partitions; uploading and previewing schema updates; making storage area and allocation or deallocation decisions; filtering views; and creating and working with tenant templates and tenant groups.

You can also enable local and remote databases for multi-tenancy, convert tables to multi-tenancy, and establish and manage user and table security settings. Support for viewing, exporting, and editing values for sequences is also available. You can commit configuration changes you make and then view the progress of each transaction in a viewlet in the My Dashboard page.

This chapter provides the following information about multi-tenancy and OpenEdge Management/OpenEdge Explorer:

- Working with multi-tenancy in the Database Administration Console
- Additional OpenEdge Management/OpenEdge Explorer enhancements
- Common terminology
OpenEdge Management and OpenEdge Explorer have been enhanced to introduce support for OpenEdge database multi-tenancy. Through the Database Administration Console, which is incorporated into the management console, you can manage tenants and multi-tenant data from the management console. You can do so in a newly designed user interface that incorporates efficient and easy-to-use navigational improvements.

From the Database Administration Console, you can perform multi-tenancy configuration by:

- **Converting a non-multi-tenant database to one configured for multi-tenancy** — You can quickly enable multi-tenancy for a database.

- **Establishing connections to multi-tenant databases** — You can set up local and remote connections to managed databases or scripted databases. These databases appear automatically in the list of database resources in the management console.

  You can also set up unmanaged local or remote database connections. Depending on the type of connection you define, you can also edit, copy, and/or delete it.

- **Creating new database tenants, deleting tenants, or generating a tenant creation program** — You can create two types of tenants: a regular tenant or a super-tenant. You can also delete a tenant.

  Alternatively, you can generate a tenant program based on preferred settings for either an existing tenant or a new tenant. You can use the resultant generated program in the future to create a tenant quickly, without needing to resupply the settings saved in the program. You can also create a tenant from an existing tenant.

- **Enabling a table for multi-tenancy** — You can enable one or more tables for multi-tenancy and then allocate the table’s partitions.

- **Creating a tenant template** — You can create, view, and edit a template that includes tenant-specific details, such as default storage areas and per-object tenant mapping, so you can reuse the template to create another tenant.

- **Creating a tenant group** — You can create, view, and edit a tenant group and add one or more tenants to it. A group is a partition for a table and partitions for any of the LOB fields and indexes in the table. Each tenant in the group has shared access to the partition and its data.

  You can also generate a group creation program based on preferred settings, and use the program in the future to create a group quickly or that you can use to transfer a group from one database to another database.
• **Working with existing tenants and multi-tenant database objects** — You can work easily with existing tenants to accomplish various tasks related to multi-tenancy configuration, such as:
  
  – Viewing an alphabetical list of all tenants in the currently selected database.
  
  – Accessing utilities by selecting a tenant.
  
  – Viewing a tenant’s layout, including the database object schema, tenant object areas, and object properties. Color coding in the partition layout allows you to see easily each object’s allocation state.
  
  You can also view tenant partition details and choose how the data is displayed: within area panels or by columns in a grid format. The grid format allows you to choose the information you want to see (partition name, area, allocation state, and/or object type) and sort the information in ascending or descending alphabetical order.
  
  – Deciding when storage space is to be allocated for a tenant’s data: immediately, delayed (for now), or not at all. You can also deallocate a table for a tenant or a group, freeing up storage space.
  
  – Specifying storage area assignments for a tenant’s tables (which apply to their indexes and LOB fields). If you choose not to allocate storage space immediately when you create a tenant, you can reorganize the layout of the multi-tenant database objects, such as moving a table from one area to another area.
  
  – Filtering the tenant list so you can focus on specific tenants. For example, you can set up the list so that you see only regular tenants or tenants categorized by allocation rule.
  
  – Adding one or more tenant domains by choosing from a predefined domain list.
  
  – Adding one or more users to a tenant.
  
  – Searching for a particular tenant.
  
  – Selecting which of a tenant’s areas you want to see when you look at the tenant’s area layout. By choosing the areas you want to see, known as the area working set, you can focus only on areas of current interest to you.
  
  – Filtering the partition view by allocation state for a tenant or a tenant template.
  
  – Enabling or disabling access to a regular tenant’s data.

**Note:** The OpenEdge Management console displays an error when you update a multi-tenant database object that already has an exclusive lock from another multi-tenant data source.
Chapter 1: Introducing multi-tenancy in OpenEdge Management and OpenEdge Explorer

- **Loading and previewing a data definition file** — You can upload a data definition file (.df) and preview its contents (tables, LOB fields, indexes, and sequences) before you commit the changes.

- **Load database contents** — You can load table and group contents into an active database. The database must have table definitions before you can load table or group contents. The console uses the .d files to load table contents from a directory you specify or to load group contents from the subdirectory for groups you specify.

  **Note:** You must have administrator privileges to load table and group contents.

- **Dump database contents** — You can dump table or group data in a text format from the console. The console creates a text file that contains the dump data of each table or group you specify. This file has a .d extension and is stored in the work directory you specify. You can dump data either from a shared table, a multi-tenant table, or both. You can also dump data from a group of tenants sharing a table. You can use these .d files to load data into a database. The console creates a separate contents file for each table or group you dump.

  **Note:** You must have administrator privileges to dump table and group contents.

- **Committing and monitoring database updates** — You can commit updates to the database, either from an uploaded data definition file or as a result of other changes you make.

  As changes are being saved to the database, the **My Dashboard** page opens to allow you to monitor the updates’ progress. The page presents a task viewlet that shows the activity as the updates are being applied.

- **Filtering database connections by container** — You can view all database connections for all containers, or you can choose which container’s connections you want to view.

- **Managing domains** — You can create and modify a domain for each tenant.

- **Managing authentication systems** — You can view, create, or delete authentication systems.

- **Establishing and managing user and table security settings** — While you can create and work with users for a particular tenant, you can also create, edit, and delete users at the database level. You can define and review table and field security for the database users, and you can review a summary that provides details about the database’s security.

  You can also configure one or more security administrators who have control over authentication and authorization.
• **Managing sequence definitions and values** — You can manage sequences and sequence values by:
  
  – Viewing a list of all sequences in a database. This includes both the sequences enabled for multi-tenancy and those not enabled.

  – Viewing and editing the current values for multi-tenant-enabled sequences for a specific tenant.

  – Viewing and editing the current values for all tenants of a sequence.

  – Exporting sequence current values for one tenant, multiple tenants, or all tenants in a multi-tenant database.

  **Note:** Full access to a tenant’s sequences functionality requires a database connection for a user associated with either a super-tenant or that specific tenant.

• **Improve database performance** — The performance of a multi-tenant database may be improved by using multi-tenant governors: Login Governor (`-nGovernor`) and Lock Governor (`-LGovernor`). These governors limit the amount of each individual tenant’s allocation of shared database resources, so that one tenant does not fully control these resources at the expense of all of the other tenants. These governors apply to the default and regular tenants in a multi-tenant database. They do not apply to super-tenants.
Chapter 1: Introducing multi-tenancy in OpenEdge Management and OpenEdge Explorer

Additional OpenEdge Management/OpenEdge Explorer enhancements

In addition to the enhancements made to it to support multi-tenancy configuration, the management console has been redesigned to offer new and improved navigation in the following key areas:

- **New menu bar** — The menu bar in the management console has been enhanced so that each functional area provides access to a dropdown list of the relevant actions you can perform. The following overall areas of functionality are available: My Dashboard, Resources, Alerts, Library, Reports, Jobs, Database Administration (new), Options, and Help.

As shown in Figure 1, the Resources menu bar option provides access to various tasks from its dropdown list, including the creation of a new OpenEdge resource, such as a database or an AppServer, for monitoring and/or configuration in the console.

![Management console menu bar](image)

Figure 1: Management console menu bar

You can keep multiple menu bar options open at one time, which creates a row of tabs as shown in the OpenEdge Management console example in Figure 2. My Dashboard, Resources, Reports, and Jobs are all open, allowing you to switch easily from one area of functionality to another.

![Multiple tabs open in the management console](image)

Figure 2: Multiple tabs open in the management console
• **Database Administration** — From the new **Database Administration** menu bar option, shown in Figure 3, you can perform a number of tasks related to managing multi-tenancy, such as viewing available database connections, enabling multi-tenancy for tables, loading a data definition file, and viewing tenant templates.

![Database Administration menu options](image1)

**Figure 3:** Database Administration menu options

From **Database Administration** → **New** as shown in Figure 4, you can create a tenant, create a tenant template, create a group, or define a database connection.

![Database Administration New options](image2)

**Figure 4:** Database Administration New options

You can have more than one instance of Database Administration open at once, allowing you to work easily with more than one tenant.

• **Breadcrumbs** — New breadcrumbs related to database administration are available. For example, you can click the **Connections** option shown in Figure 5 to move between the list of database connections and the list of tabs for one particular database.

![Connections breadcrumbs](image3)

**Figure 5:** Connections breadcrumbs
• **Multi-tenancy Tasks viewlet in OpenEdge Explorer and OpenEdge Management** — A new **Multi-tenancy Tasks** viewlet, as shown in the **My Dashboard** page in OpenEdge Explorer in **Figure 6**, allows you to see a list of transactions as they are committed to the database.

![Figure 6: Multi-tenancy Tasks viewlet in OpenEdge Explorer](image)

The **My Dashboard** page was previously available only in OpenEdge Management but is now included in OpenEdge Explorer specifically to show the multi-tenancy task details. (OpenEdge Management continues to display additional viewlets not shown in OpenEdge Explorer.)
Common terminology

As you manage multiple tenants and multi-tenant database objects in OpenEdge Management/OpenEdge Explorer, there are several terms with which you will become familiar. These terms are described in the following sections.

Tenant

There are three types of tenants: default, regular, and super tenant.

The default tenant in a multi-tenant database is a user who does not establish tenancy as part of authentication to the database. Because the user has not established tenancy, the default tenant can access only shared table data within the database or the default partition of a multi-tenant table. There is only one default tenant per multi-tenant database.

A regular tenant can access its own data, data for any other tenants in the same tenant group, or data in shared tables. (A shared table is one whose data is available to all tenants in the database.)

A super-tenant does not have its own data but can access all shared tables and all multi-tenant data in the database.

Area

An area is a physical layout on disk and represents physical storage. An area can contain multiple partitions.

Partition

A partition is a logical organizing of data by tenant and by object (table, index, or LOB field) within an area. A partition is contained inside a single area.

For shared tables there is one partition per table, index, and LOB field. For multi-tenant tables there is one partition for each table, index, and LOB field per tenant.

Tenants in a group share the partitions for the table and each associated LOB field and index.

Group

A group is a partition for a table, along with partitions for the table’s LOB fields and indexes, that can be shared by tenants. All tenants in a group have access to the same data in the table. When you create a group, you create an independent partition that multiple tenants view.

Default area

When you convert an existing shared table to one enabled for multi-tenancy, you can decide whether to save the existing table data, known as the default area. If you are creating a new multi-tenant table, you can also decide whether to create (keep) the area for the default tenant.
Allocation

Creating a new tenant in an existing multi-tenant database results in the establishment of a new tenant partition for each existing multi-tenant table defined in the database. You can assign a specific storage area for each table, its indexes, and its LOB fields, or you can use the previously defined default locations.

You can also specify if or when partitions for a table should be allocated. The allocation decision you make for a table also applies to the table’s indexes and LOB fields.

You can deallocate a multi-tenant table from a tenant or a group. Deallocation can be helpful in freeing up storage space so that it is available for reuse.
Configuring database connections

The Database Administration Console provides you with the flexibility to work with a database on a machine that is local to or remote from where you have installed OpenEdge Management/OpenEdge Explorer. To perform tasks in the Database Administration Console, you must specify a connection to the database.

This chapter provides the following information related to configuring database connections:

- Understanding database connection types
- Establishing a database connection
- Providing database connection user credentials
- Filtering of database connections by container name
Understanding database connection types

The machine on which OpenEdge Management/OpenEdge Explorer is installed is know as the local host. The remote host where the database resides is known as the remote container.

All databases, whether on the local host or a remote container, must be OpenEdge Version 11.0.

You can configure the following database connections:

- A managed connection, which refers to a database that is either of the following:
  - Managed database — A database that is being managed by OpenEdge Management or OpenEdge Explorer. The database can reside on the local host or on a remote container. For a managed database, the connection is made through shared memory.
  - Scripted database — A database that you start with a script outside of the OpenEdge Management or OpenEdge Explorer environment. The database can reside on the local host or on a remote container.

- An unmanaged database connection, which refers to a database that:
  - Is not being managed by OpenEdge Management or OpenEdge Explorer.
  - You are using only to perform database administration tasks related to multi-tenancy.

This type of database connection is new in this release of OpenEdge.

You can work with a database on a remote container by doing the following:

1. Reviewing the remote configuration requirements
2. Ungluing OpenEdge Management/OpenEdge Explorer from OpenEdge
3. Setting up the local host machine
4. Setting up the remote container
Reviewing the remote configuration requirements

Remote configuration requires that you have:

- **On the local host** — One OpenEdge installation that includes OpenEdge Management or OpenEdge Explorer

- **On the remote host** — One installation of OpenEdge Release 11.0

On the remote host with the OpenEdge installation, neither OpenEdge Management nor OpenEdge Explorer can be enabled. If either is enabled, you must disable it in the OpenEdge product by running a script known as unglue.

For more information, see the “Ungluing OpenEdge Management/OpenEdge Explorer from OpenEdge” section on page 29. If OpenEdge Management/OpenEdge Explorer is already disabled on the remote container, you can begin setting up remote configuration; see the “Setting up the remote container” section on page 30.

Ungluing OpenEdge Management/OpenEdge Explorer from OpenEdge

If the host machine you plan to use as the remote container has OpenEdge Management/OpenEdge Explorer installed as part of OpenEdge, you must disable (unglue) it before you can set up remote configuration.

To unglue OpenEdge Management/OpenEdge Explorer from OpenEdge on the remote container:

1. Shut down the AdminServer.

2. To unglue on a Windows machine, select Start → Programs (or All Programs) → Progress → OpenEdge → Proenv. The Proenv window opens.

   To unglue on a UNIX machine, log in as root in a terminal window and then run Proenv. If you do not know the root password for your system, consult with your system administrator.

3. At the prompt or from the bin directory of the OpenEdge installation, type unglue, as shown here for a Windows install:

   ```
   install-dir\unglue
   ```

4. Type y at the prompt asking you if you want to continue, and then press ENTER.

You can now set up remote configuration on the local host, as described in the “Setting up the local host machine” section on page 30.
Setting up the local host machine

Once you unglue OpenEdge Management/OpenEdge Explorer from OpenEdge on the remote container, you can set up the local host machine.

To set up the local host machine:

1. Start OpenEdge Management/OpenEdge Explorer on the local host machine.
2. From the Windows Start menu, choose Start→Programs (or All Programs)→Progress→OpenEdge→Proenv. The Proenv window opens.
   
   On a UNIX machine, log in as root in a terminal window and then run Proenv.

3. At the prompt, type the following command:

   fmconfig -enable

4. When the configuration process finishes, restart the AdminServer.

You can now set up the remote container, as described in the “Setting up the remote container” section on page 30.

Setting up the remote container

Once you have set up the local host, you can set up the remote container.

To set up the remote container:

1. Shut down the AdminServer.

2. From the Windows Start menu, choose Start→Programs (or All Programs)→Progress→OpenEdge→Proenv. The Proenv window opens.

   On a UNIX machine, log in as root in a terminal window.

3. At the prompt, type the following command:

   fmconfig -host local-hostname -enable

   The local-hostname is the name of the host where OpenEdge Management or OpenEdge Explorer is running.

4. Press ENTER.

5. When the configuration process finishes, restart the AdminServer.

For additional details about remote configuration and using the unglue and glue scripts, see the “Setting Up Remote Resource Monitoring and Configuration” section in OpenEdge Management and OpenEdge Explorer: Getting Started. You can view this document online by choosing Help→Documentation from the management console.
Establishing a database connection

OpenEdge Management/OpenEdge Explorer allows you to work with multi-tenant databases and their schema from the Database Administration Console running in a Web browser. From the console, you can establish database connections, create tenants, edit tenant configuration, upload and preview schema updates, create tenant templates, create tenant groups, filter views, and commit updates and monitor their progress.

Once you install and configure OpenEdge Management/OpenEdge Explorer, you are ready to start managing multi-tenant databases and their objects. You begin by establishing a database connection. By default, connections for databases defined in OpenEdge Management/OpenEdge Explorer use the blank user ID.

However, you can set up the connection to provide user credentials (user name and password). The availability of certain features and functionality is dependent upon the permissions that exist for the user whose name and password establish the connection as well as on the type of tenant the user belongs to.

For more information, see the "Providing database connection user credentials" section on page 35.

Setting up the connection

To work with a database’s multi-tenant objects, you must set up a connection to the database and the database’s server must be running. The connection can be:

- To a local or remote managed database resource
- To a local or remote scripted database
- To a local or remote database using an unmanaged connection

Establishing a connection to a local or remote managed database resource

If the database is a resource already being managed by OpenEdge Management/OpenEdge Explorer, you can start the database through the management console by doing the following:

1. Log in to OpenEdge Management/OpenEdge Explorer.
2. Click Resources in the management console menu bar. The main resource types appear in the grid frame.
3. Select the database you want to start. You can start the database by doing either of the following:
   - Click Start brokers in the resource panel.
   - Click Start in the Resource Summary section.
   - Click the Edit icon for the selected database. The database’s details page appears. In the Command and control section of the page, click Control. The Database Control page appears. Click Start Database.

Once the database is running, you can select it as a database connection.
For a local or remote managed database in the database connections list, you can also:

- View details about a database connection on the database home page. For more information, see the “Managing multi-tenant databases” section on page 39.

- Copy a database connection. When you copy a connection, you are not copying the actual database resource; you are copying only the connection details. The connection copy does not represent a database resource being managed by OpenEdge Management/OpenEdge Explorer.

- Delete a database connection.

Establishing a connection to a local or remote scripted database

If the database is not being managed from within OpenEdge Management/OpenEdge Explorer, you can start the database on the machine where it is located (either the local host or a remote host) using the command line. You can then use the Database Administration Console to work with that database once you define a connection to it.

When you define a scripted database on a remote container, be sure to use localhost as the database’s host. This allows the ABL commands to execute on the remote container and connect to the database by using shared memory.

When you use localhost, the database is included in both the Resources list in OpenEdge Management/OpenEdge Explorer and the Database Administration Console’s Connections list. If you do not use localhost, the database is still listed as a resource but does not appear in the Connections list.

If you do not define the host as localhost for the scripted database on the remote container, you must add the database connection manually and specify the host and port required for the connection. In this case, the connection to the database is performed using the -H (host name) and -S (service name or port) parameters, and the database appears in the Connections list but not the Resources list in the management console.

To establish a connection to a scripted database:

1. On the machine where the scripted database resides (either the local host or a remote host), start Proenv (by choosing Start→Programs (or All Programs)→Progress→OpenEdge→Proenv).

2. Type the following command to start the database:

```
proserve { db-name | -servergroup [ server-group-name ] [ parameters ] }
```

3. Exit Proenv.

4. To add the database to the list of database resources, perform the following steps on the machine where OpenEdge Management/OpenEdge Explorer is installed.
5. Choose one:
   - Click **Resources** from the OpenEdge Management console menu bar. The **OpenEdge Management Resources** page appears.
     
     Click **New Resource Monitor**. The **New Resource Monitor** page appears.
   - Choose **Resources** → **New OpenEdge Resource** or **New System Resource**.

6. Choose **Scripted database**.

7. Complete the page:
   a. Provide the following information:
      - **Name** — Name of the database.
      - **Description** — A description of the database (optional).
   b. Choose the container name from the dropdown list.
   c. Type the host name.
   d. Provide an IP Address (optional).
   e. Select the TCP/IP version (IPv4 or IPv6).
   f. Type the complete path to the database.
   g. Click **Save**. The **Database** Details page appears.

8. Click **Control**.

9. Choose one:
   If you are connecting to a scripted database on the local host:
   a. Copy the command line from the **Command line to start Monitoring Agent**.
   b. Start **Proenv**, and paste the command line details at the prompt.
   c. Exit **Proenv**.

   If you are connecting to a scripted database on a remote host:
   a. On the local host, note the command line from the **Command line to start Monitoring Agent**.
   b. Start **Proenv** on the remote machine.
   c. Type the command line details at the prompt.
   d. Exit **Proenv**.

10. From the management console on the local host, return to the **Database** Details page. The database and the database agent are now running.
For a local or remote scripted database in the database connections list, you can also:

- View details about a scripted database connection on the database home page. For more information, see the “Managing multi-tenant databases” section on page 39.
- Copy a scripted database connection.

**Establishing a connection to an unmanaged local or remote database connection**

An unmanaged database connection refers to a database that is not being managed by OpenEdge Management/OpenEdge Explorer and that you are using only to perform database administration tasks related to multi-tenancy.

You can start an unmanaged database connection (located on the local host or a remote host) by using the command line. You can then use the multi-tenancy configuration tool to work with that database once you define a connection to it.

1. On the machine where the scripted database resides (either the local host or a remote host), start Proenv (Start → Programs (or All Programs) → Progress → OpenEdge → Proenv).

2. Type the following command to start the database:

   ```
   proserve { db-name | -servergroup [ server-group-name ] [ parameters ] }
   ```

3. From the management console menu bar on the machine where OpenEdge Management/OpenEdge Explorer is installed, choose **Database Administration** → **New** → **Database Connection**. (Alternatively, you can click **New** from the **Connections** list in the list frame.)

4. Provide the following information:

   - **Connection name** — The name of the database connection
   - **Database name** — The full path to the database
   - **Container** — The name of the database container

5. Click **Save**.

For a local or remote unmanaged database connection in the database connections list, you can also:

- View details about an unmanaged database connection on the database home page. For more information, see the “Managing multi-tenant databases” section on page 39.
- Copy an unmanaged database connection.
- Delete an unmanaged database connection.
Providing database connection user credentials

Each database connection is based on a set of user credentials. The availability of certain database and multi-tenancy features and functionality is dependent upon the permissions that exist for the user whose credentials establish the connection, as well as upon the type of tenant the user belongs to. For example, certain users can read data and write to the database, but not delete data; and a super-tenant can view and edit sequence values for all tenants, whereas a regular tenant user can do so only for the tenant the user belongs to.

Access to certain multi-tenancy configuration features might be restricted, disabled, or hidden based on the credentials (user ID and password) provided for the database connection.

User credentials considerations

By default, a connection for a database defined in OpenEdge Management/OpenEdge Explorer uses a blank user ID, in which no user name or password is required. However, if you are a database administrator working with multi-tenant databases, you must consider how to manage tenants effectively and the role that user credentials play in the tenants’ successful management.

OpenEdge Management/OpenEdge Explorer permits only one set of user credentials (user ID and password) per database connection; it does not, however, require the credentials. Any user with a login to OpenEdge Management/OpenEdge Explorer can see any database connection defined in it. Passwords are encrypted and stored internally and are not visible in the user interface.

Because of this default structure, you may need to establish or change database connection credentials. You may also need to establish multiple database connections for the same database to allow performance of specific tasks as different users.

Database connection credentials for a regular tenant or super-tenant

In order to access tenant data, you must set up the database connection to use the credentials for either a user for a regular tenant or for a super-tenant. Because super-tenant’s can access all users’ data, establishing a database connection as a super-tenant will allow you to perform operations such as dumping and loading of data and editing sequences for any tenant. If you establish a connection with the credentials of a user for a regular tenant, you can perform operations for only that tenant.

Regardless of how you set up the connection, the operations you can perform are defined by the user data security permissions defined for the database in a series of Can-\(^{-}\)\*\(\) actions. (For more information, see the "Managing multi-tenant database table security for users" section on page 126.) You can use wildcards to allow the performance of certain operations that any user would normally be permitted to do. Likewise, you can restrict which users can perform specific tasks. For example, by default any user can create a tenant. You can prevent this by setting up the Can-Create action to permit only a select user to do so.
Security administrators

Keep in mind that a database may have one or more security administrators in place. A security administrator has the authority to create and delete database users, which includes tenant users. If your database has security administrators configured and you must be able to manage users from within OpenEdge Management/OpenEdge Explorer, be sure that the database credentials you use to establish the database connection have security administrator rights.
Filtering of database connections by container name

You can view all database connections for all containers, or you can filter the database connections that appear in the **Connections** list by container name. If you have several containers, each of which has multiple connections, filtering allows you to focus on only the connections for a particular container.

**To filter the database connections by container name:**

1. From the management console, choose **Database Administration → Database Connections**. The list of connections appears in the list frame on the left.

2. Click **Filter**. The **Container name** field appears:

3. Select a container from the dropdown list. The filtering begins and, when completed, presents a list of database connections for only that container:
Managing multi-tenant databases

You can establish a connection to a database that is enabled for multi-tenancy. You can also connect to a database that is not enabled for multi-tenancy, and then enable multi-tenancy for the database from the Database Administration Console.

This chapter provides the following information related to managing databases enabled for multi-tenancy:

- Enabling a database for multi-tenancy
- Managing a multi-tenant database
- Viewing multi-tenant database areas, domains, schemas, tenants, and groups
Enabling a database for multi-tenancy

You can enable a database for multi-tenancy from the Database Administration Console.

To enable a database for multi-tenancy:

1. Choose Database Administration → Database Connections.
2. Highlight the database connection in the list, and click View. The database home page appears. (For additional information about the database home page, see the “Managing a multi-tenant database” section on page 41.)
3. In the Database Features panel, verify the Multi-tenancy status:

   ![Database Features panel](image)

   (Note that you can click the Sort arrow to display the features in ascending or descending order.)

   If the status is a check mark in a green circle and the word Enable does not appear in the Action column, the database is already enabled for multi-tenancy.
4. Click Enable.
5. Click Enable Multi-tenancy. A message appears confirming that the database is now multi-tenant.
6. Click OK. The database home page appears, and the multi-tenancy status for the database reflects that the database is now enabled:
Managing a multi-tenant database

Once you establish a connection to a database enabled for multi-tenancy, you can:

- Use the database connection home page to manage and view various details about multi-tenancy users, domains, authentication systems, and security for the database.

  To access the database home page, choose **Database Administration**→**Database Connections** in the management console. From the **Connections** list, select the database and click **View**. The database home page appears in the right pane.

- View and work with the areas, domains, schemas (tables, LOB fields, indexes, and sequences), tenants, and groups that belong to the database.

Viewing database connection details

From the database home page, you can see various database details that assist you in managing multi-tenancy. The multi-tenancy-related actions you can perform from the home page are dependent upon the type of database connection you define. For a managed database, a scripted database, or an unmanaged database connection, you can:

- Manage and edit a database connection.

- Review database connection features; for example, you can see if the database is enabled for multi-tenancy or has support for 64-bit sequences.

- Manage, edit, and review database security settings for users, and create one or more security administrators.

- View a security summary, which includes details about various characteristics of the database, such as whether establishing user credentials with a blank user id is allowed; how many database users exist; how many tenants are defined in the database; and additional statistics. Once you review the summary information, you can edit certain database options, modify user or domain properties, or create a tenant.

  Note that if the database whose summary you are viewing is not enabled for multi-tenancy, the summary does not include any of the details that relate specifically to multi-tenancy.

- Perform data administration by editing sequences and their current values, exporting sequences, or previewing and/or loading a data definition file.

For an unmanaged database, you can also delete the database connection from the database home page.
Chapter 3: Managing multi-tenant databases

Reviewing database features

From the database home page, you can review a database feature status list. The status for each feature that is enabled appears as a check mark in a green circle.

If you are reviewing features for a database that is not enabled for multi-tenancy, you can enable multi-tenancy for the database from the Database Features panel. For more information, see the “Enabling a database for multi-tenancy” section on page 40.

To review database features:

1. Choose Database Administration → Database Connections.
2. Choose the database connection from the list, and click View. The database home page appears.
3. Scroll through the entries in the Database Features panel to see the status of one or more database features, such as large keys, 64-bit sequences, or 64-bit database keys. You can click the Sort arrow below the Feature Name column heading to sort the features in ascending or descending order.

A status appears for a feature as long as the feature is enabled, with the exception of multi-tenancy. The status for multi-tenancy appears whether or not the database is enabled as multi-tenant. If multi-tenancy is not enabled, the Database Features panel provides that detail. You can then enable multi-tenancy for the database directly from that panel. For more information, see the “Enabling a database for multi-tenancy” section on page 40.

Reviewing the database security summary

From the database home page, you can review security information and work with different multi-tenancy components.

Note that if the database whose summary you are viewing is not enabled for multi-tenancy, you do not see any of the details that relate specifically to multi-tenancy. You can enable the database for multi-tenancy by clicking Enable in the Action column in the Database Features panel, also on the database home page. For more information, see the “Enabling a database for multi-tenancy” section on page 40.

To review the database security summary:

1. Choose Database Administration → Database Connections.
2. Choose the database connection from the list, and click View. The database home page appears.
3. Review the following information about the database provided in the Security Summary panel:

- **Blank userid access** — Whether users are allowed to connect using the blank user id.

- **Security administrator** — Whether there is a security administrator defined for the database. You create a security administrator by clicking **Edit security administrator**. For more information, see the “Configuring database security administrators” section on page 131.

- **Security options** — Security options for a database. For more information, see the “Reviewing user access in the Data Administration Console” section on page 133.

- **Users** — The number of users in the database.

- **Domains** — The total number of domains (active and disabled) in the database.

- **Disabled domains** — The number of disabled (inactive) domains in the database.

- **Tenants** — The total number of tenants in the database. This number includes the default tenant, super-tenants, and named regular tenants.

- **Super-tenants** — The number of super-tenants in the database.

- **Named regular tenants** — The number of named regular tenants in the database. This number excludes the super-tenants and the default tenant.

**Working with the database from the security summary**

In addition to reviewing the details in the database security summary, you can also manage database functionality from the summary.

You can select:

- **Edit security options** to define security options for your database.

- **Edit users** to open the **Users** page, where you can review, add, or delete users.

- **Edit domains** to open the **Domains** page, where you can review, add, or delete domains.

- **Create tenant** to open the **New Tenant** page, where you can create a tenant for the database.

- **Edit authentication systems** to open the **Authentication Systems** page, where you can view, create, or delete authentication systems.

- **Edit data security** to access the user data security page and set or remove user permissions for the data.

- **Review user data security** to review the data security permissions for a particular user.
Chapter 3: Managing multi-tenant databases

Reviewing sequences details

From the Data Administration panel in the database home page, you can view and edit sequences and export sequence values.

To review sequence details:

1. Choose Database Administration→Database Connections.

2. Choose the database connection from the list, and click View. The database home page appears.

3. From the Data Administration panel, choose one:
   - Click Edit sequences. The Sequences properties page appears, with a list of the sequence names and entries for current values for both multi-tenant-enabled and non-multi-tenant-enabled sequences.
     For information about editing sequences, see the “Editing sequence values” section on page 154.
   - Click Export sequences. The Export sequences current value page appears.
     For information about exporting sequences, see the “Exporting sequences for a tenant” section on page 157.

Loading a data definition file

From the Data Administration panel in the database home page, you can load a data definition file that you can then preview and/or load.

To load a data definition file:

1. Choose Database Administration→Database Connections.

2. Choose the database connection from the list, and click View. The database home page appears.

3. From the Data Administration panel, click Load data definitions (.df file).

For information about loading, previewing, and committing a data definition file, see the “Uploading schema for a multi-tenant database” section on page 106.
Managing a multi-tenant database

Loading database contents

The Database Administration console of OpenEdge Management or OpenEdge Explorer enables you to load table and group contents into an active database. The database must have table definitions before you can load table or group contents. The console uses the .d files to load table contents from a directory you specify or to load group contents from the sub-directory for groups you specify. By default, the .d files used for loading table contents is stored in the work directory C:\OpenEdge\WRK and the .d files used for loading group contents is stored in the groups sub-directory of the work directory.

Note: You must have administrator privileges to load table and group contents.

Loading table contents to a database

The Database Administration console uses the .d files to load table contents from the sub-directory for tables you specify.

To load table contents:

1. Click Database Administration in the OpenEdge Management or OpenEdge Explorer console. The Database Administration tab appears.

2. From Database Administration in the OpenEdge Management or OpenEdge Explorer menu, do one of the following:
   - Click the Database Administration drop-down → Load data and definitions → Table Contents (.d files).
   - From the Connections section on the left pane, select an active database connection to which you want to load table contents. The Database Connection Details page appears. In the Data Administration section, click Load table contents (.d file).

The Load Table Contents page for the selected database connection appears, as shown:
In the **Database connection** field, enter a database connection name that contains the database into which you want to load the table contents. By default, the last used database connection name appears in the **Database connection** field.

You can select another database connection by entering a database name in the **Database connection** field.

**Note:** If you type the name of the database connection, follow the format used by OpenEdge Management/OpenEdge Explorer to define a connection: `container-name.database-name`. A database server must be running for you to connect to the database.

You can also click the **Search** icon to choose a database for which you are creating the tenant from the **Connection Selection** dialog, as shown:

The **Connection Selection** dialog displays the connections details in a grid. You can perform the following:

- Filter the connections in the grid by **Connection name**, **Container**, and/or **Category**.
- Select the column heading and click the drop-down to choose the order (ascending or descending alphabetically) for the connections to appear in the grid.

**Note:** When you select a database connection name, the **Database connection** field displays the selected database connection name. Most of the other fields get auto-populated with the default values, based on the selected database connection name.
4. In the **Load root directory** field, specify a file path of the contents (.d) file. By default, this field displays the work directory `C:\OpenEdge\WRK`.

5. Select **Include LOB** to enable importing of large database objects, such as images. By default, this check box is selected.

6. In the **LOB sub-directory** field, specify a sub-directory name that contains the large database objects that you want to load. By default, this field displays `lobs` and this sub-directory is contained in the default work directory `C:\OpenEdge\WRK`.

7. In the **Acceptable error percentage** field, specify an acceptable error percentage. The default value is **0**.

8. In the **Group sub-directory** field, specify a sub-directory name which contains group contents in .d files. By default, this field displays `groups` and this sub-directory is contained in the default work directory `C:\OpenEdge\WRK`.

9. Select the **Skip secured tables** check box, if you do not want to load secured tables.

10. Select the **Do not load group tables** check box, if you do not want to load the group tables.

11. Select the **Skip missing directories** check box, to skip validating the missing sub-directories mentioned under the root directory when loading table contents.

12. Select one of the following options for **Tables**:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>All</strong></td>
<td>Load contents to all shared and multi-tenant tables. By default, this option is selected.</td>
</tr>
<tr>
<td><strong>All shared tables</strong></td>
<td>Load contents to all shared tables only.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This option is available only for multi-tenant database connections.</td>
</tr>
<tr>
<td><strong>All multi-tenant tables</strong></td>
<td>Load contents to all multi-tenant tables only.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This option is available only for multi-tenant database connections.</td>
</tr>
<tr>
<td><strong>Selected</strong></td>
<td>Load content either to one or many, shared and/or multi-tenant tables. This option appears both for multi-tenant and non-multi-tenant database connections. Selecting this option displays the <strong>Selected Tables</strong> section.</td>
</tr>
</tbody>
</table>

1. Databases that are not enabled for multi-tenancy do not have shared or multi-tenant tables.
If you choose the **Selected** option for **Tables**, the **Selected Tables** section appears, as shown:

![Selected Tables Screenshot]

In the **Selected Tables** section, do the following:

a. In the **Table name** field, enter a table name. You can specify a keyword, use the wildcard operator *, or a combination of both.

b. In the **Database area** field, specify a database area name which contains the tables you want to view. When you type a keyword in this field, the console lists database areas matching your keyword. You can select a database area name. For example, if you type **Cu**, the console lists the database areas **Cust_Data** and **Cust_Index**.

c. Select one of the following options (available only for multi-tenant databases):
   - **Show shared and multi-tenant** — to view tables that are both shared and multi-tenant. By default, this option is selected.
   - **Show shared** — to view only shared tables.
   - **Show multi-tenant** — to view only multi-tenant tables.

d. Select the **Show hidden** check box to view any hidden tables from the database.
Managing a multi-tenant database

e. Click **Apply Filter**. Based on your search criteria, the **Selected Tables** section lists the table names and displays the following columns:

<table>
<thead>
<tr>
<th>Column name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schema</td>
<td>Displays whether the schema associated with the database table is public or user-defined. The default value is <strong>PUB</strong> which indicates that the default public schema is assigned to the OpenEdge database.</td>
</tr>
<tr>
<td>Table name</td>
<td>Displays the name of tables in an ascending alphabetical order.</td>
</tr>
<tr>
<td>Area</td>
<td>Displays the area in the database in which the table resides.</td>
</tr>
<tr>
<td>Multi-Tenant</td>
<td>Displays true for multi-tenant tables and false for shared tables.</td>
</tr>
<tr>
<td>Description</td>
<td>Displays details associated with the table name. This column is optional. To view this column, click any of the column’s drop-down and select <strong>Columns → Description</strong> check box.</td>
</tr>
</tbody>
</table>

13. Select **Tenants** based on whether you access the database as a regular or a super user.

**Note:** In the case of multi-tenant database connections, you must provide either regular or super user credentials to dump or load tenant data. Refer to “Managing users in a multi-tenant database” section on page 118. If you do not provide any credentials for database authentication, you can dump or load only default database tables.

- For regular tenant user credentials, **Tenants** displays a preselected radio button for the regular tenant and you can only load contents to the tables within that specific regular tenant. For example, the following image displays a regular tenant **Default**:
For super-tenant user credentials, **Tenants** displays two options for you to select and load contents to the tables included within these tenants:

You can choose **All** to select all the regular tenants or **Selected** to filter one or more tenants. Upon choosing **Selected**, the console displays the **Selected Tenants** section, as shown:

You can enter either a keyword, the wildcard operator 
\*, or a combination of the two in the **Tenant name** field. Click **Apply filter** to view the **Tenant name** and the **Description** in the respective columns. Use the check boxes to select or clear any of the tenant entries.

Optionally, you can click the columns drop-down to select options such as **Type**, **Id**, **External Id**, and **Data Enabled** to display the respective tenant properties. Similarly, you can clear the check box to remove any of the columns from the **Selected Tenants** view.

**Note:** The option for displaying tenants is not available for non-multi-tenant databases.
14. Click **Load**. A confirmation dialog appears for table data load displaying the number of shared and multi-tenant tables that will be loaded.

![Confirm task for table data load](image)

15. Do one of the following:

- Click **Commit** to load the contents of the selected tables. The *My Collections* page appears with the task listed in the *Multi-tenancy Tasks* section. If you do not find the task, click the refresh icon in the *Multi-tenancy Tasks* section to update the task list.

- Click **Commit & Monitor** to load the contents of the selected tables, and view the task page. This page lists the details of the load activity performed.

- Click **Cancel** to exit the dumping process.

When this operation is successful, the contents from the .d file in the load directory that you specify (in this case, the work directory C:\OpenEdge\WRK) are imported into the database tables.
Loading group contents to a database

The Database Administration console uses the .d files to load group contents from the sub-directory for groups you specify.

To load group contents:

1. Click Database Administration in the OpenEdge Management or OpenEdge Explorer console. The Database Administration tab appears.

2. From Database Administration in the OpenEdge Management or OpenEdge Explorer menu, do one of the following:

   - Click the Database Administration drop-down → Load data and definitions → Group Contents (.d files).

   - From the Connections section on the left pane, select an active database connection to which you want to load table contents. The Database Connection Details page appears. In the Data Administration section, click Load group contents (.d file).

The Load Group Contents page for the selected database connection appears, as shown:
3. In the **Database connection** field, enter a database connection name that contains the database into which you want to load the table contents. By default, the last used database connection name appears in the **Database connection** field.

You can select another database connection by entering a database name in the **Database connection** field.

**Note:** If you type the name of the database connection, follow the format used by OpenEdge Management/OpenEdge Explorer to define a connection: `container-name.database-name`. A database server must be running for you to connect to the database.

You can also click the **Search** icon to choose a database for which you are creating the tenant from the **Connection Selection** dialog, as shown:

![Connection Selection Dialog](image)

The **Connection Selection** dialog displays the connections details in a grid. You can perform the following:

- Filter the connections in the grid by **Connection name**, **Container**, and/or **Category**.
- Select the column heading and click the drop-down to choose the order (ascending or descending alphabetically) for the connections to appear in the grid.

**Note:** When you select a database connection name, the **Database connection** field displays the selected database connection name. Most of the other fields get auto-populated with the default values, based on the selected database connection name.
4. In the **Load root directory** field, specify a file path of the groups sub-directory which contains the contents (.d) file. By default, this field displays the work directory `C:\OpenEdge\WRK`.

5. Select **Include LOB** to enable importing of large database objects, such as images. By default, this check box is selected.

6. In the **LOB sub-directory** field, specify a sub-directory name that contains the large database objects that you want to load. By default, this field displays `lobs` and this sub-directory is contained in the default work directory `C:\OpenEdge\WRK`.

7. In the **Acceptable error percentage** field, specify an acceptable error percentage. The default value is 0.

8. In the **Group sub-directory** field, specify a sub-directory name which contains group contents in .d files. By default, this field displays `groups` and this sub-directory is contained in the default work directory `C:\OpenEdge\WRK`.

9. Select the **Skip secured tables** check box, if you do not want to load secured tables.

10. Select the **Skip missing directories** check box, to skip validating the missing sub-directories mentioned under the root directory when loading table contents.

11. Select one of the following options for **Groups**:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>All</strong>¹</td>
<td>Load contents to all groups. By default, this option is selected.</td>
</tr>
<tr>
<td><strong>Selected</strong></td>
<td>Load content either to one or many groups. Selecting this option displays the <strong>Selected Groups</strong> section.</td>
</tr>
</tbody>
</table>

¹. Databases that are not enabled for multi-tenancy do not have groups.
In the **Selected Groups** section, do the following:

**a.** In the **Group name** field, enter a group name. You can specify a keyword, use the wildcard operator *, or a combination of both.

**b.** Click **Apply Filter**. Based on your search criteria, the **Selected Groups** section lists the group names and displays the following columns:

<table>
<thead>
<tr>
<th>Column name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Group name</strong></td>
<td>Displays the name of groups in an ascending alphabetical order.</td>
</tr>
<tr>
<td><strong>Schema</strong></td>
<td>Displays whether the schema associated with the database table is public or user-defined. The default value is <strong>PUB</strong> which indicates that the default public schema is assigned to the OpenEdge database.</td>
</tr>
<tr>
<td><strong>Table</strong></td>
<td>Displays the table in the database with which the group is associated.</td>
</tr>
<tr>
<td><strong>Is allocated</strong></td>
<td>Displays true if space is allocated for objects in the group.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Displays details associated with the group name. This column is optional. To view this column, click any of the column’s drop-down and select <strong>Columns</strong> → <strong>Description</strong> check box.</td>
</tr>
</tbody>
</table>

12. Click **Load**. A confirmation dialog appears for table data load displaying the number of groups that will be loaded.
13. Do one of the following:

- Click **Commit** to load contents of the selected groups. The **My Collections** page appears with the task listed in the **Multi-tenancy Tasks** section. If you do not find the task, click the refresh icon in the **Multi-tenancy Tasks** section to update the task list.

- Click **Commit & Monitor** to load contents of the selected groups, and view the task page. This page lists the details of the load activity performed.

- Click **Cancel** to exit the dumping process.

When this operation is successful, the contents from the .d file in the groups sub-directory of the load directory you specify, (in this case, the work directory C:\OpenEdge\WRK) are imported into the database groups.

## Dumping database contents

The Database Administration console of OpenEdge Management or OpenEdge Explorer allows you to dump table or group data in a text format. The console creates a text file that contains the dump data of each table or group you specify. This file has a .d extension and is stored in the work directory you specify. The default work directory is C:\OpenEdge\WRK. You can dump data either from a shared table, a multi-tenant table, or both. You can also dump data from a group of tenants sharing a table. You can use the .d files to load data into a database. The console creates a separate contents file for each table or group you dump.

**Note:** You must have administrator privileges to dump table and group contents.

### Dumping table contents from a database

The Database Administration console allows you to dump table contents in a text format.

**To dump table contents:**

1. Click **Database Administration** in the OpenEdge Management or OpenEdge Explorer console. The **Database Administration** tab appears.

2. From **Database Administration** in the OpenEdge Management or OpenEdge Explorer menu, do one of the following:

   - Click the Database Administration drop-down → **Dump data and definitions** → **Table Contents (.d files).**

   - From the **Connections** section on the left pane, select an active database connection to which you want to load table contents. The **Database Connection Details** page appears. In the **Data Administration** section, click **Dump table contents (.d file).**
The **Load Table Contents** page for the selected database connection appears, as shown:

3. In the **Database connection** field, enter a database connection name that contains the database into which you want to load the table contents. By default, the last used database connection name appears in the **Database connection** field.

   You can select another database connection by entering a database name in the **Database connection** field.

   **Note:** If you type the name of the database connection, follow the format used by OpenEdge Management/OpenEdge Explorer to define a connection: `container-name.database-name`. A database server must be running for you to connect to the database.

   You can also click the **Search** icon to choose a database for which you are creating the tenant from the **Connection Selection** dialog, as shown:
The **Connection Selection** dialog displays the connections details in a grid. You can perform the following:

- Filter the connections in the grid by **Connection name**, **Container**, and/or **Category**.
- Select the column heading and click the drop-down to choose the order (ascending or descending alphabetically) for the connections to appear in the grid.

**Note:** When you select a database connection name, the **Database connection** field displays the selected database connection name. Most of the other fields get auto-populated with the default values, based on the selected database connection name.

4. In the **Dump root directory** field, specify a file path for the directory in which you want to store the contents (.d) file. By default, this field displays the work directory `C:\OpenEdge\WRK`.

5. Select **Include LOB** to enable exporting of large database objects, such as images. By default, this check box is selected.

6. In the **LOB sub-directory** field, specify a sub-directory name in which you want to store the large database objects. By default, this field displays `lobs` and this sub-directory is contained in the default work directory `C:\OpenEdge\WRK`.

7. In the **Code page** field, specify a value for code page. By default, this field displays `ISO8859-1`. For more information on code pages, see *OpenEdge Development: Internationalizing Applications*.

8. In the **Group sub-directory** field, specify a sub-directory name in which you want to store group contents. By default, this field displays `groups` and this sub-directory is contained in the default work directory `C:\OpenEdge\WRK`.

9. In the **Character mapping** field, specify **MAP** or **NO-MAP** for character mapping. For more information about character mapping, PROTERMCAP, and national language support, see *OpenEdge Development: Internationalizing Applications*.

10. Select the **Overwrite existing .d files** check box, to overwrite the existing .d file.

11. Select the **Do not dump secured tables** check box, if you do not want to dump secured tables.

12. Select the **Do not dump group tables** check box, if you do no want to dump group tables.

13. Select the **Do not validate code page** check box, to skip validating the value entered in the **Code page** field.
14. Select one of the following options for **Tables**:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Dump contents from all shared and multi-tenant tables. By default, this option is selected.</td>
</tr>
<tr>
<td>All shared tables</td>
<td>Dump contents from all shared tables only.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This option is available only for multi-tenant database connections.</td>
</tr>
<tr>
<td>All multi-tenant</td>
<td>Dump contents from all multi-tenant tables only.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This option is available only for multi-tenant database connections.</td>
</tr>
<tr>
<td>Selected</td>
<td>Dump content either from one or many, shared and/or multi-tenant tables. This option appears both for multi-tenant and non-multi-tenant database connections. Selecting this option displays the <strong>Selected Tables</strong> section.</td>
</tr>
</tbody>
</table>

1. Databases that are not enabled for multi-tenancy do not have shared or multi-tenant tables.

In the **Selected Tables** section, do the following:

a. In the **Table name** field, enter a table name. You can specify a keyword, use the wildcard operator *, or a combination of both.

b. In the **Database area** field, specify a database area name which contains the tables you want to view. When you type a keyword in this field, the console lists database areas matching your keyword. You can select a database area name. For example, if you type Cu, the console lists the database areas Cust_Data and Cust_Index.

c. Select one of the following options:
   - **Show shared and multi-tenant** — to view tables that are both shared and multi-tenant. By default, this option is selected.
   - **Show shared** — to view only shared tables.
   - **Show multi-tenant** — to view only multi-tenant tables.
d. Select the **Show hidden** check box to view any hidden tables from the database.

e. Click **Apply Filter**. Based on your search criteria, the **Selected Tables** section lists the table names and displays the following columns:

<table>
<thead>
<tr>
<th>Column name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Schema</strong></td>
<td>Displays whether the schema associated with the database table is public or user-defined. The default value is <strong>PUB</strong> which indicates that the default public schema is assigned to the OpenEdge database.</td>
</tr>
<tr>
<td><strong>Table name</strong></td>
<td>Displays the name of tables in an ascending alphabetical order.</td>
</tr>
<tr>
<td><strong>Area</strong></td>
<td>Displays the area in the database in which the table resides.</td>
</tr>
<tr>
<td><strong>Multi-Tenant</strong></td>
<td>Displays true for multi-tenant tables and false for shared tables.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Displays details associated with the table name. This column is optional. To view this column, click any of the column’s drop-down and select <strong>Columns</strong> → <strong>Description</strong> check box.</td>
</tr>
</tbody>
</table>

15. Select **Tenants** based on whether you access the database as a regular or a super user.

**Note:** In the case of multi-tenant database connections, you must provide either regular or super user credentials to dump or load tenant data. Refer to “Managing users in a multi-tenant database” section on page 118. If you do not provide any credentials for database authentication, you can only dump or load default database tables.

- For regular tenant user credentials, **Tenants** displays a preselected radio button for the regular tenant and you can only dump contents from the table within that specific regular tenant. For example, the following image displays a regular tenant **Default**.
Managing a multi-tenant database

- For super-tenant user credentials, **Tenants** displays two options for you to select and dump contents from the tables included within these tenants:

  - Choose **All** to select all regular tenants.
  - Choose **Selected** to filter one or more tenants. Upon choosing Selected, the console displays the **Selected Tenants** section. You can enter either a keyword, the wildcard operator *, or a combination of the two in the **Tenant name** field. Click **Apply filter** to view the **Tenant name** and the **Description** in the respective columns. Use the check boxes to select or clear any of the tenant entries.

    Optionally, you can click the columns drop-down to select options such **Type**, **Id**, **External Id**, and **Data Enabled** to display the respective tenant properties. Similarly, you can clear the check box to remove any of the columns from the **Selected Tenants** view.

**Note:** The option for displaying tenants is not available for non-multi-tenant databases.

16. Click **Dump**. A confirmation dialog appears for table data dump displaying the number of shared and multi-tenant tables that will be dumped.

17. Do one of the following:

  - Click **Commit** to dump contents of the selected tables. The **My Collections** page appears with the task listed in the **Multi-tenancy Tasks** section. If you do not find the task, click the refresh icon in the **Multi-tenancy Tasks** section to update the task list.

  - Click **Commit & Monitor** to dump contents of the selected tables, and view the task page. This page lists the details of the dump activity performed.

  - Click **Cancel** to exit the dumping process.

When this operation is successful, a contents (.d) file is created for each table in the dump directory you specify (in this case, the work directory C:\OpenEdge\WRK).
Chapter 3: Managing multi-tenant databases

Dumping group contents from a database

When you dump group contents using the Database Administration console, the .d file is created in a sub-directory of the work directory you specify. The default work directory is \OpenEdge\WRK.

To dump group contents:

1. Click Database Administration in the OpenEdge Management or OpenEdge Explorer console. The Database Administration tab appears.

2. From Database Administration in the OpenEdge Management or OpenEdge Explorer menu, do one of the following:
   - Click the Database Administration drop-down → Dump data and definitions → Group Contents (.d files).
   - From the Connections section on the left pane, select an active database connection whose group contents you want to dump. The Database Connection Details page appears. In the Data Administration section, click Dump group contents (.d file).

The Dump Group Contents page for the selected database connection appears, as shown:

3. In the Database connection field, enter a database connection name that contains the database into which you want to load the table contents. By default, the last used database connection name appears in the Database connection field.

You can select another database connection by entering a database name in the Database connection field.

Note: If you type the name of the database connection, follow the format used by OpenEdge Management/OpenEdge Explorer to define a connection: container-name.database-name. A database server must be running for you to connect to the database.
Managing a multi-tenant database

You can also click the **Search** icon to choose a database for which you are creating the tenant from the **Connection Selection** dialog, as shown:

The **Connection Selection** dialog displays the connections details in a grid. You can perform the following:

- Filter the connections in the grid by **Connection name**, **Container**, and/or **Category**.

- Select the column heading and click the drop-down to choose the order (ascending or descending alphabetically) for the connections to appear in the grid.

**Note:** When you select a database connection name, the **Database connection** field displays the selected database connection name. Most of the other fields get auto-populated with the default values, based on the selected database connection name.

4. In the **Dump root directory** field, specify a file path of the directory in which you want to store the contents (.d) file. By default, this field displays the work directory `C:\OpenEdge\WRK`.

5. Select **Include LOB** to enable exporting of large database objects, such as images. By default, this check box is selected.

6. In the **LOB sub-directory** field, specify a sub-directory name in which you want to store the large database objects. By default, this field displays `lobs` and this sub-directory is contained in the default work directory `C:\OpenEdge\WRK`.

7. In the **Code page** field, specify a value for code page. By default, this field displays `ISO8859-1`. For more information on code pages, see *OpenEdge Development: Internationalizing Applications*.
8. In the **Group sub-directory** field, specify a sub-directory name in which you want to store group contents. By default, this field displays groups and this sub-directory is contained in the default work directory `C:\OpenEdge\WRK`.

9. In the **Character mapping** field, specify **MAP** or **NO-MAP** for character mapping. For more information about character mapping, PROTERMCAP, and national language support, see *OpenEdge Development: Internationalizing Applications*.

10. Select the **Overwrite existing .d files** check box, to overwrite the existing dump (.d) file.

11. Select the **Do not dump secured tables** check box, if you do not want to dump secured tables.

12. Select the **Do not dump group tables** check box, if you do not want to dump group tables.

13. Select the **Do not validate code page** check box, to skip validating the value entered in the **Code page** field.

14. Select one of the following options for **Groups**:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| All
1          | Dump contents from all groups. By default, this option is selected.           |
| Selected    | Dump content either from one or many groups. Selecting this option displays the **Selected Groups** section. |

1. Databases that are not enabled for multi-tenancy do not have groups.
In the **Selected Groups** section, do the following:

a. In the **Group name** field, enter a group name. You can specify a keyword, use the wildcard operator `*`, or a combination of both.

b. Click **Apply Filter**. Based on your search criteria, the **Selected Groups** section lists the group names and displays the following columns:

<table>
<thead>
<tr>
<th>Column name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group name</td>
<td>Displays the name of groups in an ascending alphabetical order.</td>
</tr>
<tr>
<td>Schema</td>
<td>Displays whether the schema associated with the database group is public or user-defined. The default value is <strong>PUB</strong> which indicates that the default public schema is assigned to the OpenEdge database.</td>
</tr>
<tr>
<td>Table</td>
<td>Displays the table in the database with which the group is associated.</td>
</tr>
<tr>
<td>Is allocated</td>
<td>Displays true if space is allocated for objects in the group.</td>
</tr>
<tr>
<td>Description</td>
<td>Displays details associated with the group name. This column is optional. To view this column, click any of the column’s drop-down and select <strong>Columns</strong>→<strong>Description</strong> check box.</td>
</tr>
</tbody>
</table>

15. Click **Dump**. A confirmation dialog appears for group data dump displaying the number of groups that will be dumped.

16. Do one of the following:

   - Click **Commit** to dump contents of the selected groups. The **My Collections** page appears with the task listed in the **Multi-tenancy Tasks** section. If you do not find the task, click the refresh icon in the **Multi-tenancy Tasks** section to update the task list.

   - Click **Commit & Monitor** to dump contents of the selected groups, and view the task page. This page lists the details of the dump activity performed.

   - Click **Cancel** to exit the dumping process.

When this operation is successful, a contents (.d) file is created for each group in the `groups` sub-directory of the dump directory you specify (in this case, the work directory `C:\OpenEdge\WRK`).
Tuning multi-tenant database performance

There are two multi-tenant governors which you can use to improve the performance of multi-tenant databases. These governors limit each tenant’s access to the shared database resources. These multi-tenant governors are:

- Login Governor
- Lock Governor

Note: These governors are applicable to only the default tenant and regular tenant; these governors do not apply to a super-tenant. Also, these governors do not apply to non multi-tenant databases.

The Login Governor (Tenant Max User Governor) specifies the maximum number of users that may login for each tenant. The Lock Governor (Tenant Lock Table Governor(%) ) specifies the percentage of the lock table that any tenant can occupy. The database startup parameter for Tenant Max User Governor Login Governor is \(-n\)Governor and for Tenant Lock Table Governor(%) is \(-L\)Governor.

When a tenant attempts to acquire more locks than the governor allows, an error message is displayed as: Attempt to exceed tenant lock governor for tenant <tenantID>. Increase \(-L\) or \(-LGovernor\).

When a user attempts to login to a database and the available maximum number of logins for that tenant has been exceeded, an error message is displayed as: Attempt to exceed tenant login governor limit for tenant <tenant ID>. Increase \(-n\) or \(-nGovernor\).

The Database Administration console and the PROMON utility help you to monitor and change the governor values for these parameters.

To monitor and change the values of these multi-tenant governors using the Database Configuration page, see Chapter 2, “Viewing or modifying database properties”.

To monitor and change the values of these multi-tenant governors using the PROMON utility, see OpenEdge Data Management: Database Administration.
Viewing multi-tenant database areas, domains, schemas, tenants, and groups

Once you successfully set up a connection to a multi-tenant database, you can view its contents, specifically its areas, domains, schemas, tenants, and groups.

To view the multi-tenant database contents:

1. Ensure that the database server is running and that you have set up the database connection. (For more information, see the “Setting up the connection” section on page 31.)

2. Select **Database Administration** → **Database Connections**. The list of database connections appears in the list frame (on the left in the console):

   ![Database Connections](image)

3. Click the database connection whose contents you want to view. The database home page options appear in the details frame on the right, and the list frame on the left changes to show selections for **Areas**, **Domains**, **Schemas**, **Tenants**, and **Groups**:

   ![Database Options](image)

   The list frame also displays a **Connections** option, which allows you to return to the list of connections if you want to choose a different database.

You can now click any of the selections to choose the details you want to view, as described in the following sections.
Chapter 3: Managing multi-tenant databases

Viewing areas

Select Areas to view all the areas configured for the database. A list of areas appears in the list frame on the left. If you have a large number of areas, you can also move forward or backward a page, or specify a particular page, in the list of areas by using the Page feature at the bottom of the list.

To see details about an area and its extents, select the area in the list. The area and extent details appear, as shown in Figure 7.

![Figure 7: Area details](image)

The upper portion of the pane provides general details about the area; the lower portion focuses on the extents and provides information in a grid format. The grid allows you to see, for each extent, the extent number, the file name, the size of the extent, and whether the extent is fixed (true) or variable (false). You can sort on each column to view the information in ascending or descending order; simply click on the column name and then on the dropdown arrow, which is helpful when you have a database with many extents.
Viewing domains

Select **Domains** to view the domains available for the database. The list of domains appears in the list frame on the left. If you have a large number of domains, you can also move forward or back a page, or specify a particular page, in the list of domains by using the **Page** feature at the bottom of the list.

To see a domain’s details, as shown in **Figure 8**, select the domain in the list.

![Domain details](image)

**Figure 8:** Domain details
Chapter 3: Managing multi-tenant databases

Viewing schema

Select Schemas to view the schema for the database. The schema appears in the detail frame on the right; click a schema object to see its details, as shown in Figure 9 for a table named Customer.

![Schema details](image1.png)

Figure 9: Schema details

Viewing tenants

Select Tenants to view the Tenants list, as shown in Figure 10.

![Tenants list](image2.png)

Figure 10: Tenants list
From the **Tenants** list, you can select a particular tenant and view its details.

Since the number of tenants in a database can be large, the tenant list can become quite long, requiring you to scroll frequently as you view the tenants or modify schema objects and then apply the changes. To allow you to selectively choose which tenants you want to focus on and to reduce scrolling as you work with tenant objects, you can filter the tenant list by tenant type and/or partition allocation state.

You can also move forward or backward a page, or specify a particular page, in the list of tenants by using the **Page** feature at the bottom of the list.

You can also search for a particular tenant.

To see tenant details, find a tenant, or filter tenants in the view from the **Tenants** list, do one of the following:

- To see details about a tenant, select the tenant. The tenant home page appears in the detail frame:

(For a super-tenant, no **Tenant data access** link is shown.)

Click **Edit tenant**. The tenant's **General** details appear in the detail frame:
From this page, you can view the tenant’s users, domains, and partitions, as described in the “Viewing a tenant’s users” section on page 73, the “Viewing a tenant’s domains” section on page 74, and the “Viewing and filtering tenant partitions” section on page 75.

You can also view a tenant’s groups; for more information, see the “Using tenant groups” section on page 162.

- To search for a tenant, click Search tenants at the top of the Tenants list. Type part or all of the tenant’s name, and click Search:

The tenant (or tenants) whose name matches the search criteria is listed.

- To filter the tenants that appear in the Tenants list by tenant type or allocation state, click Filter:

The filter options list appears:

![Filter options](image)

By default, all the options are selected. Deselect any of the option(s) to filter out tenants of a particular type or those with a particular allocation state, and then click Apply. The entries in the Tenants list reflect only those tenants who match the criteria you selected.
Viewing a tenant’s users

You can view a list of a tenant’s users; you can also add a user to the tenant.

To see a list of users in the _user table for a tenant, as shown in Figure 11, select Users. To sort the information in the grid, click a column name and then click the dropdown arrow.

Figure 11: Tenant’s users list

You can filter the list of users by entering a user name in the User name field, and then clicking the Search icon. You can expand the filter option to search for users using a User ID and/or Domain name.

You can also move forward or backward a page, or specify a particular page, in the list of users by using the Page feature at the bottom of the list.

For information about adding a user to a tenant, see the “Adding a user to a tenant” section on page 92.
For information about setting up multi-tenant table security for users, see the “Managing multi-tenant database table security for users” section on page 126.

**Viewing a tenant’s domains**

You can view a list of a tenant’s domains; you can also add a domain and establish domain security.

To see a list of domains that exist for a selected tenant, select **Domains**. From the list, select a particular domain, as shown in **Figure 12**. To sort the information in the grid, click a column name and then click the drop-down arrow.

![Domains list](image)

**Figure 12: Domains list**
You can filter the list of domains by entering the domain name in the **Domain name** field as shown:

![Domain name filter](image)

You can also move forward or backward a page, or specify a particular page, in the list of domains by using the **Page** feature at the bottom of the list.

For information about adding a domain for a tenant, see the “Adding a tenant domain” section on page 90. For details about adding a domain to the database, see the “Managing domains in a multi-tenant database” section on page 121.

### Viewing and filtering tenant partitions

From the tenant’s general details, you can view more specific information about the tenant. You can also filter the details you see and use the predefined color-coding to provide a quick view of how partitions are allocated.

**Viewing partitions**

To view details about a tenant’s partitions, choose a tenant from the **Tenants** list, and click **Edit tenant** from the Tenant home page. From the tenant details, click **Partitions**; the partition details appear by default in one or more area panels, as shown in Figure 13. The predefined pink color coding shown in the figure indicates that the allocation state for the partitions is **Not allocated**.

![Partitions details](image)

**Figure 13:** **Partitions details**

(For details about what different predefined colors represent, see the “Interpreting the color legend” section on page 78.)
To switch from the area panels layout to a grid view, click the **View Grid** icon shown in **Figure 13**. The partitions details appear.

From the grid view, you can sort by ascending or descending alphabetical order in each of the following columns: **Partition Name**, **Area**, **Allocation State**, **object Type**, or **Buffer Pool**. You can also choose to hide any of the columns you do not want to view, or move the order of the columns. (If you cannot see the entire grid, adjust the width of the columns in the grid. You can also adjust the width of the other columns in the management console.)

To change the order of items in any column, select the column name and click the dropdown arrow that appears. From the menu, select the sort order as well as which columns to include in the grid, as shown in **Figure 14**.
To see details (in either layout) about the database schema from the **Partitions** view, expand the schema items as necessary; or select one of the partitions in the grid. The properties for the database object appear in the **Properties** pane, as shown in **Figure 15** for the *mtCustomer* table.

![Properties pane](image.png)

**Figure 15: Properties pane**

The **Properties** pane allows you to focus on details for one particular object by identifying the object’s name, type, the area where the object resides, buffer pool (primary or alternate), and the allocation state. (For more information about allocation state, see the “Allocating tenant partitions” section on page 80.)

**Filtering partitions for a tenant**

You can filter the view of partitions by allocation state from a tenant.

You can also filter the view of partitions by allocation state from a tenant template. For more information, see the “Filtering partitions from a tenant template” section on page 144.

**To filter partitions by allocation state from a tenant:**

1. From the tenant menu bar, click **Filter Partitions**. The filtering options appear:

   ![Filter options](image.png)

   All filtering options are selected by default. Click any option to toggle between selected and cleared.

2. Click **Apply filter** to implement the filtering.
Interpreting the color legend

So that you can quickly identify partitions by allocation state, each state corresponds to a particular color, as shown in the following legend:

To access the legend in the management console:

1. From the tenants list, select a tenant.
2. Click **Edit tenant** in the tenant home page.
3. Choose **Partitions**.
4. From the tenant menu bar, choose **Tools→Legends**.
Working with tenants

Using OpenEdge Management/OpenEdge Explorer, you can create a new tenant for a database enabled for multi-tenancy. You can also manage the tenant’s users and domains and delete a tenant.

This chapter provides the following information about working with tenants:

- Creating a new tenant for a multi-tenant database
- Editing a tenant
- Adding a tenant domain
- Adding a user to a tenant
- Generating a tenant program from an existing tenant
- Deleting a tenant
- Deleting a tenant domain
- Deleting a tenant user
- Enabling a table for multi-tenancy
- Enabling or disabling access to tenant data
- Deallocating tenant tables
Creating a new tenant for a multi-tenant database

Using the multi-tenancy configuration tool, you can create a new tenant for a database enabled for multi-tenancy. As you are creating the tenant, you can specify a schema storage area location for each type of multi-tenant database object (table, index, or LOB field). You can also determine if access to the tenant’s data should be enabled or disabled.

Once you finish specifying all the tenant’s settings, you can either:

- Create the tenant immediately.
- Generate a tenant configuration ABL program that you can use to create a tenant.

You can also create a new tenant from an existing tenant or from a tenant template. A tenant template defines common general and partition settings, making it easier for you to create the new tenant. For more information about working with tenant templates, see the “Using tenant templates” section on page 138.

Details related to creating the tenant and generating a tenant program are provided in the following sections:

- Allocating tenant partitions
- Specifying an alternate buffer pool
- Using a tenant configuration program
- Creating a new tenant or tenant program

You can also delete a tenant, as described in the “Deleting a tenant” section on page 94.

Allocating tenant partitions

Creating a new tenant in an existing multi-tenant database results in the establishment of a new tenant partition for each existing multi-tenant object defined in the database. You can assign a specific storage area for each table, index, or LOB field, or you can use the previously defined default locations.

You can also specify if or when partitions should be allocated, as long as the following criteria exist:

- The tenant is a regular tenant. You cannot specify the area assignment or allocation setting for partitions for a default tenant or a super-tenant.
- The allocation rule for the tenant is either Set new objects not to allocate space or Set new objects to delay space allocation. If the rule is set to Set new objects to allocate space on tenant creation, partitions are created and allocated at the same time as the tenant is created. You will be unable to change the area assignment for a specific partition when you add a new database object.
You might choose not to allocate space at all when creating a tenant. This can save space if the tenant is not going to be using all of the multi-tenant tables. For example, when a tenant will be using only a subset of the multi-tenant tables, you can delay space allocation for the unused tables. Similarly, you might not be finished making modifications to an object when you create a tenant and prefer not to allocate space now.

For a shared object, you cannot choose not to allocate the object, so its allocation state is immediate. If default allocation is set to immediate, that setting is always applied on new tables (along with the table’s indexes and the LOB fields). If the tenant’s default allocation is set to delayed or none, then the table’s allocation setting applies.

When you set the allocation state for a table, the same state applies to its indexes and LOB fields.

**Specifying an alternate buffer pool**

As you create a tenant, you can choose between using the primary buffer pool or the alternate buffer pool.

---

**Note:** Access to the alternate buffer pool feature requires an Enterprise database license. The feature is unavailable with a Workgroup or Personal database license.

The alternate buffer pool is a set of buffers in shared memory that are logically separate from the primary buffer pool. The alternate buffer pool gives the database administrator the ability to modify buffer pool behavior by designating objects or areas to consume buffers from the alternate buffer pool, rather than from the primary buffer pool.

Management of the buffers in the alternate buffer pool is independent of the primary buffer pool. Assigning specific database areas or objects to occupy buffers from the alternate buffer pool might improve your buffer hit rate, thereby reducing the need to read and write buffers to and from disk and possibly improving performance.

For each table, index, and LOB field, you can specify whether to use the primary or the alternate buffer pool.

**Using a tenant configuration program**

Using OpenEdge Management/OpenEdge Explorer, you can create a tenant for a multi-tenant database. If you prefer, you can, as an alternative, set up the tenant’s properties, generate a tenant creation ABL program based on those properties, and save the program so you can run it when you want. Generating the program alone does not create the tenant; you create the tenant when you run the generated program.

Similarly, if you have an existing tenant whose configuration you want to reuse, you can generate a tenant creation program from that tenant. You might also want to use the generated code as a template for writing your own tenant creation program within your own application.
Generating the program for a new or an existing tenant creates a .p file (procedure file) that you then use to create the tenant and all its settings, including partition assignments. If you are generating a program for an existing tenant, you can include domain and user information associated with the tenant. For a new tenant, domain and user details are not yet available in the database; therefore, no user or domain information is included in the program.

When you create and save a tenant program, you can then use that program to create a tenant with the settings you have defined. You can also modify a generated program before you run it.

**Creating a new tenant or tenant program**

You can create a new tenant or create a tenant based on an existing tenant. You can also generate a reusable tenant ABL program for an online multi-tenant database. Before you begin, you must select a database connection, and the database server must be running, as described in the “Setting up the connection” section on page 31.

You can also create a tenant from a tenant template. For more information, see the “Using tenant templates” section on page 138.

To create a new tenant or tenant program:

1. Choose one of the following:
   - From the Security Summary panel on the database home page, click Create Tenant.
   - From the management console, select Database Administration → New → Tenant.

The New Tenant page appears:
2. Provide the following information:

- **Tenant name** — The name of the new tenant, which must be unique within the database. Do not use spaces or special characters such as an asterisk (*), ampersand (&), or period (.) in this field. You can include the underscore (_).

- **Description** — An optional description of the tenant.

- **External ID** — An optional ID. If you provide an external ID, you can later refer to the ID when you view the progress of transactions being committed.

3. Select the tenant type: **Regular** or **Super**. For more information about each tenant type, see the “Common terminology” section on page 25.

4. To enable access to the tenant’s data, select the **Enable data access** option. If you do not select the option, data access is disabled for any user other than the super-tenant. For more information, see the “Enabling or disabling access to tenant data” section on page 100.

5. In the **Database connection** name, enter a database connection name to which you want to add the new tenant. By default, the last used database connection name appears in the **Database connection** field.

   **Note:** If you type the name of the database connection, follow the format used by OpenEdge Management/OpenEdge Explorer to define a connection: `container-name.database-name`. A database server must be running for you to connect to the database.

   You can also click the **Search** icon to choose a database for which you are creating the tenant from the **Connection Selection** dialog, as shown:
The **Connection Selection** dialog displays the connections details in a grid. You can perform the following:

- Filter the connections in the grid by a **Connection name**, **Container**, and/or **Category**.

- Select the column heading and click the drop-down to choose the order (ascending or descending alphabetically) for the connections to appear in the grid.

6. If you are creating a super-tenant, go to **Step 9**.

   If you are creating a regular tenant, type the name of each of the following areas, and then continue with **Step 7**:

   - **Default data area** — The default storage location for the tenant’s tables
   - **Default index area** — The default storage location for the tenant’s indexes
   - **Default LOB area** — The default storage area for the tenant’s LOB fields

   For each of the areas, you can either enter the storage area name in the default area field or click the **Search** icon to choose the storage area name from the **Area Selection** dialog, as shown:
Creating a new tenant for a multi-tenant database

The Area Selection dialog displays the storage area names in a grid. You can perform the following:

- Filter the storage area name in the grid by Area name, Records per block, and/or Cluster size.
- Move forward or backward a page, or specify a particular page, in the list of domains by using the Page feature at the bottom of the list.
- Select the column heading and click the drop-down to choose the order (ascending or descending alphabetically) for the area names to appear in the grid.

7. Choose one of the following object allocation rules for the regular tenant:

- **Set new objects not to allocate space** — Allocate no space for the tenant’s objects.
- **Set new objects to allocate space on tenant creation** — Allocate storage space immediately.
- **Set new objects to delay space allocation** — Do not yet allocate storage space. (You can allocate space later when you are ready to do so.)
8. If you selected either Set new objects not to allocate space or Set new objects to delay space allocation in Step 7, select one of theses options:

- **Do not use template** — Select this option if you are creating a new tenant without using a template.

- **Tenant** — Select this option if you are creating a tenant by using an existing tenant. You can type the tenant name in the field, or you can click the Search icon to open the Tenant Selection dialog, as shown:

The Tenant Selection dialog displays the tenant details in a grid. You can filter the tenants in the grid by Tenant name and/or External ID.

You can also move forward or backward the page, or specify a particular page, in the list of tenants by using the Page feature at the bottom of the grid.

**Note:** You can select the column heading and click the drop-down to choose the order (ascending or descending alphabetically) for the tenants to appear in the grid.

- **Template** — Select this option if you are creating a tenant by using an existing template. You can enter a template name in the field, or you can click the Search icon to open the Template Selection dialog. For more information about working with tenant templates, see the “Using tenant templates” section on page 138.
9. Choose one:

- To create the tenant immediately, click **Create tenant**.

  If you are creating a regular tenant, the tenant home page appears. Click **Edit tenant** to see a set of vertical tabs consisting of the following selections in the left pane: **General**, **Partitions**, **Groups**, **Users**, and **Domains**.

  OpenEdge Management console submits an asynchronous task to the OpenEdge servers when you create a tenant in a database. You can see the status of such a task under the **Multi-tenancy Tasks** pane in the **My Dashboard** tab as shown below:

  ![Multi-tenancy Tasks](image)

  If you are creating a super-tenant, the tenant home page appears. Click **Edit Tenant** to see a set of vertical tabs consisting of the following selections in the left pane: **General**, **Users**, and **Domains**.

- To create a tenant configuration script, click **Generate tenant program**. Choose to open or save the `create_tenant.p` file.
Editing a tenant

You can make changes to a tenant; for example, you can add it to or remove it from a group, add users, or domains, and rename a tenant (when tenant is a part of a group).

If space for a tenant partition has not yet been allocated, you can alter the allocation state, change the area assignment, and select the buffer pool assignment. You can also enable or disable access to a tenant’s data.

Note that:

• You cannot disable access to the tenant you belong to as a user.
• You cannot disable access for a super-tenant. A super-tenant does not have its own data.
• You can rename a regular or super-tenant.
• You can rename a tenant when it is part of a group.
• You cannot rename the default tenant.
• The allocation state you choose for a table applies also to its indexes and LOB fields.

To edit a tenant from tenant:

1. From the management console, choose Database Administration → Database Connections.
2. From the database connections list, click a database connection.
3. Click Tenants in the list frame.
4. Select the tenant you want to edit.
5. In the tenant home page, click Edit tenant. The Tenant Details page appears.
6. In the Tenant name field, replace the existing tenant name with a new tenant name.
7. Choose the appropriate tab to make the changes you want:
   • General — You can enable or disable tenant data access; change the default data area, index area, and/or LOB area; and modify a table’s allocation rule. (Note that the modification to the allocation rule affects only the unallocated partitions.)
   • Partitions — For each table or table object, you can modify the buffer pool assignment, choosing either Primary or Alternate. If the partitions have already been allocated, you cannot change the area or the allocation state.
   • Groups — You can add a group, or generate a tenant creation program. For more information, see the “Creating a group or group program” section on page 163.
• **Users** — You can add a user. For more information, see the “Adding a user to a tenant” section on page 92.

• **Domains** — You can add a domain. For more information, see the “Adding a tenant domain” section on page 90.

8. Make the changes to the tenant; when you finish, click **Commit**.

   If you have renamed the tenant, the new tenant name appears on the list frame after you commit the changes.

OpenEdge Management console submits an asynchronous task to the OpenEdge servers when you edit a tenant in a database and commit the saved changes. You can see the status of such a task under the Multi-tenancy Tasks pane in the My Dashboard tab, as shown:

![Asynchronous task status when editing a tenant](image)

**Figure 16:** Asynchronous task status when editing a tenant
Chapter 4: Working with tenants

Adding a tenant domain

You can add one or more domains for a tenant by selecting from a list of predefined authentication systems that are configured for the database.

You can also add a domain to the database. For more information, see the "Managing domains in a multi-tenant database" section on page 121.

To add a domain:

1. From the management console, choose **Database Administration** → **Database Connections**.
2. From the list frame, click the database connection.
3. Click **Tenants** in the list frame.
4. Select the tenant for which you want to add a domain.
5. In the Tenant home page, click **Edit tenant**.
6. Click **Domains**.
7. Click **New** in the tenant menu bar.
8. Provide the following information:

   - **Domain name** — Type the domain name (required). Do not use spaces or special characters such as an asterisk (*), ampersand (&), or period ( . ) in this field. You can include the underscore (_). The domain name represents the logical name of a single authentication system (domain) that can be used to validate the authentication of a user account.

   - **Authentication system** — From the dropdown list, specify the type of authentication system. (The available types exist in the database in the _sec-authentication-system table.)

   - **Access code** — Type an access code for the domain. The access code you type is then encrypted and used to validate the identity and integrity of any CLIENT-PRINCIPAL issued by the authentication system represented by this domain.

   - **Confirm access code** — Retype the access code.

   - **Description** — Provide a description (optional).

   - **Comments** — Provide comments (optional).
Adding a tenant domain

- **Enabled** — Select the check box to indicate that the domain is enabled (meaning that a user can log in).

- **Auditing context** — Provide the audit record context value.

- **Runtime options** — Provide a comma-delimited list of runtime options for this domain.

- **System options** — Provide the system option value.

9. Click **Commit**.

For more information about auditing and OpenEdge, see *OpenEdge Getting Started: Core Business Services* on PSDN (http://communities.progress.com/pcom/docs/DOC-16074).
Adding a user to a tenant

You can add one or more users to a tenant. You can also add one or more users to the database. For more information, see the “Managing users in a multi-tenant database” section on page 118.

To add a user:

1. From the management console, click Database Administration → Database Connections.
2. From the list frame, click the database connection.
3. Click Tenants in the list frame.
4. Select the tenant for which you want to add users.
5. In the detail frame, click Edit tenant.
6. Click Users.
7. Click New in the tenant menu.
8. Provide the following information for the new user:
   - **User name** — Type the user’s name (required). Do not use spaces or special characters such as an asterisk (*), ampersand (&), or period (.) in this field. You can include the underscore (_).
   - **Domain name** — Enter a domain name or click the Search icon to open the Domain Selection dialog to select a domain name. This is a required field.
     The Domain Selection dialog allows you to filter the domains in the grid by Domain name, as shown below:
   - **Password** — Type the user’s password.
   - **Confirm password** — Retype the user’s password.
   - **Description** — Provide a description (optional).
   - **Given name/Middle initial/Surname** — Provide the user’s given name, middle initial, and surname (optional).
   - **Telephone** — Type the user’s telephone number (optional).
   - **E-mail** — Type the user’s email address (optional).
9. Click Commit in the tenant menu.
Generating a tenant program from an existing tenant

Generating a tenant program for an existing tenant creates a .p file (procedure file) that you then use to create the tenant and all its settings, including partition assignments. You can optionally include user and domain information associated with the tenant.

To generate a tenant program from an existing tenant:

1. From the management console, select Database Administration → Database Connections.
2. From the list of connections that appears in the list pane on the left, choose the database where the tenant (that you want to use as the basis for the tenant program) resides.
3. Click Tenants in the list frame on the left.
4. Select the tenant. The tenant home page appears.
5. Choose one:
   - Click Generate tenant program.
   - Click Edit tenant. From the tenant menu bar, select Tools → Generate tenant program.
   You are prompted to open or save the create_tenant.p file.
6. Choose one:
   - If you want to open the file before saving it, click Open. The file opens in your default text editor; you can modify the file if you want.
   - If you simply want to save the file, click Save. Provide the file with a unique name, which will prevent your overwriting one create_tenant.p file with another if you create more than one tenant program. Then click Save.
Deleting a tenant

You can delete a tenant, which also deletes the tenant’s domains, users, and data, including partition information. Once you delete a tenant, any space that was used for that tenant’s data becomes available.

You can delete a tenant and its users, domains, and data in one transaction, or you can delete each user and domain individually. You cannot delete a tenant if it is in use by the current database connection; in other words, you cannot delete a tenant for which you are a user.

**Note:** The default tenant cannot be deleted.

---

To delete a tenant:

1. From the management console, select **Database Administration** → **Database Connections**.
2. From the list of connections that appears in the list pane on the left, click the database connection for the tenant.
3. Click **Tenants**. The tenants for the database connection appears in a list.
4. From the list of tenants, select a tenant that you want to delete. The **Tenant Details** page appears.
5. In the **Manage Tenant** panel, click **Delete tenant**.

**Caution:** When you delete a tenant from the database, all domains, users, sequence current values, and data for the tenant will also be deleted. Should you want to restore the tenant in the future, you can do so only from a backup. Therefore, it is strongly recommended that you back up a tenant before you delete it.

6. Click **Commit**. The **My Dashboard** page opens; you can review the **Multi-tenancy Tasks** viewlet to check on the progress of the deletion:
Deleting a tenant domain

You can delete a tenant domain from the database using the Edit Tenant details page. You can also delete a domain from the Edit Database Domains page: see Chapter 6, “Managing domains in a multi-tenant database”.

To delete a tenant domain

1. From the management console, select Database Administration → Database Connections.
2. From the list of connections that appears in the list pane on the left, click the database connection for the tenant.
3. Click Tenants. The tenants list for the database connection appears in a list.
4. From the list of tenants that appears in the list pane on the left, click a tenant. The Tenant Details page appears.
5. In the Manage Tenant panel, click Edit Tenant. The Edit Tenant page appears displaying the tenant details.
6. Click Domains. The list of tenant domains appear in a grid, as shown:

7. From the list of tenant domains, select a tenant domain that you want to delete from the database.
8. Click Delete. You are prompted to confirm deletion. Click Yes to delete the selected tenant domain from the database.
Deleting a tenant user

You can delete a tenant user from the database using the Edit Tenant details page. You can also delete a user from the Edit Database Users page: see Chapter 6, “Managing users in a multi-tenant database”.

To delete a tenant user

1. From the management console, select Database Administration → Database Connections.

2. From the list of connections that appears in the list pane on the left, click the database connection for the tenant.

3. Click Tenants. The tenants list for the database connection appears in a list.

4. From the list of tenants that appears in the list pane on the left, click a tenant. The Tenant Details page appears.

5. In the Manage Tenant panel, click Edit Tenant. The Edit Tenant page appears displaying the tenant details.

6. Click Users. The list of tenant users appear in a grid, as shown:

7. From the list of tenant users, select a tenant user that you want to delete from the database.

8. Click Delete. You are prompted to confirm. Click Yes to delete the selected tenant user from the database.
Enabling a table for multi-tenancy

From the management console, you can choose one or more tables not enabled for multi-tenancy, and enable them. You can then make decisions about partition allocation for the table or tables that have not yet been allocated. The allocation state you choose for a table applies also to the table’s indexes and LOB fields. When you enable a table for multi-tenancy, you are affecting all tenants for a selected database.

**Note:** A table must be in a Type II area in the database to be enabled for multi-tenancy. If a table, or any of its indexes or LOB fields, is not in a Type II area, you cannot enable the table for multi-tenancy.

In such a situation, the Notes column will identify which table, index, or LOB field is not in a Type II area, so you can correct the issue and then enable the table as multi-tenant.

Selecting one or more tables to enable for multi-tenancy

You can easily identify tables not enabled for multi-tenancy in a database connection. The tables appear in a list, and you can select one or more of the tables that you want to enable.

To select a table for enabling as multi-tenant:

1. From the management console, choose Database Administration → Enable Multi-tenancy for Tables. The Enable Multi-tenancy for Tables page appears, as shown:
2. In the **Database connection** field, enter a database connection name. By default, the last used database connection name appears in the **Database connection** field.

Note: If you type the name of the database connection, follow the format used by OpenEdge Management/OpenEdge Explorer to define a connection: \textit{container-name.database-name}. A database server must be running for you to connect to the database.

You can also click the **Search** icon to choose a database for which you are creating the tenant from the **Connection Selection** dialog, as shown:

![Connection Selection Dialog](image)

The **Connection Selection** dialog displays the connections details in a grid. You can perform the following:

- Filter the connections in the grid by **Connection name, Container**, and/or **Category**.
- Select the column heading and click the drop-down to choose the order (ascending or descending alphabetically) for the connections to appear in the grid.

3. From the list of tables, select one or more tables.

4. Click **Preview** to make partition allocation decisions, by tenant, for the tables now enabled for multi-tenancy. The **Schema Selection** page appears.

5. Select a tenant in the **Tenants** list. (Note that only regular tenants are listed.)

6. Expand the **PUB** node under **Schema Selections**, and expand the table you have enabled for multi-tenancy to view its schema.

Note that the schema shown in the area panels includes the full schema for the database, not just the schema for the newly enabled tables.
7. Select a table whose area or allocation state you are able to modify, and make the changes to the tenant partition area or the allocation state in the Properties pane. If space for a partition has already been allocated, you cannot make changes.

8. Click Commit to save the changes. The Confirm commit enabling multi-tenancy dialog appears:

9. Choose from the following options:
   - To commit the changes, click Commit.
   - To cancel the changes, click Cancel.
   - To force allocation of new partitions that otherwise would not be allocated, select that option. This allows you to force allocation of partitions that otherwise would not be allocated when the changes are saved. This option overrides a tenant's default allocation for new partitions, but any changes applied to individual partitions will also be allocated if you select this option.

   If you select this option, you have an additional choice to make between the following two selections:

   - Force allocation of all partitions with an allocation state of Delayed — Forces allocation of partitions whose default allocation setting is to delay.
   - Force allocation of all partitions with an allocation state of Delayed or None — Forces allocation of all partitions whose default allocation setting is to either delay or not allocate space at all.

   For example, if a tenant has an object allocation default of no allocation (None) and a partition for the tenant is changed to delay allocation (Delayed), this partition will be allocated if Force allocation is specified. If a tenant has its default allocation set to delay and a partition is changed to no allocation, the partition will be allocated only if Force allocation is selected.

   Note that it may take some time to commit the changes to the database. The length of time may vary, depending on the complexity of the changes (the number of tables converted to multi-tenancy, for example) as well as the number of existing tenants in the database.

   The My Dashboard page opens and displays a viewlet that allows you to monitor the status of the task. For more information, see the “Monitoring data definition file updates to the database” section on page 115.
Enabling or disabling access to tenant data

You can enable or disable access to a regular tenant. You cannot disable access to a default tenant or a super-tenant; a super-tenant does not have its own data and can access data that other tenant types might not be able to access.

From the tenant home page, you can:

- Determine if a tenant’s data is accessible.
- Disable or enable access to the tenant data.

You can also create a tenant whose data access is either enabled for disabled. For more information, see the “Creating a new tenant for a multi-tenant database” section on page 80.

You cannot disable access to a tenant for which you are a user.

Determining if tenant data access is enabled

From the tenant home page, you can determine at a glance if the tenant’s data is accessible.

To determine if a tenant’s data access is enabled:

1. From the management console, choose Database Administration → Database Connections.
2. From the list frame, click the database connection.
3. Click Tenants in the list frame.
4. Select the tenant whose data access you want to verify. The tenant home page appears.
5. In the Manage Tenant panel, review the Tenant data access status, which is either enabled or disabled.

For information about changing the data access status from enabled to disabled or vice versa, see the “Enabling or disabling access” section on page 101.
Enabling or disabling access

From the tenant home page, you can enable or disable access to a tenant’s data. You cannot disable a tenant for which you are a user.

To enable or disable access to a tenant’s data:

1. From the management console, choose **Database Administration** → **Database Connections**.

2. From the list frame, click the database connection.

3. Click **Tenants** in the list frame.

4. Select the tenant whose data access you want to modify. The tenant home page appears.

5. In the **Manage Tenant** panel, review the **Tenant data access** status, which is either enabled or disabled.

6. To change the status, click the **Tenant data access** link. Click Yes to confirm the decision. The **Tenant data access** status is updated to reflect the confirmation.
Deallocating tenant tables

You can deallocate a multi-tenant table from a tenant or a group. Deallocation can be helpful in freeing up storage space so that it is available for reuse.

If you are logged in as a user to a regular tenant, you can deallocate one or more tables from the tenant. If you are logged in as a user to a super-tenant, you can deallocate a table for a group or another tenant in the database.

If you attempt to deallocate a tenant table and the table is in use, deallocation waits for the table to be available.

Note: Keep in mind that when you deallocate a multi-tenancy-enabled table’s partitions, all data in the table is deleted. For this reason, it is advised that you back up a tenant before you deallocate its contents.

To deallocate a tenant table from the tenant:

1. From the management console, choose Database Administration → Database Connections.
2. From the list of the database connections, choose a database connection. The database connection home page appears.
3. Click Tenants in the list frame. The tenants of the selected database connection appears in a list.
4. From the list of tenants, select a tenant whose table you want to deallocate. The tenant home page appears.
5. In the Data Administration panel, click Deallocate tables. The Deallocate Tenant Tables page appears:
The **Deallocate Tenant Tables** page provides the table details: **Table**, **Area**, **Allocation State**, **Status**, and **Comments**. You can filter the tables which appear in the grid by a table name. Enter a table name in the **Table name** field and click on the **Search** icon. The grid displays the tables that match the entered criteria.

You can also move forward or backward a page, or specify a particular page, in the list of tables by using the **Page** feature at the bottom of the list.

**Note:** You can select the column heading and click the drop-down to choose the order (ascending or descending alphabetically) for the tables to appear in the grid.

6. Select one or more individual tables to be deallocated, or click the **Select All** check box. The following warning appears:

   ![Confirm deallocating the table](image)

7. To continue, click **Yes**; to cancel the deallocation, click **No**.

   If you click **Yes**, you see one of the following statuses, depending on the deallocation progress:

   - If the deallocation has completed, you see the following confirmation evidence: The **Allocation state** changes to **None**, the **Status** changes to **Done**; and **Task completed successfully** appears in the comments for that table.

   - If the deallocation is in progress, you see a notation that the **Background task has been submitted**.

   - If the deallocation has timed out, you see the comment **Check the logs in the task list**. Note that the progress of the task is verified at five-second intervals, up to a maximum of ten minutes.

To deallocate a tenant table from a group:

1. From the management console, choose **Database Administration** → **Database Connections**.

2. From the list frame, click the database connection.

3. Click **Groups**.

4. From the list of groups, select the group and click **Edit**. You can now deallocate the table in the group.

5. Choose **Tools** → **Deallocate group**. The table partitions are deallocated.
As you work with databases enabled for multi-tenancy, you may find that you need to
update the database’s schema, modify the area assignments for a regular tenant’s
data, and save the changes. Using the multi-configuration tool, you can load and
preview a data definition file and then commit the updates to the database, or you can
skip the preview and just commit the changes.

This chapter provides the following information related to updating the schema for a
regular tenant:

- Uploading schema for a multi-tenant database
- Configuring an area working set
- Editing storage area assignments for regular tenants
- Committing changes to a multi-tenant database
Uploading schema for a multi-tenant database

As you work with a multi-tenant database, you may find that you need to update its schema. For example, consider the situation in which you have a multi-tenant application in production, serving tenants, and you want to update the application with additional functionality. If the application update also requires you to update the database schema, you can do this while the database is online by loading the data definition (.df) file that contains the schema modifications.

Once you load the data definition file, you can optionally preview the file’s contents before applying the changes to the database. If you prefer, you can commit the changes without reviewing the preview.

Note that for the data definition file to upload correctly, its contents must be properly formatted.

Selecting and loading the data definition file

You can select and load a data definition file.

1. From the management console bar, do either of the following:
   - Choose Database Administration → Database Connections. Choose a connection from the list, and click View.
     
     From the Data Administration panel, click Load data definitions (.df file).
     
     - Choose Database Administration → Load Data Definitions (.df file).

   The Load Data Definitions tab opens:

2. Click Browse to locate the file you want to upload. The file name appears in the Data definitions (.df file) field.

3. Select an available database connection from the Database connection drop-down list. (Note that a database server must be running for you to connect to the database.)
4. Choose one:

- Choose **Commit**. The **Confirm Commit database definitions** dialog appears. For more information about this dialog, see the “Committing changes to a multi-tenant database” section on page 113.

- Click **Preview**. The changes are uploaded to the server and the preview appears, as described in the “Previewing the contents of an uploaded data definition file” section on page 107.

**Previewing the contents of an uploaded data definition file**

When you load a data definition file, you can preview the changes contained in the file before you commit the changes to the database. The data definition preview, as shown in **Figure 17**, reveals various details about an uploaded data definition.

---

**Figure 17: Data definition file preview**

The preview allows you to see the updates present in the file and make modifications before you commit the updates. The predefined color coding allows you to tell the allocation state at a glance. In **Figure 17**, the color pink indicates that the area’s partitions are not allocated.
Chapter 5: Updating tenant schema

The data definition file preview includes the following information:

- **Data Definitions** — A treeview list of the contents of the data definition file, along with a notation about which objects in the file have changed, and in what way. The notation can be ADD, DELETE, or MODIFY, or a combination of these, and appears after the object name in the display.

Only those multi-tenant objects that require or are affected by partition assignments appear in the treeview, since those are the only objects you can modify in the console. (However, any and all changes that are included in the data definition file are uploaded.) Consider the following typical updates, how the updates affect partition assignments, and how the updates will appear in the treeview list:

- The addition of a table requires partition information for each tenant; therefore, the name of the new table appears in the list and is followed by **ADD**.

- A data definition file might drop and re-add an index in order to change the fields that the index comprises. In such an instance—in which two actions relate to one object—both actions follow the object (the index name, for example) and are separated by a comma, as in **DELETE,ADD**.

- Any changes to LOB fields are listed. Changes to any other type of field do not appear in the treeview since they do not affect partitioning.

- A deleted object is shown with the notation **DELETE**.

- An object whose details change (other than **ADD** or **DELETE**) is marked by the notation **MODIFY**.

- The drop of a table, index, or LOB field is shown, since the drop causes a removal of partition information from the database. In this case, the name of the table, index, or LOB field is followed by **DELETE**.

- **Areas Assignments** — A list of current storage area assignments for each object of the selected tenant as well as each area for any area assignment referenced by a schema object. You can select multiple partitions, and simply drag them from one area and drop them on another area.

- **Properties** — Details about a schema object you select in the Data Definitions treeview or a partition object you select in a storage area.

When you select a schema object, details can include:

- **Name** — The name of the object selected in the treeview list

- **Default area** — The area assigned

- **Multi-tenant** — Whether the object is enabled for multi-tenancy
– Keep default area — Whether to keep the data in the default tenant upon upload

– Tenant partition area — The area where the tenant partition resides

– Allocation state — The partition allocation status, which identifies whether space has been allocated for the partition and/or when it will be allocated

For a sequence, the following details appear:

– Name — The name of the sequence

– Multi-tenant — Whether the sequence is enabled for multi-tenancy. (If it is, the check box is selected.)

– Initial value — The current value of the sequence.

– Increment by — A positive or negative integer value with which you want to change the sequence value at each increment.

– Sequence minimum value — An integer value that represents the lower limit of the sequence.

– Upper limit — An integer value that represents the upper limit of the sequence.

– Cycle at Limit — Whether a cycling sequence has been activated (true) or not (false)

When you select a partition object, details include:

– Name — The name of the object selected in the area

– Type — The type of object (table, LOB field, index)

– Area — The area where the object resides

– Buffer Pool — The chosen buffer pool, either primary or alternate.

– Allocation state — The partition allocation status, which identifies whether space has been allocated for the partition and/or when it will be allocated

• Tenants — A list of tenants in alphabetical order. By default, the first tenant is selected. If you have viewed the tenant already, a green indicator appears in the upper-left corner of the tenant name. If you have altered the tenant through the loading of a data definition file, a red indicator appears instead in the upper-left corner of the tenant name.
Configuring an area working set

You can review a tenant’s area layout in the detail frame. As you work with tenants and upload and commit schema changes, you might find that you cannot see all the database areas at one time. To remedy this, you can configure an area working set, which allows you to specify which areas you want to see in the tenant area layout. This option is useful when you are working with multi-tenancy tables with an allocation status of delayed or none.

To configure an area working set:

1. Choose Database Administration → Database Connections.
2. Choose a connection.
3. Click Tenants, and select a tenant from the list.
4. Click Edit tenant in the detail frame.
5. Click Configure working areas in the tenant pane menu bar. The Select Working Areas dialog appears:

The dialog presents a list of all of the Type II areas in the database. In addition, the second column shows the number of partitions currently assigned to that area.

(Areas already being shown are preselected.)

6. In the Display column, click the check box for each area you want to appear in the area layout.
7. Click **Close** when you finish.

8. Click **Partitions** to scroll in the area layout and see all the areas you chose to include in the working set.

9. To save the areas you added to the working set, click **Commit** in the tenant menu bar. (Note that any other pending transactions will also be committed at this time.)
Editing storage area assignments for regular tenants

Once you preview the schema changes present in an uploaded data definition file—but before you commit those changes—you can optionally modify the area assignments for a regular tenant’s data provided the object allocation space is not specified to be set immediately. In this case, you cannot modify area settings.

Consider the following data definition preview for the regular tenant Hats By Eloise shown in Figure 18:

The uploaded data definitions file includes a new table named Terms8. The Properties: Terms8 pane for the new table shows that the table will be located in the tenant's default storage area Employee; the table is enabled for multi-tenancy; the table’s tenant partition area is Area 100; and space allocation for the partition will be delayed. (The allocation state is indicated by both the Allocation state choice in the Properties and the predefined yellow color coding in the area panels).

The properties also indicate that the default area is being kept. The Keep default area option is available when you are converting from a shared table to one enabled for multi-tenancy. If you select the option when you create a multi-tenant table, the original table data is not deleted and is retained for the default tenant in the new table.

If you did not select the Keep default area option, a new partition will be created for the default tenant for that shared table in the area specified by the value(s) in the data definition file.

You can edit the area assignment from the drop-down in the Properties pane before you commit the updates contained in the uploaded data definition file. If you want to move Terms8 from Area 100 to Area 101, for example, you can simply drag it from one area and drop it on another area. You can also drag and drop from the Data Definitions treeview to one of the areas.
Committing changes to a multi-tenant database

You can upload a data definition file, preview its contents, make storage area modifications, determine when to allocate partition space, and then commit all the changes. As you do so, you can configure one or more tenants and then commit the changes all at once, rather than needing to commit the updates for each tenant individually.

To commit changes to the database:

1. From the data definition file preview page, click Commit in the tenant menu bar (located above the list of tenants). The Confirm commit database definitions dialog appears:

   ![Confirm commit database definitions dialog](image)

   The dialog shows the task name, which is the name given to the transaction you are committing. You can later use the task name to verify that the transaction has been applied once you commit the changes.

   If you want, you can modify the task name. By default, the given task name includes the name of the container and database (`nbbedaspauldi.LocalScr`), the type of transaction being committed (`load database definitions`), and the name of the uploaded data definition file (`terms8.df`).

2. Select from the following options:

   - **Add new objects online** — Allows you to make the following changes while the database is online:
     - Add new sequences.
     - Add new tables, along with any associated fields, indexes, and database triggers (which must be added within the same transaction).
     - Add new fields to an existing table. (Note that you cannot define ASSIGN triggers for new fields while the database is online.)
     - Add new inactive indexes to an existing table.
• **Add all new multi-tenant tables as shared tables** — Informs the load process to ignore any allocation settings for multi-tenant tables. Therefore, if a data definition file contains the MULTI-TENANT or KEEP-DEFAULT-AREA setting for a table, multi-tenancy settings are ignored and all objects become shared objects.

In addition, any modification described in the data definition file that would cause the table to become a multi-tenant table is ignored. (Once you enable multi-tenancy for a table you cannot disable it. You would then need to dump and reload the table.) Note that this does not apply to the addition of indexes and fields for existing tables. If an index or a table is being added to an existing multi-tenant table, the table or index is added as a multi-tenant schema object to that table.

Enabling this option can be useful, for example, if you are loading data definitions to a table that is not enabled for multi-tenancy or if you want to defer storage space allocation, particularly if you have many tenants with immediate allocation selected.

• **Force allocation of new partitions that otherwise would not be allocated** — Allows you to force allocation of partitions that otherwise would not be allocated when the data definition file is loaded. This option overrides the tenant's default allocation for new partitions, but changes applied to individual partitions will also be allocated if you select this option.

If you select this option, you have an additional choice to make between the following two selections:

– **Force allocation of all partitions with an allocation state of Delayed** — Forces allocation of partitions for tenants that are created as part of the uploaded data definition file and whose default allocation setting is to delay.

– **Force allocation of all partitions with an allocation state of Delayed or None** — Forces allocation of all partitions created as part of the uploaded data definition file. This includes those whose default allocation setting is to either delay or not allocate space at all.

For example, if a tenant has an object allocation default of no allocation (None) and a new partition for the tenant is changed to delay allocation (Delayed), this partition will be allocated if Force allocation is specified. If a tenant has its default allocation set to delay and a partition is changed to no allocation, the partition will be allocated only if the **Force allocation of all partitions** option is selected. Note that the forced allocation option also applies to new indexes and LOB fields added to existing multi-tenant tables.
• **Add new indexes in deactivated state** — Allows you to add in a deactivated state all new indexes that are described in the data definition file. This option applies to indexes on both shared and multi-tenant tables; enabling the option can save processing time if the loaded data definition file adds new indexes to tables that contain a large amount of data.

• **Commit changes even when errors are encountered during load** — Specifies that the load of definitions should continue, even if some definitions result in errors that prevent those definitions from being applied to the database. Note that selecting this option might leave the database in a corrupt state. If you have selected the **Add new objects online** option, this option is invalid and, therefore, unavailable.

5. Click **Commit** to commit the transactions. The data definitions from the data definition file are applied to the database, partition assignments are made, and allocation settings are applied.

The **My Dashboard** page opens and displays a viewlet that allows you to monitor the status of the load data definition file task by either the default name or the name you assigned using the **Task name** field. For more information, see the “Monitoring data definition file updates to the database” section on page 115.

### Monitoring data definition file updates to the database

Once you commit transactions to the database, you can monitor their progress from a viewlet on the **My Dashboard** page, as shown in **Figure 19**:

![Multi-tenancy Tasks viewlet](image)

**Figure 19:** Multi-tenancy Tasks viewlet

The **My Dashboard** page automatically opens once you commit updates and allows you to track the progress of the transactions by using the task name automatically assigned or created by you on the **Confirm commit database definitions** dialog.
Managing users and domains in a multi-tenant database

You can work with users and domains in tenants and in the database by using the multi-tenancy configuration tool.

This chapter provides the following information about working with user and domains:

- Managing users in a multi-tenant database
- Managing domains in a multi-tenant database
- Managing multi-tenant database table security for users
- Configuring database security administrators
- Reviewing user access in the Data Administration Console
Managing users in a multi-tenant database

You can create and delete users, and you can make changes to several user-related fields. You can also add users to a particular tenant. For more details, see the "Adding a user to a tenant" section on page 92.

You cannot modify the User ID, User name, or Domain name. You can modify the password only if you are the user/password owner.

**Note:** As you work with a multi-tenant database, you may find that access to some features or operations is disabled, possibly due to the user permissions defined in the database. For more information about user permissions, see the "Managing multi-tenant database table security for users" section on page 126.

To add a user to a multi-tenant database:

1. Choose **Database Administration** → **Database Connections**.
2. Choose the database connection from the list, and click **View**. The database home page appears.

   In the **Security Summary** panel, click **Edit users**. A list of existing database users appears in a grid. If you have a large number of users, you can move forward or backward a page, or specify a particular page, in the list of users by using the **Page** feature at the bottom of the list.

   The list provides the following details:
   - **User ID** — The ID assigned to the user.
   - **User Name** — The user name.
   - **Domain Name** — The domain to which the user belongs.
   - **SQL Only** — If this option is enabled, the `_user` table record can be used only by a SQL connection to authenticate to the database. ABL clients cannot authenticate to the database by using user ID and user name.

     If the option is disabled, both SQL and ABL users can use the record.
   - **Description** — Provide a description or notes about a particular user.
3. Click **New**.
4. In the **User name** field, enter a user name.
5. In the **Domain name** field, enter a domain name or click the domain name’s **Search** icon to select a domain from the list that appears in the Domain Selection dialog, as shown below:

![Domain Selection dialog](image)

The Domain Selection dialog displays the domains details in a grid. You can filter the domains in the grid by **Domain name** and/or **Tenant name**.

You can also move forward or backward the page, or specify a particular page, in the list of domains by using the **Page** feature at the bottom of the grid.

**Note:** You can select the column heading and click the drop-down to choose the order (ascending or descending alphabetically) for the domains to appear in the grid.

6. Type the user’s password in the **Password** field; confirm the password by retyping it in the **Confirm password** field.

7. If you want only SQL connections to be able to authenticate to the database using the _user table record, select the **SQL Only** check box.

8. Click **Save**.
To modify a user in a multi-tenant database:

1. Choose **Database Administration** → **Database Connections**.
2. Choose the database connection from the list, and click **View**. The database home page appears.
3. In the **Security Summary** panel, click **Edit users**. A list of existing database users appears.
   
   If you have a large number of users, you can move forward or backward a page, or specify a particular page, in the list of users by using the **Page** feature at the bottom of the list.
4. Select a user and make the modifications.
5. Click **Save**.

To delete a user from a multi-tenant database:

1. Choose **Database Administration** → **Database Connections**.
2. Choose the database connection from the list, and click **View**. The database home page appears.
3. In the **Security Summary** panel, click **Edit users**. The list of existing database users appears.
   
   If you have a large number of users, you can move forward or backward a page, or specify a particular page, in the list of users by using the **Page** feature at the bottom of the list.
4. Select the user you want to delete from the database, and click **Delete**.
5. Click **Yes** to confirm the deletion.
Managing domains in a multi-tenant database

You can work with domains in tenants and in the database by using the Database Administration Console. You can do the following:

- View and filter the existing domains
- Create a domain
- Edit a domain (including renaming a domain)
- Delete a domain (only if the domain has no users)

You can also edit existing authentication systems or create your own. You can also add domain users to a particular tenant. For more details, see the “Adding a tenant domain” section on page 90.

To view and filter the database domains:

1. Choose Administration → Database Connections. The Database Administration tab appears.
2. From the Connections list, choose a database connection. The database home page appears.
3. In the Security Summary panel, click Edit domains. The Edit Database Domains page with a list of existing database domains appears, as shown:
Chapter 6: Managing users and domains in a multi-tenant database

The database domains grid provides the following details:

- **Domain Name** — The domain to which the tenant belongs.
- **Authentication System** — The authentication system; for example, Internal or LDAP.
- **Tenant Name** — The tenant that the domain belongs to.

Note that you can select the column heading and click the dropdown to choose the order (ascending or descending alphabetically) in which the items appear. This allows you to see which tenants belong to a particular domain.

- **Enabled** — Whether the domain is currently enabled.

You can filter the database domains which appear in the grid by a **Domain name** and/or **Tenant name**. Filtering allows you to focus only on the database domains for a particular tenant.

You can also move forward or backward the page, or specify a particular page, in the list of domains by using the **Page** feature at the bottom.

To add a domain to a multi-tenant database:

1. Choose **Database Administration** → **Database Connections**.
2. From the list of database connections, choose a database connection. The database home page appears.
3. In the **Security Summary** panel, click **Edit domains**. The list of existing database domains appear in a grid.
4. Click **New**.
5. Enter a new domain name in the **Domain name** field.
6. Click the drop-down arrow in the **Authentication system** field; select one of the predefined options.
7. Click the tenant name’s Search icon; select a tenant from the **Tenant Selection** dialog, and click **OK**.
8. Type a code in the **Access Code** field. Re-type the access code in the **Confirm access code** field.
9. Enter a description and/or comments in the fields provided (optional).
10. If you want to disable the domain, clear the **Enabled** check box.

**Note:** The Enabled check box is selected by default.
11. Enter the audit record context value in the **Audit Context** field (optional).

12. Enter a comma-delimited list of runtime options for the domain in the **Runtime options** field (optional).

13. Enter the system option value in the **System options** field (optional).

14. Click **Commit**.

To modify a domain in a multi-tenant database:

1. Choose **Database Administration** → **Database Connections**.

2. Choose the database connection from the list, and click **View**. The database home page appears.

3. In the **Security Summary** panel, click **Edit domains**. A list of existing database domains appears.

   You can move forward or backward a page, or specify a particular page, in the list of domains by using the **Page** feature at the bottom of the list.

4. Select the domain you want to modify, and make the changes. If you want to rename a domain, replace the existing name with a new name in the **Domain name** field.

5. Click **Save**.

   If you rename a domain associated with a tenant, the new domain name appears on the list frame for **Domains** after you save your changes.

---

**Note:** You cannot rename a domain associated with a default tenant.

To delete a domain from a multi-tenant database:

1. Choose **Database Administration** → **Database Connections**.

2. Choose the database connection from the list, and click **View**. The database home page appears.

3. In the **Security Summary** panel, click **Edit domains**. A list of existing database domains appears.

4. Select the domain you want to delete from the database, and click **Delete**.

---

**Note:** You cannot delete a domain if it has users.

5. Click **Yes** to confirm the deletion.
Managing authentication systems

You can manage authentication systems using the multi-tenancy configuration tool. You can use a built-in authentication system, you can create a new authentication system, you can integrate with an ABL-based user authentication plug-in, and you can delete an authentication system as long as no existing domains reference it.

You cannot edit a built-in authentication system.

To add an authentication system:

1. Choose **Database Administration** → **Database Connections**.
2. From the **Connections** list, select a database connection. The database home page appears.
3. In the **Security Summary** panel, click **Edit authentication systems**. The **Edit Database Authentication Systems** page appears with a list of existing authentication systems, as shown:

![Edit Database Authentication Systems](image)

You can move forward or backward a page, or specify a particular page, in the list of domains by using the **Page** feature at the bottom of the list.

4. Click **New**.
5. Type a name of the authentication system in the **Name** field.
6. Provide a description and/or comments (optional).
7. Type the path of the callback procedure name in the **Callback** field. The callback procedure file must be a `.p` file.

**Note:** The callback procedure file contains the user authentication function which is implemented using the ABL-based authentication plug-ins. For details about the ABL authentication plug-ins, see *OpenEdge Development: Programming Interfaces*.

8. By default, the **Enabled authentication** check box is disabled. For the user-defined domain types, the check box gets enabled and selected automatically, when you start typing the callback procedure name in the **Callback** field.

**Note:** For the built-in domain types, the **Enable authentication** check box is disabled.

9. Click **Save**. The new authentication system appears in the list.

---

**To delete an authentication system:**

1. Choose **Database Administration** → **Database Connections**.

2. Choose the database connection from the list, and click **View**. The database home page appears.

3. In the **Security Summary** panel, click **Edit authentication systems**. A list of existing database authentication systems appears.

4. Select the authentication system you want to delete, and click **Delete**.

**Note:** You cannot delete an authentication system if there are existing domains that reference it.

5. Click **Yes** to confirm the deletion. The authentication system is removed from the list.
Managing multi-tenant database table security for users

As you work with users in the database, you can define what types of operations the users can perform on tables and fields enabled for multi-tenancy. You can also review at a glance the security settings you have established for the users.

To define security for one or more tables and fields:

1. Choose **Database Administration** → **Database Connections**.
2. Choose the database connection from the list, and click **View**. The database home page appears.
3. In the **Security Summary** panel, click **Edit data security**. The schema appears in the list frame, and the list of tables for the database you selected appears in the details frame:
4. To view or modify permissions for a table or field, select the table or field in the schema.

A list of current user permissions for the selected table or field appears in a permission panel for each of the following options. The default for each permission is an asterisk ( * ), indicating that the permission is currently in place for all users.

<table>
<thead>
<tr>
<th>A user granted this permission . . .</th>
<th>Can . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can-read</td>
<td>Read a table or field.</td>
</tr>
<tr>
<td>Can-write</td>
<td>Write to a table or field.</td>
</tr>
<tr>
<td>Can-create</td>
<td>Create new records in a table. To create a new record, users must also have Can-write privileges.</td>
</tr>
<tr>
<td>Can-delete</td>
<td>Delete records from a table.</td>
</tr>
<tr>
<td>Can-dump</td>
<td>Dump database or table definitions and data with triggers disabled.</td>
</tr>
<tr>
<td>Can-load</td>
<td>Load database or table definitions and data with triggers disabled.</td>
</tr>
</tbody>
</table>

5. To include hidden tables and fields in the list, click the Filter icon. The Show hidden tables and fields check box appears:

6. Select the check box to see the hidden objects, or click the Filter icon again to close the check box.
7. If you want to add to the list of users for a particular permission, click that permission panel. The list of actions to the right of the permission panel reflects the options you have regarding that permission, in addition to providing a link for you to review user data security based on the selected permission.

For example, if you click the **Can-create** panel, the list of actions appears as follows:

8. Choose one:

   - Click **Add users to <permission>**, from the **Actions** list. The **User Selection** dialog appears. Select one or more users in the list, and click **OK**.

   - Type the name of each user you want to add. Follow these conventions:
     - Separate user names by inserting a comma (not a period) between each one.
     - Use an asterisk (*) to allow a permission for all users. Remember to remove the asterisk if you do not want a permission to be available for all users.
     - To allow a permission for all users except one—for example user **u1**—use **!u1,***
     - To allow a permission for only those users whose names begin with a letter or letters—for example **ab**—use **ab***
     - To allow a permission for a user of a domain, separate the user name with the domain name:
       
       user@domain

       - To allow a permission for all users of a domain, put a wild card in front of the domain:

         *@domain
9. Repeat Step 8 for each additional permission.

10. Click **Commit** to save the settings.

**Reviewing user data security permissions**

You can review the permissions that exist for users with regard to data security.

---

To review user data security permissions:

1. Choose **Database Administration → Database Connections**.

2. Choose the database connection from the list, and click **View**. The database home page appears.

3. In the **Security Summary** panel, click **Review user data security**.

4. To include hidden tables and fields in the permissions details, select the option.

5. Do either of the following to select the user whose permissions you want to view:
   - Type the **User ID** in the field provided, and click **Search**.
   - Click **Find User**. From the **Select a User** dialog that appears, select the user whose permissions you want to view. Click **OK**.

   The data security permissions that exist for the user, by table, appear in the **Data Security Permissions** dialog. Each permission the user has is marked. Where the user has no permission, there is no mark present.
Configuring database security options

The Database Security Options page enables you to maintain the security options for a database. Only a user with administrator privileges can access this page to configure the database security options.

To configure the database security options

1. Choose Database Administration → Database Connections.
2. From the list of database connections, choose a database connection. The Database Connection Details page appears.
3. In the Security Summary panel, click Edit security options. The Database Security Options page appears, as shown:

![Database Security Options](image)

4. You can select one or more of the following security options:

<table>
<thead>
<tr>
<th>Security options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trust application domain registry</td>
<td>Overrides the database connection’s domain registry settings and uses the application level domain registry settings. For more information about domain registry settings, see OpenEdge Getting Started: Core Business Services.</td>
</tr>
<tr>
<td>Record authenticated client sessions</td>
<td>Record user login sessions.</td>
</tr>
<tr>
<td>Disallow blank userid connections</td>
<td>Blocks database connection with blank UserId.</td>
</tr>
<tr>
<td>Use runtime permissions checking</td>
<td>Apply CAN-WRITE and CAN-READ permissions at runtime, rather than at compile time.</td>
</tr>
</tbody>
</table>

When you finish, click Commit.
Configuring database security administrators

You can establish one or more security administrators for a multi-tenant database. You can also identify domains as security administrators; in such a case, everyone in a domain is a security administrator.

To set up a database security administrator:

1. Choose Database Administration → Database Connections.
2. Choose the database connection from the list, and click View. The database home page appears.
3. Click Edit database connection.
4. In the Database authentication area, select the Log in with these credentials option.
5. Type the User ID and password; then type the password again to confirm it.
6. Click Save.
7. From the Connections list, select the database connection you are logged in to, and click View.
8. In the Security Summary panel, click Edit security administrator. The Security Administrators page opens:
You can designate one or more security administrators by:

- Typing the login ID for each user in the box provided.
  
  You can enter multiple user IDs here, but you must include your own user ID. Separate the user IDs with commas, but no spaces.
  
- Clicking **Add users to Security Administrators**. A list of users appears; select each user you want to designate as a security administrator. Be sure to select your own ID in the list. Click **OK** when you finish.
  
- Click **Add domains to Security Administrators**. A list of domains appears; select the domains you want to designate. All users in the domains you specify will be security administrators. Click **OK** when you finish.

9. When you finish, click **Save**.

### Setting up a database connection login

You can set up a database connection login that allows you access to super-tenants.

To set up a login to a database connection:

1. From list of connections, select the connection for which you want to establish a login.

2. In the **Manage Database Connection** section of the detail frame, click **Edit database connection**.

3. Select the **Log in with these credentials** option, and provide the user ID and password. Retype the password in the **Confirm** password field.

4. Click **Save**.
Reviewing user access in the Data Administration Console

The access to various options and links available in the database and tenant landing pages depends on the type of user’s tenant used for the database connection. There are three types of users associated with a database connection:

- Default user
- Regular user
- Super user

An user can be associated with either the default tenant, regular tenant, or super-tenant. For more information on managing users in a database connection, see “Managing users in a multi-tenant database” section on page 118.

Table 1 lists the options available in the Database landing page for the user associated with the database connection. Note that full access to a database landing page requires a database connection for a user with the administrator privileges.

Table 1: Database landing page

<table>
<thead>
<tr>
<th>Database landing page section</th>
<th>Default User</th>
<th>Regular User</th>
<th>Super User</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Database Connection</td>
<td>• Edit database connection</td>
<td>• Edit database connection</td>
<td>• Edit database connection</td>
</tr>
<tr>
<td>Security Summary1</td>
<td>• Edit security options</td>
<td>• Edit security options</td>
<td>• Edit security options</td>
</tr>
<tr>
<td></td>
<td>• Edit security administrator</td>
<td>• Edit security administrator</td>
<td>• Edit security administrator</td>
</tr>
<tr>
<td></td>
<td>• Edit users</td>
<td>• Edit users</td>
<td>• Edit users</td>
</tr>
<tr>
<td></td>
<td>• Edit domains</td>
<td>• Edit domains</td>
<td>• Edit domains</td>
</tr>
<tr>
<td></td>
<td>• Create tenant</td>
<td>• Create tenant</td>
<td>• Create tenant</td>
</tr>
<tr>
<td></td>
<td>• Edit authenticatio n systems</td>
<td>• Edit authenticatio n systems</td>
<td>• Edit authentication systems</td>
</tr>
<tr>
<td></td>
<td>• Edit data security</td>
<td>• Edit data security</td>
<td>• Edit data security</td>
</tr>
<tr>
<td></td>
<td>• Review user data security</td>
<td>• Review user data security</td>
<td>• Review user data security</td>
</tr>
</tbody>
</table>
Table 1: Database landing page

<table>
<thead>
<tr>
<th>Database landing page section</th>
<th>Default User</th>
<th>Regular User</th>
<th>Super User</th>
</tr>
</thead>
</table>
| Data Administration           | • Edit sequences  
• Export sequences  
• Load data definitions (.df file)  
• Load table contents (.d file)  
• Load group contents (.d file)  
• Dump table contents (.d file)  
• Dump group contents (.d file) | • Edit sequences  
• Export sequences  
• Load data definitions (.df file)  
• Load table contents (.d file)  
• Load group contents (.d file)  
• Dump table contents (.d file)  
• Dump group contents (.d file) | • Edit sequences  
• Export sequences  
• Load data definitions (.df file)  
• Load table contents (.d file)  
• Load group contents (.d file)  
• Dump table contents (.d file)  
• Dump group contents (.d file) |

1. The Edit security options and Edit security administrator links are enabled for the default user, a regular user, or a super user with the administrator privileges. For more information on configuring database security administrators, see “Configuring database security administrators” section on page 131.

Table 2 lists the options available for each type of user associated with the database connection and the tenant type selected in the Tenant’s landing page. Note that full access to a tenant’s landing page requires a database connection for a user associated with either a super-tenant or that specific tenant.

Table 2: Tenant’s landing page

<table>
<thead>
<tr>
<th>Tenant Type</th>
<th>Tenant’s landing page section</th>
<th>Default User</th>
<th>Regular User</th>
<th>Super User</th>
</tr>
</thead>
</table>
| Default Tenant | Manage Tenant                | • Edit tenant  
• Generate tenant program | • Edit tenant  
• Generate tenant program | • Edit tenant  
• Generate tenant program |
|               | Database Administration      | • Deallocate tables  
• Edit sequence values  
• Export sequences   | • Deallocate tables  
• Edit sequence values  
• Export sequences | • Deallocate tables  
• Edit sequence values  
• Export sequences |

1. For more information on configuring database security administrators, see “Configuring database security administrators” section on page 131.
### Table 2: Tenant's landing page (2 of 2)

<table>
<thead>
<tr>
<th>Tenant Type</th>
<th>Tenant's landing page section</th>
<th>Default User</th>
<th>Regular User</th>
<th>Super User</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regular Tenant</td>
<td>Manage Tenant</td>
<td>• Edit Tenant</td>
<td>• Edit Tenant</td>
<td>• Edit Tenant</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Delete tenant</td>
<td>• Delete tenant</td>
<td>• Delete tenant</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Tenant data access: enabled</td>
<td>• Tenant data access: enabled</td>
<td>• Tenant data access: enabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Generate tenant program</td>
<td>• Generate tenant program</td>
<td>• Generate tenant program</td>
</tr>
<tr>
<td></td>
<td>Data Administration</td>
<td>• Deallocate tables</td>
<td>• Deallocate tables</td>
<td>• Deallocate tables</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Edit sequence values</td>
<td>• Edit sequence values</td>
<td>• Edit sequence values</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Export sequences</td>
<td>• Export sequences</td>
<td>• Export sequences</td>
</tr>
<tr>
<td></td>
<td>super-tenant</td>
<td>• Edit tenant</td>
<td>• Edit tenant</td>
<td>• Edit tenant</td>
</tr>
<tr>
<td></td>
<td>Manage Tenant</td>
<td>• Delete tenant</td>
<td>• Delete tenant</td>
<td>• Delete tenant</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Generate tenant program</td>
<td>• Generate tenant program</td>
<td>• Generate tenant program</td>
</tr>
<tr>
<td></td>
<td>Data Administration</td>
<td>• Edit sequence values</td>
<td>• Edit sequence values</td>
<td>• Edit sequence values</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Deallocate tables</td>
<td>• Deallocate tables</td>
<td>• Deallocate tables</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Edit sequence values</td>
<td>• Edit sequence values</td>
<td>• Edit sequence values</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Export sequences</td>
<td>• Export sequences</td>
<td>• Export sequences</td>
</tr>
</tbody>
</table>

1. The **Delete tenant** link is not available for the default tenant, because the default tenant in a database connection cannot be deleted by either a regular or super user.

2. A regular user can export sequences of its own, but cannot export sequences of the default tenant or other regular tenants.

3. The **Delete tenant** link is not available for the tenant to which the logged user belongs to. For example, for a regular user, the **Delete tenant** link is not available for a regular tenant.

4. A default user cannot export sequences of a regular tenant.

5. The **Edit sequence values**, **Deallocate tables**, and **Export sequences** options are not available for a super user, because super-tenant does not have data of its own.
Table 3 lists the options available for each type of user associated with the database connection, and the tenant type selected in the Edit Tenant’s landing page. Note that full access to the Edit tenant’s landing page requires a database connection for a user associated with either a super-tenant or that specific tenant.

### Table 3: Edit Tenant’s landing page

<table>
<thead>
<tr>
<th>Tenant Type</th>
<th>Default User</th>
<th>Regular User</th>
<th>Super User</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Tenant¹</td>
<td>• Tabs: General, Partitions, Users, Domains</td>
<td>• Tabs: General, Partitions, Users, Domains</td>
<td>• Tabs: General, Partitions, Users, Domains</td>
</tr>
<tr>
<td></td>
<td>• Configure working areas</td>
<td>• Configure working areas</td>
<td>• Configure working areas</td>
</tr>
<tr>
<td></td>
<td>• Commit</td>
<td>• Commit</td>
<td>• Commit</td>
</tr>
<tr>
<td></td>
<td>• Tools</td>
<td>• Tools</td>
<td>• Tools</td>
</tr>
<tr>
<td>Regular Tenant</td>
<td>• Tabs: General, Partitions, Users, Domains, Groups</td>
<td>• Tabs: General, Partitions, Users, Domains, Groups</td>
<td>• Tabs: General, Partitions, Users, Domains, Groups</td>
</tr>
<tr>
<td></td>
<td>• Configure working areas</td>
<td>• Configure working areas</td>
<td>• Configure working areas</td>
</tr>
<tr>
<td></td>
<td>• Commit</td>
<td>• Commit</td>
<td>• Commit</td>
</tr>
<tr>
<td></td>
<td>• Tools</td>
<td>• Tools</td>
<td>• Tools</td>
</tr>
<tr>
<td>Super-tenant¹</td>
<td>• Tabs: General, Users, Domains</td>
<td>• Tabs: General, Users, Domains</td>
<td>• Tabs: General, Users, Domains</td>
</tr>
<tr>
<td></td>
<td>• Commit</td>
<td>• Commit</td>
<td>• Commit</td>
</tr>
<tr>
<td></td>
<td>• Tools</td>
<td>• Tools</td>
<td>• Tools</td>
</tr>
</tbody>
</table>

1. As the default tenant and a super-tenant cannot be added to a group, the Groups tab is not available for the default tenant or super-tenant. Also, for a super-tenant, the **Partitions** tab and **Configure working areas** options are not available, as a super-tenant does not have any data of its own.
Working with tenant templates

As you create and work with regular tenants, you might find that the initial configuration you set up for each tenant is identical. For example, you might recognize that the database connection and the default area assignments for tables, indexes, and LOB fields are the same for many newly created tenants.

To allow you to create regular tenants more efficiently, you can create one or more reusable tenant templates.

This chapter provides the following information about working with tenant templates:

- Using tenant templates
- Creating a tenant template
- Filtering partitions from a tenant template
- Viewing a list of available tenant templates
- Creating a tenant from a tenant template
- Editing a tenant template
Using tenant templates

To allow you to create regular tenants more efficiently, you can create one or more reusable tenant templates. Once you create a tenant template, you can use it as is or later modify it if necessary. Template modifications affect any new tenants you create from the edited template. (Any tenants already created remain unchanged.)

You begin creating a template from Database Administration in the management console menu bar. You can work on one or more tenant templates simultaneously.

When you later want to create a regular tenant, you can select the tenant template from a list of available templates.

Allocation considerations when creating a tenant template

When you create a tenant template, you choose between the following two allocation options:

- Set new objects not to allocate space
- Set new objects to delay space allocation

Note that the option to allocate space immediately is not available, since it would disallow the creation of partition mapping for any tenant you create with the template. A template that stipulates that allocation should be immediate would establish default assignments and ignore any area assignments you try to set, as allocation would already be complete.
Creating a tenant template

To make creating tenants easier, you can create a tenant template. As you define the template, you must at a minimum provide the name of the template and make an allocation rule selection.

You establish tenant template settings on the General tab and the Partitions tab. As you select the template settings, you can switch between the two tabs, and then save the template once you finish with all the settings.

Choosing general tenant template settings

You create a tenant template by making choices about general and partition-related settings.

To choose general tenant template settings:

1. From the management console menu bar, choose Database Administration → New → Tenant Template. The template creation page opens, with the General details in focus:

2. In the Template name field, enter a template name.

Providing the template name is the only requirement on this page; however, you can also choose the database connection, identify default areas, and select an allocation rule if you want.

3. In the Database connection field, enter a database connection name to which you want to add the tenant template. By default, the last used database connection name appears in the Database connection field.

Note: If you type the name of the database connection, follow the format used by OpenEdge Management/OpenEdge Explorer to define a connection: container-name.database-name. A database server must be running for you to connect to the database.
You can also click the **Search** icon to choose a database for which you are creating the tenant from the **Connection Selection** dialog, as shown:

The **Connection Selection** dialog displays the connections details in a grid. You can perform the following:

- Filter the connections in the grid by **Connection name**, **Container**, and/or **Category**.
- Select the column heading and click the drop-down to choose the order (ascending or descending alphabetically) for the connections to appear in the grid.

4. Choose a selection for each of the following:

- **Default data area** — The default area for tenant data
- **Default index area** — The default area for index data
- **Default LOB area** — The default area for LOB field data
For each of the areas, you can either enter the storage area name in the default area field or click the **Search** icon to choose the storage area name from the **Area Selection** dialog, as shown:

The **Area Selection** dialog displays the storage area names in a grid. You can perform the following:

- Filter the storage area name in the grid by **Area name**, **Records per block**, and/or **Cluster size**.
- Move forward or backward a page, or specify a particular page, in the list of domains by using the **Page** feature at the bottom of the list.
- Select the column heading and click the drop-down to choose the order (ascending or descending alphabetically) for the area names to appear in the grid.

5. Optionally select the object allocation rule:

   - **Set new objects not to allocate space** — Allocate no space for the tenant’s objects.
   - **Set new objects to delay space allocation** — Do not yet allocate storage space. (You can allocate space later when you are ready to do so.)

6. Click **Save**.
Choosing partition-related template settings

You create a tenant template by choosing partition-related (and general) settings.

To choose partition-related template settings:

1. Click **Partitions**. The tenant template’s partitions appear:

![Partitions Page]

From this page, you can:

- Choose to view the partitions in either of two different layouts: by area panels, which is the default and is shown above, or by columns in a grid view. To switch from one layout option to the other, click the **View Grid** or **View Area** icon in the upper-right corner of the **Template Object Area Assignments** panel.

- Filter the partitions by allocation state. Click **Filter Partitions** in the tenant menu bar, and select one or more of the filtering options. Then click **Apply**.
• Make changes to the template object area assignments. This is helpful because when you use the template to create a tenant in the future, any partition changes that you make to individual tenant objects from this page during the template creation are preserved for the individual objects in the new tenant.

For example, consider that you define TenantArea20 (as shown in the General details) as the default data area for the template, but you want one particular table named mtCustomer to be in TenantArea25. You can change the partition assignment for the mtCustomer table from the template default data area of TenantArea20 to TenantArea25.

Select mtCustomer in the list of template object area assignments. The mtCustomer table properties appear in the Properties pane:

In the Properties pane, click the Search icon for the Area field; select TenantArea 25 in the Area Selection dialog and click OK.

When you use the template to create a tenant in the future, the tenant partition area you explicitly set for any object (such as the mtCustomer table in this example) in the template is preserved.

2. Click Save to maintain the settings. The tenant template is created.
Filtering partitions from a tenant template

You can filter the view of partitions by allocation state from a tenant template. You can also filter the view of partitions by allocation state from a tenant.

To filter partitions by allocation state from a tenant template:

1. Select Database Administration → Tenant Templates.
2. Highlight the template in the list, and click Edit template.
3. Click Filter partitions. The filtering options appear:

   ![Filtering options](image)

   All filtering options are selected by default. You can deselect any of the options. (To close the filtering options box without making any changes, click Filter partitions.)

4. Click Apply filter to begin the filtering.
Viewing a list of available tenant templates

You can view a list of available tenant templates and choose one to use as the basis for a new tenant you want to create. If you want to create a tenant that is almost but not exactly identical to one for which there is a template, you can select the template from the list, modify it, save it, and use the edited template as the basis for the new tenant.

To view the list of available tenant templates, choose Database Administration → Tenant Templates from the management console menu bar. The list of templates appears as shown in Figure 20.

Figure 20: Tenant templates list

From the tenant template list, you can:

- **Select all the templates** — Click the Select All check box.
- **Refresh the list of templates** — Click the Refresh icon.
- **Copy a template** — Select a template, and click the Copy icon. The Copy tenant template dialog appears. Type the name of the new template or accept the default name provided, and click OK.
- **Delete a template** — Select a template, and click Delete. The template name is immediately removed from the list.
Creating a tenant from a tenant template

You can create a new regular tenant from a tenant template.

Note that you can open a template only if it is associated with a valid database connection that you can access. If the database connection is no longer valid or accessible, either restore the database connection with the same connection name as required by the template, or delete the template.

To create a tenant from a tenant template:

1. From the management console, choose Database Administration→ Tenant Templates. The list of tenant templates appears (as shown in Figure 20).

2. Select the template you want to use, and click Create tenant from template. (If you do not see a recently created template in the list, click Refresh.) The tenant creation page opens:

If you defined any of the following settings when you created the selected tenant template, the settings are loaded for you:

- **Database connection**
- **Default data area**
- **Default index area**
Creating a tenant from a tenant template

- Default LOB area
- Object allocation rule
- Template (from which to copy defaults for the tenant)

You can use any or all of the template defaults, or you can make changes. The changes you make override any of the default settings for this tenant but do not modify the actual template.

3. Type the tenant name, which is required, and an optional description.

4. Do one of the following:
   - Click Create tenant. The tenant is created, and the tenant home page appears.
   - Click Generate tenant program. You are prompted to open or save the create_tenant.p file.
Editing a tenant template

You can edit an existing tenant template.

To edit a tenant template:

1. From the management console, click **Database Administration** → **Tenant Templates**. The list of tenant templates appears (as shown in Figure 20).

2. Select the template you want to edit, and click **Edit template**. The template’s **General** information appears.

3. Make any general changes; then open the **Partitions** information.

4. Make any partition changes (from either the area panels layout or the grid view layout); then click **Save**.
Working with sequences

From the database home page, you can work with sequences and their values.

This chapter provides the following information about working with sequences:

- Working with sequences and sequence values
- Editing sequence values
- Exporting sequences for a tenant
Working with sequences and sequence values

Sequences are database objects that provide incremental values to an application. They can generate sequential values within any range of an ABL integer (–2,147,483,648 to 2,147,483,647) and with your choice of increment (positive or negative).

You can also define sequences to cycle or terminate when a specified limit is reached. A cycling sequence restarts after it reaches the specified limit, providing non-unique values for the life of the sequence. A terminating sequence stops incrementing after it reaches the specified limit, providing unique values for the life of the sequence as long as you do not explicitly reset it.

Types of sequences

A multi-tenant sequence is defined for a database but allows each tenant to view and update its own current value. A shared sequence has one value and is non-multi-tenant enabled.

Each tenant’s sequence has its own current value. All other sequence settings are shared, including the minimum, maximum, increment, and rollover values. Changing the increment, therefore, affects the value for all tenants.

Sequence functionality and user credentials

Access to sequences and their values depends on the credentials of the user who has established the database connection. To be able to access and edit the current values, the user whose credentials were supplied at login must be either a super-tenant or a user of the tenant whose sequence values are being accessed. If the user is a super-tenant user, the user can access sequence current values for all tenants.

As a user of the regular tenant whose sequence values you want to work with, you can:

- View a list of sequences with details that include, for example, whether a sequence is enabled for multi-tenancy; a sequence’s initial value; and a sequence’s increment value.
- Edit the current values for shared sequences.
- Edit a tenant’s current values for the shared sequences.
- Edit a tenant’s current values for the multi-tenant sequences (provided that the user whose credentials were provided at database connection is a user of that tenant).
- Preview sequence definitions when loading a data definition file.
- Export to a file the current values for all multi-tenant.
- Export to a file the current values for shared sequences for the tenant (provided that the user whose credentials were provided at database connection is a user of that tenant).
Database connection user credentials for a super-tenant user permit the user to do all of the above as well as the following tasks:

- Edit the current values for all tenants of a multi-tenant sequence.
- Export by tenant the current values for all regular tenants to individual files. Each tenant has an individual file that contains the current sequence values for all multi-tenant sequences. For each tenant, an export file is created and holds the current sequence values for that tenant for each multi-tenant sequence.

The super-tenant does not have its own sequence data; therefore, when you export sequence values for multi-tenant sequences, no file is generated.

When a tenant is added to the database, a current sequence value (set to the initial value) is stored for the tenant for each multi-tenant sequence. When a tenant is removed from a database, each multi-tenant sequence and its current value for that tenant is dropped from the database.

You cannot currently convert a shared sequence to a multi-tenant sequence. However, you can add multi-tenant sequences, created in the Data Dictionary tool, to a database by loading a data definition file (.df) that contains them.

**Creating a multi-tenant sequence and loading a data definition file with sequences**

As has been the case in previous releases of OpenEdge, you create a sequence by using the Data Dictionary tool. With this release of OpenEdge, you can choose to create the sequence as multi-tenant. (If you do not choose the multi-tenant option, you create a shared sequence.)

Although you cannot create sequences from the Database Administration Console, you can use the tool to view and edit them. As you have done in previous releases, you begin by using the Data Administration tool (Start→ Programs (or All Programs)→ Progress→ OpenEdge→ Data Administration) to create a data definition file that contains sequences. Using the multi-tenancy configuration tool, you can then load the data definition file that contains the sequences into the database and edit the sequence current values.

Due to the importance of establishing the required user credentials to work with multi-tenancy, many tasks that you perform related to multi-tenancy in the Data Dictionary tool or the Data Administration tool require the user ID and password of a super-tenant user.
Chapter 8: Working with sequences

Exporting current sequence values

By using the Data Administration tool (Start→ Programs (or All Programs)→ Progress→ OpenEdge→ Data Administration) in the current version of OpenEdge, you can export current sequence values to a file. You have the option of doing so for multi-tenant sequences, shared sequences, or all sequences. You can then import the file to the database by using Data Administration or an ABL program. For more information, see the Data Administration online help or OpenEdge Development: ABL Reference.

By configuring multi-tenancy in the Database Administration Console, you can export all current values for all tenants at one time. For more information, see the "Exporting sequences for a tenant" section on page 157.

Viewing a list of sequences

You can view a list of sequences for a database from the database’s home page. If you have connected to the database as a super-tenant user, you can view a list of multi-tenant enabled sequences for all tenants, since a super-tenant has access to all tenant data. You can also edit and export the sequence current values of multi-tenant enabled tenants.

If you have connected to the database as a regular tenant user, you can view a list of sequences only for the tenant you belong to. You cannot view, edit, or export sequence current values for any other tenants.

To view a list of sequences:

1. Choose Database Administration→ Database Connections.

2. From the list of database connections, choose a database connection. The database home page appears.

3. In the Data Administration panel, click Edit sequences. The Edit Database Sequences page appears:
Note that if you have a long list of sequences, you can type a particular sequence name in the **Sequence name** field and click the **Search** icon. You can move forward or backward the page, or specify a particular page, in the list of sequences by using the **Page** feature at the bottom of the grid.

**Note:** You can also sort the details by column in either ascending or descending order by clicking the column name and then the **Sort** arrow.

The **Edit Database Sequences** page provides the following details:

- **Sequence Name** — The name of the sequence.
- **Multi-tenant** — Whether the sequence is enabled for multi-tenancy (**true**) or not (**false**).
- **Initial Value** — The value at which a sequence begins to increase (or decrease).
- **Increment by** — The value by which a sequence will increment (or decrement) values from the initial value.
- **Upper Limit** — An integer value that defines the upper (or lower) limit of the sequence.
- **Cyclic at Limit** — Whether a cycling sequence has been activated (**true**) or not (**false**).

A cycling sequence is a sequence that restarts after it reaches the specified limit, providing non-unique values for the life of the sequence. The value of a cycling sequence resets to its defined initial value when the sequence exceeds its upper limit or falls below its lower limit providing non-unique values for the life of the sequence. The terminating sequence stops increasing when it reaches its upper limit or stops decreasing when it reaches its lower limit, providing unique values as long as you do not explicitly reset it.

- **Current Value** — The current value of the sequence.

  For a newly created (not yet committed) sequence, the field is empty. For a shared sequence, the current value for the sequence is shown.

  For a multi-tenant sequence value you can change, an **Edit** link appears. For more information, see the “Editing sequence values” section on page 154.

4. From the list, you can:

   - Edit a multi-tenant sequence’s current value. See **Editing sequence values**.
   - Restore an edited sequence’s current value to its previous setting. See **Restoring sequence current values**.
Editing sequence values

You can edit the values for all sequences for a particular tenant or for all tenants of a particular sequence.

If you have connected to the database as a super-tenant user, you can edit and you can export the sequence current values of all multi-tenant enabled tenants.

If you have connected to the database as a regular tenant user, you can view a list of sequences and edit sequence current values for only that tenant you belong to. You cannot edit sequence current values for any other tenants.

To edit the current values for all sequences for a tenant:

1. Choose Database Administration → Database Connections.
2. From the database connections list, choose a database connection. The tenants for the database connection appears in a list.
3. Click Tenants.
4. Select a tenant. The tenant home page appears.
5. In the Data Administration panel, click Edit sequence values. The Edit Tenant Sequence Current Values page appears:
If you have a long list of multi-tenant sequences, you can type a particular sequence name in the **Sequence name** field and click the **Search** icon. You can also move forward or backward the page, or specify a particular page, in the list of sequences by using the **Page** feature at the bottom of the grid.

**Note:** You can also sort the details by column in either ascending or descending order by clicking the column name and then the **Sort** arrow.

6. To modify the current value of a multi-tenant sequence, click the value for the sequence in the **Current Value** column.

7. Change the sequence value. A red mark appears in the corner of the column cell to indicate that the value has been changed.

8. Click **Commit**.

To edit the values for all tenants of a sequence:

1. Choose **Database Administration** → **Database Connections**.

2. From the database connections list, choose a database connection. The database home page appears.

3. In the **Data Administration** panel, click **Edit sequences**. The Edit Database Sequences page appears:
4. To modify the current value of a multi-tenant sequence, click **Edit** in the **Current Value** column for the sequence. The **Multi-tenant Sequence** page appears:

![Edit Multi-Tenant Sequence Values](image)

A list of tenants appears, along with the current value for the sequence for each tenant.

5. Click in the **Current Value** column to set or change the sequence value for a tenant. A red mark appears in the corner of the column to indicate that the value has been changed.

6. Click **Commit** to save the changes.

**Restoring sequence current values**

You can restore a sequence current value that you have modified.

From the **Multi-tenant Sequence** page, select a tenant name and click **Restore**. The previous value is restored to the **Current Value** column.
Exporting sequences for a tenant

A super-tenant user can export sequences for one or more tenants; a regular tenant user can export current sequence values only for the tenant the user belongs to.

You cannot export sequences if you are connected to the database with the blank user ID.

To export sequences for one or more tenants in the database:

1. Establish the database connection as a super-tenant user.
2. Choose Database Administration → Database Connections.
3. From the database connections list, choose a database connection. The database connection details page appears.
4. In the Data Administration panel, click Export sequences.

If the database connection is a non multi-tenant database, the Export sequence current values page appears, as shown:

![Export sequence current values](image)

Note: The tenant selection options do not display for non multi-tenant databases.

If the database connection is a multi-tenant database, the Export sequences current values page appears, as shown:

![Export sequences current values](image)
Chapter 8: Working with sequences

The following information is prefilled:

- **Container name** — The container for the connected database.
- **Directory location** — Where the exported file will be located.
- **File name** — The name of the exported file.

Note that if you export only non-multi-tenant enabled sequences, all the sequence data will be located in the one file specified in this field. However, if the export includes multi-tenacy enabled sequences and the sequences have different values per tenant, a new directory is created (in the Directory location you specified) for each tenant. Each separate directory contains a file; the file contains the exported sequences and current values specific to that tenant.

- **Code page** — The code page.

5. Select which type of sequence you want to export: **All**, **Shared**, or **Multi-tenant**.

6. Select one or more tenants, or click **Select all** for all the tenants listed.

7. Click **Export**. The **My Dashboard** page appears so that you can review the progress of the export in the **Multi-tenancy Tasks** viewlet.

You cannot import the exported file to a database from the Database Administration Console; you can, however, use the Data Administration tool (Start→Programs (or All Programs)→Progress→OpenEdge→Data Administration), which has been enhanced to accommodate the inclusion of multi-tenancy-enabled sequences when you are exporting or importing data. For more information, see the Data Dictionary online help.

To export sequence current values for a selected tenant:

1. Establish the database connection as a regular tenant user.

2. Choose **Database Administration**→**Database Connections**.

3. From the database connections list, choose a database connection. The tenants for the selected database connection appears in a list.

4. Click the **Tenants** tab, and select a tenant. The tenant home page appears.
5. In the **Data Administration** panel, click **Export sequences**. The **Export Tenant Sequence Current Values** page appears and includes the tenant name (in this case, **SNCSoftware**):

![Export Tenant Sequence Current Values](image)

The following information is prefilled:

- **Container name** — The container for the connected database.
- **Use default location** — Indicates if you want to use the OpenEdge Work directory (the default) for the location of the exported file. This option is preselected; to choose an alternate location, clear the check box and provide a new location in the **Directory location** field.
- **Directory location** — Where the exported file will be located.
- **File name** — The name of the exported file.
- **Code page** — The code page.

6. Select which type of sequence you want to export: **All**, **Shared**, or **Multi-tenant**.

7. Click **Export**. The **My Dashboard** page appears so that you can review the progress of the export in the **Multi-tenancy Tasks** viewlet.
A tenant group represents a single partition for a single table, along with the partitions for the table’s LOB fields and indexes, that can be shared by tenants. All tenants in a group have access to the same data. When you create a group, you are creating an independent partition that multiple tenants view.

This chapter provides the following information about working with groups:

- Using tenant groups
- Creating a group or group program
- Editing a group
- Viewing a list of tenant groups
- Viewing group details
- Searching for available groups
- Removing a tenant from a group
Using tenant groups

You can create a tenant group, which allows the tenants in the group access to the same data. A group can contain one table and one tenant, multiple tenants, or no tenants at all. You can add only regular tenants to a group.

If you prefer, you can, as an alternative, set up the group’s properties, generate a group creation program based on those properties, and save the program so you can run it when you want. Generating the program alone does not create the group; you create the group when you run the generated program.

Guidelines for using groups

Keep in mind the following considerations as you work with tenant groups:

- When you initially create a group, the group has no tenants. You can take a table from an existing tenant’s schema and add it to the group.
- You cannot add a tenant to a group if the tenant’s partitions are already allocated.
- Once you assign a tenant to a group, that tenant can no longer access any data in the tenant’s partition for the table partition associated with the group. In other words, the tenant can have only one partition for each given table.
- A tenant can belong to more than one group but cannot belong to two groups for the same table.
- Removing a tenant from a group restores the tenant’s unique partition information for that table based on the defaults that are set up in the tenant record.
Creating a group or group program

You can create a group and then add one or more tenants to it.

1. Begin creating a group by doing **either** of the following from the management console:
   - Choose **Database Administration → Database Connections**. In the list frame on the left, select the database for which you want to create a group.
     
     Click **Groups**, then click **New** in the list frame.
   - Choose **Database Administration → New → Group**.

   The **New Group** page opens:

   ![New Group Page](image)

   2. Provide the following information:

   - **Group name** — The name of the group, which must be unique within the database. Do not use spaces or special characters such as an asterisk (*), ampersand (&), or period (.) in this field. You can include the underscore (_).
   - **Description** — An optional description of the group.

   3. In the **Database connection** name, enter a database connection name to which you want to add the new group. By default, the last used database connection name appears in the **Database connection** field.

   **Note:** If you type the name of the database connection, follow the format used by OpenEdge Management/OpenEdge Explorer to define a connection: `container-name.database-name`. A database server must be running for you to connect to the database.
You can also click the **Search** icon to choose a database for which you are creating the tenant from the **Connection Selection** dialog, as shown:

The **Connection Selection** dialog displays the connections details in a grid. You can perform the following:

- Filter the connections in the grid by a **Connection name**, **Container**, and/or **Category**.

- Select the column heading and click the drop-down to choose the order (ascending or descending alphabetically) for the connections to appear in the grid.
4. Choose the **Table** you want to place in the group by either typing the table name or clicking the **Search** icon to select the table from the **Table Selection** dialog, as shown:

![Table Selection Dialog]

**Note:** There is one table per group and one or more tenants per group.

5. Select the default data area, default index area, and default LOB area. For each of the areas, you can either type the area name or click the **Search** icon to select the area from the **Area Selection** dialog, as shown:

![Area Selection Dialog]
The **Area Selection** dialog displays the storage area names in a grid. You can perform the following:

- Filter the storage area name in the grid by **Area name**, **Records per block**, and/or **Cluster size**.

- Move forward or backward a page, or specify a particular page, in the list of domains by using the **Page** feature at the bottom of the list.

- Select the column heading and click the drop-down to choose the order (ascending or descending alphabetically) for the area names to appear in the grid.

6. On the **Partitions** tab, select an item in the table schema to view its properties, which include name, type, area, buffer pool assignment, and allocation state:

7. Set the area for each partition *individually* by clicking the **Search** icon and choosing an area from the list.

8. Select a buffer pool assignment of **Primary** or **Alternate**.

9. To modify the allocation state, choose from either of the options.

10. Choose one:

    To add one or more tenants to the group and then create the group immediately:

    a. Click the **Tenants** tab.

    b. Click **Add Tenant**.

    c. From the list of tenants that appears, select one or more tenants.

    d. Click **OK**. The newly added tenants are listed as belonging to the group.
Creating a group or group program

e. Click **Save** to save the group. If the partition in the group has already been allocated for a newly added tenant, an error message appears and the group is not created.

To save the group without adding tenants:

f. Click **Save**.

g. Click **Yes** to the message confirming that the group has no tenants.

To create a group creation script, click **Generate group program**.

11. From the list of groups, click **Refresh**. The new group appears in the list of groups.
Chapter 9: Working with tenant groups

Editing a group

You can make changes to a group; for example, you can edit the existing group details, add tenants, add partitions, or rename a group (when the group has tenants as members).

To edit a group:

1. Choose Database Administration → Database Connections. In the list frame on the left, select the database for which you want to create a group.

2. From the database connections list, choose a database connection.

3. Click Groups.

4. From the list of groups in the list frame on the left, highlight the name of the group you want to modify and then click Edit below the group’s name. The group’s details appear.

5. In the Group name field, replace the existing group name with a new group name.

6. Modify the description of the group (optional).

7. To make partition changes, select a table in the schema on the Partitions tab. Then:
   - Click the Area drop-down arrow if you want to choose a different area.
   - Click the Buffer pool dropdown to change from Primary to Alternate, or vice versa.
   - To change the allocation state, select the appropriate option.

8. To add a new tenant, click Tenants and then click Add Tenant. Click Remove to remove an existing tenant from the group.

9. Click Save to save the changes.
Adding a tenant to a group

You can add a tenant to a group as long as the partition in the group has not already been allocated as a partition for the same table for the tenant.

For more details about adding a tenant to a group, see the “Guidelines for using groups” section on page 162.

You can add a tenant to a group in two ways:

- From the tenant
- From the group

To add a tenant to a group from the tenant:

1. From the management console, choose Database Administration→Database Connections.
2. Choose the database connection.
3. Click Tenants.
4. From the list of tenants in the list frame, select the tenant you want to add to a group.
5. Click Edit tenant in the detail frame. The tenant details appear.
6. Click the Groups tab.
7. From the tenant menu bar, click Add Group. The Group Selection dialog appears, as shown:
The **Group Selection** dialog displays the groups for the selected tenant in a grid. You can perform the following:

- Filter the groups in the grid by Group name and/or Table name.
- Move forward or backward a page, or specify a particular page, in the list of tables by using the **Page** feature at the bottom of the list.
- Select the column heading and click the drop-down to choose the order (ascending or descending alphabetically) for the groups to appear in the grid.

8. From the list of available groups, select the group you want and click **OK**. The group name and group title appear for the tenant.

9. Click **Commit**.

To add a tenant to a group from the group:

1. From the management console, choose **Database Administration** → **Database Connections**.
2. Choose the database connection.
3. Click **Groups**.
4. Select the group from the list frame. The group’s details appear.
5. Click **Tenants**.
6. Click **Add Tenant**.
7. Select the tenants you want to add to the group.
8. Click **OK**. The names of the tenants appear.
9. Click **Save**.

If the partition in the group has already been allocated for a selected tenant, an error message appears and the group is not created.

If the partition has not yet been allocated, the group is created with the selected tenants.
Viewing a list of tenant groups

You can view a list of tenant groups that exist for a multi-tenant database.

To view a list of groups:

1. From the management console, choose **Database Administration** → **Database Connections**.
2. From the database connections list, choose a database connection.
3. Click **Groups**. The list of groups defined for the selected database appears in the list frame on the left.
Chapter 9: Working with tenant groups

Viewing group details

You can view details about an existing group.

To view a group’s details:

1. From the management console, choose Database Administration → Database Connections.
2. Choose the database connection.
3. Click Groups.
4. Click the name of the group whose details you want to see. The details appear in the detail frame on the right.
Searching for available groups

You can search for a particular tenant group.

To search for a group:

1. From the management console, choose Database Administration → Database Connections.
2. Choose the database connection.
3. Click Groups.
4. Do either of the following:
   - Type the name of the group you are searching for in the Search field, and then click Search (the magnifying glass). The list of groups appears.
   - Click Filter and type the table name in the field provided. A list of groups for that table appears.
Chapter 9: Working with tenant groups

Removing a tenant from a group

You can remove a tenant from a group. If you later change your mind, you can restore the tenant to the group.

You can remove the tenant from either the tenant itself or from the group.

To remove a tenant from a group from the tenant:

1. From the management console, choose Database Administration → Database Connections.
2. Click the database connection.
3. Click Tenants.
4. Click the tenant you want to remove. The tenant home page appears.
5. Click Edit tenant.
6. Click Groups.
7. Select the group name, and click Remove.

To restore the tenant to the group, click Restore.

To remove a tenant from a group from the group:

1. From the management console, choose Database Administration → Database Connections.
2. Click the database connection.
3. Click Groups.
4. Click the group from which you want to remove the tenant.
5. Click the Tenants tab.
6. Select the tenant, and click Remove.
Third Party Acknowledgements

One or more products in the Progress OpenEdge v11.3 release includes third party components covered by licenses that require that the following documentation notices be provided:

Progress OpenEdge v11.3 may incorporate ANT v1.5.4. Such technology is subject to the following terms and conditions: The Apache Software License, Version 1.1, applies to all versions of up to ant 1.6.0 included. The Apache Software License, Version 1.1 - Copyright (C) 2000-2003 The Apache Software Foundation. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment: "This product includes software developed by the Apache Software Foundation (http://www.apache.org/)." Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party acknowledgments normally appear. 4. The names "Ant" and "Apache Software Foundation" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact apache@apache.org. 5. Products derived from this software may not be called "Apache", nor may "Apache" appear in their name, without prior written permission of the Apache Software Foundation. THIS SOFTWARE IS PROVIDED "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
Appendix A: Third Party Acknowledgements

ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE. This software consists of voluntary contributions
made by many individuals on behalf of the Apache Software Foundation. For more
information on the Apache Software Foundation, please see

Progress OpenEdge v11.3 may incorporate Apache Avalon 2002/08/06, Apache Batik
v1.1, Apache Jakarta POI v1.1, Apache POI 2003/05/14, Regexp (Pure Java Regular
Expression) v1.2, and XMLTask v1.15.1 from The Apache Software Foundation. Such
technologies are subject to the following terms and conditions: The Apache Software
License, Version 1.1 Copyright (c) 2000 The Apache Software Foundation. All rights
reserved. Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met: 1.
Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer. 2. Redistributions in binary form must
reproduce the above copyright notice, this list of conditions and the following disclaimer
in the documentation and/or other materials provided with the distribution. 3. The
end-user documentation included with the redistribution, if any, must include the
following acknowledgment: "This product includes software developed by the Apache
Software Foundation (http://www.apache.org")." Alternately, this acknowledgment
may appear in the software itself, if and wherever such third-party acknowledgments
normally appear. 4. The names "Apache" and "Apache Software Foundation" must not
be used to endorse or promote products derived from this software without prior written
permission. For written permission, please contact apache@apache.org. 5. Products
derived from this software may not be called "Apache", nor may "Apache" appear in
their name, without prior written permission of the Apache Software Foundation. THIS
SOFTWARE IS PROVIDED "AS IS" AND ANY EXPRESSED OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR
ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF
USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE. This software consists of voluntary contributions
made by many individuals on behalf of the Apache Software Foundation. For more
information on the Apache Software Foundation, please see
<http://www.apache.org/>. Portions of this software are based upon public domain
software originally written at the National Center for Supercomputing Applications,
University of Illinois, Urbana-Champaign.

Progress OpenEdge v11.3 may incorporate Apache JAXP v1.3.04 from The Apache
Software Foundation. Such technology is subject to the following terms and conditions:
The Apache Software License, Version 1.1 Copyright (c) 1999-2003 The Apache
Software Foundation. All rights reserved. Redistribution and use in source and binary
forms, with or without modification, are permitted provided that the following conditions
are met: 1. Redistributions of source code must retain the above copyright notice, this
list of conditions and the following disclaimer. 2. Redistributions in binary form must
reproduce the above copyright notice, this list of conditions and the following disclaimer
in the documentation and/or other materials provided with the distribution. 3. The
end-user documentation included with the redistribution, if any, must include the
following acknowledgment: "This product includes software developed by the Apache
Software Foundation (http://www.apache.org")." Alternately, this acknowledgment
may appear in the software itself, if and wherever such third-party acknowledgments
normally appear. 4. The names "Xalan" and "Apache Software Foundation" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact apache@apache.org. 5. Products derived from this software may not be called "Apache", nor may "Apache" appear in their name, without prior written permission of the Apache Software Foundation. THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. This software consists of voluntary contributions made by many individuals on behalf of the Apache Software Foundation and was originally based on software copyright (c) 1999, Lotus Development Corporation., http://www.lotus.com. For more information on the Apache Software Foundation, please see http://www.apache.org/.

Progress OpenEdge v11.3 may incorporate Crimson v1.1.3 from Progress Extensions for Eclipse v2.2.1. Such technology is subject to the following terms and conditions: The Apache Software License, Version 1.1 Copyright (c) 1999-2003 The Apache Software Foundation. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment: "This product includes software developed by the Apache Software Foundation (http://www.apache.org/)." Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party acknowledgments normally appear. 4. The names "Xerces" and "Apache Software Foundation" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact apache@apache.org. 5. Products derived from this software may not be called "Apache", nor may "Apache" appear in their name, without prior written permission of the Apache Software Foundation. THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. This software consists of voluntary contributions made by many individuals on behalf of the Apache Software Foundation and was originally based on software copyright (c) 1999, International Business Machines, Inc., http://www.ibm.com. For more information on the Apache Software Foundation, please see <http://www.apache.org/>.
Appendix A: Third Party Acknowledgements

Progress OpenEdge v11.3 may incorporate jfor v0.7.2 from jfor. Such technology is subject to the following terms and conditions: jfor Apache-Style Software License. Copyright (c) 2002 by the jfor project. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment: "This product includes software developed by the jfor project (http://www.jfor.org)." Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party acknowledgments normally appear. 4. The name "jfor" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact info@jfor.org. 5. Products derived from this software may not be called "jfor", nor may "jfor" appear in their name, without prior written permission of info@jfor.org. THIS SOFTWARE IS PROVIDED `AS IS` AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE JFOR PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Progress OpenEdge v11.3 may incorporate Apache LogKit v1.2 from The Apache Software Foundation. Such technologies are subject to the following terms and conditions: The Apache Software License, Version 1.1 -- Copyright (C) 1997-2003 The Apache Software Foundation. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment: "This product includes software developed by the Apache Software Foundation (http://www.apache.org/)." Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party acknowledgments normally appear. 4. The names "LogKit", "Jakarta" and "Apache Software Foundation" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact apache@apache.org. 5. Products derived from this software may not be called "Apache", nor may "Apache" appear in their name, without prior written permission of the Apache Software Foundation. THIS SOFTWARE IS PROVIDED `AS IS` AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING

OpenEdge® Management™ and OpenEdge Explorer: Configuring Multi-tenancy
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. This software consists of voluntary contributions made by many individuals on behalf of the Apache Software Foundation. For more information on the Apache Software Foundation, please see <http://www.apache.org/>.

Progress OpenEdge v11.3 may incorporate Xerces for Java XML Parser v2.6.2. Such technology is subject to the following terms and conditions: The Apache Software License, Version 1.1 Copyright (c) 1999 The Apache Software Foundation. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment: "This product includes software developed by the Apache Software Foundation (http://www.apache.org/)." Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party acknowledgments normally appear. 4. The names "Xerces" and "Apache Software Foundation" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact apache@apache.org. 5. Products derived from this software may not be called "Apache", nor may "Apache" appear in their name, without prior written permission of the Apache Software Foundation. THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. This software consists of voluntary contributions made by many individuals on behalf of the Apache Software Foundation and was originally based on software copyright (c) 1999, International Business Machines, Inc., http://www.ibm.com. For more information on the Apache Software Foundation, please see <http://www.apache.org/>.

Progress OpenEdge v11.3 may incorporate SOAP v2.3.1 from Apache Foundation. Such technology is subject to the following terms and conditions: The Apache Software License, Version 1.1

Copyright (c) 1999 The Apache Software Foundation. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment: "This product includes software developed by the Apache Software Foundation (http://www.apache.org/)."

Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party acknowledgments normally appear.

4. The names "SOAP" and "Apache Software Foundation" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact apache@apache.org.

5. Products derived from this software may not be called "Apache", nor may "Apache" appear in their name, without prior written permission of the Apache Software Foundation.

THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This software consists of voluntary contributions made by many individuals on behalf of the Apache Software Foundation. For more information on the Apache Software Foundation, please see <http://www.apache.org/>.

Progress OpenEdge v11.3 may incorporate ANTLR (Another Tool for Language Recognition) v2.7.6. Such technology is subject to the following terms and conditions: ANTLR 3 License [The BSD License] Copyright (c) 2003-2006, Terence Parr All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the name of the author nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Progress OpenEdge v11.3 may incorporate Castor v0.9.3 from castor.org. Such technology is subject to the following terms and conditions: Original Intalio license -
Appendix A: Third Party Acknowledgements

REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE
MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY
PARTICULAR PURPOSE. decstrtod.c License: The author of this software is David M. Gay. Copyright (C) 1998-2001 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
decstrtof.c License: The author of this software is David M. Gay. Copyright (C) 1998, 2000 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
dm misc.c License: The author of this software is David M. Gay. Copyright (C) 1998 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
gdtoa.c License: The author of this software is David M. Gay. Copyright (C) 1998, 1999 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT
SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL,
INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER
RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION
OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF
OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

hd_init.c License: The author of this software is David M. Gay. Copyright (C) 2000 by
Lucent Technologies All Rights Reserved Permission to use, copy, modify, and
distribute this software and its documentation for any purpose and without fee is hereby
granted, provided that the above copyright notice appear in all copies and that both that
the copyright notice and this permission notice and warranty disclaimer appear in
supporting documentation, and that the name of Lucent or any of its entities not be
used in advertising or publicity pertaining to distribution of the software without specific,
written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD
TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS
ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL
DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE,
DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR
OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE
USE OR PERFORMANCE OF THIS SOFTWARE.

misc.c License: The author of this software is David M. Gay. Copyright (C) 1998, 1999 by Lucent Technologies All Rights
Reserved Permission to use, copy, modify, and distribute this software and its
documentation for any purpose and without fee is hereby granted, provided that the
above copyright notice appear in all copies and that both that the copyright notice and
this permission notice and warranty disclaimer appear in supporting documentation,
and that the name of Lucent or any of its entities not be used in advertising or publicity
pertaining to distribution of the software without specific, written prior permission.
LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE,
INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS.
IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY
SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS
ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR
PERFORMANCE OF THIS SOFTWARE.

misc.c License: The author of this software is David M. Gay. Copyright (C) 1998, 1999 by Lucent Technologies All Rights
Reserved Permission to use, copy, modify, and distribute this software and its
documentation for any purpose and without fee is hereby granted, provided that the
above copyright notice appear in all copies and that both that the copyright notice and
this permission notice and warranty disclaimer appear in supporting documentation,
and that the name of Lucent or any of its entities not be used in advertising or publicity
pertaining to distribution of the software without specific, written prior permission.
LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE,
INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS.
IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY
SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS
ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR
PERFORMANCE OF THIS SOFTWARE.

strtodg.c License: The author of this software is David M. Gay. Copyright (C) 1998-2001 by Lucent Technologies All Rights
Reserved Permission to use, copy, modify, and distribute this software and its
documentation for any purpose and without fee is hereby granted, provided that the
above copyright notice appear in all copies and that both that the copyright notice and
this permission notice and warranty disclaimer appear in supporting documentation, and that the name
of Lucent or any of its entities not be used in advertising or publicity pertaining to
distribution of the software without specific, written prior permission.

LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE,
INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS.
IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY
SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS
ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR
PERFORMANCE OF THIS SOFTWARE. strord.c License: The author of this software
is David M. Gay. Copyright (C) 1998, 2000 by Lucent Technologies All Rights
Reserved Permission to use, copy, modify, and distribute this software and its
documentation for any purpose and without fee is hereby granted, provided that the
above copyright notice appear in all copies and that both that the copyright notice and
this permission notice and warranty disclaimer appear in supporting documentation,
and that the name of Lucent or any of its entities not be used in advertising or publicity
pertaining to distribution of the software without specific, written prior permission.

LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE,
INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS.
IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY
SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS
ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR
PERFORMANCE OF THIS SOFTWARE. sum.c License: The author of this software is
David M. Gay. Copyright (C) 1998 by Lucent Technologies All Rights Reserved
Permission to use, copy, modify, and distribute this software and its documentation for
any purpose and without fee is hereby granted, provided that the above copyright
notice appear in all copies and that both that the copyright notice and this permission
notice and warranty disclaimer appear in supporting documentation, and that the name
of Lucent or any of its entities not be used in advertising or publicity pertaining to
distribution of the software without specific, written prior permission.

LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE,
INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS.
IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY
SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS
ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

ulp.c License: The author of this software is David M. Gay. Copyright (C) 1998, 1999
by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and
distribute this software and its documentation for any purpose and without fee is hereby
granted, provided that the above copyright notice appear in all copies and that both that
the copyright notice and this permission notice and warranty disclaimer appear in
supporting documentation, and that the name of Lucent or any of its entities not be
used in advertising or publicity pertaining to distribution of the software without specific,
written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD
TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS
ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL
DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE,
DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR
OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE
USE OR PERFORMANCE OF THIS SOFTWARE.
Progress OpenEdge v11.3 may incorporate DOM4J v1.6.1 from MetaStuff, Ltd. Such technology is subject to the following terms and conditions: Copyright 2001-2005 (C) MetaStuff, Ltd. All Rights Reserved. Redistribution and use of this software and associated documentation ("Software"), with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain copyright statements and notices. Redistributions must also contain a copy of this document. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. The name "DOM4J" must not be used to endorse or promote products derived from this Software without prior written permission of MetaStuff, Ltd. For written permission, please contact dom4j-info@metastuff.com. 4. Products derived from this Software may not be called "DOM4J" nor may "DOM4J" appear in their names without prior written permission of MetaStuff, Ltd. DOM4J is a registered trademark of MetaStuff, Ltd. 5. Due credit should be given to the DOM4J Project - http://www.dom4j.org THIS SOFTWARE IS PROVIDED BY METASTUFF, LTD. AND CONTRIBUTORS "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL METASTUFF, LTD. OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Progress OpenEdge v11.3 may incorporate GraphicsMagick v1.3.14 from GraphicsMagick Group. Such technology is subject to the following terms and conditions:

.. This text is in reStucturedText format, so it may look a bit odd. .. See http://docutils.sourceforge.net/rst.html for details.

GraphicsMagick Copyrights and Licenses

This file is part of the GraphicsMagick software distributed by the GraphicsMagick Group.

[*Please note that the legal community considers 15 or more total lines of code or text (not necessarily contiguous) to be significant for the purposes of copyright. Repeated changes such as renaming a symbol has similar significance to changing one line of code.*]

The licenses which components of this software fall under are as follows.

1) In November 2002, the GraphicsMagick Group created GraphicsMagick from ImageMagick Studio's ImageMagick and applied the "MIT" style license: Copyright (C) 2002 - 2012 GraphicsMagick Group
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the “Software”), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions: The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software. THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

2) In October 1999, ImageMagick Studio assumed the responsibility for the development of ImageMagick (forking from the distribution by E. I. du Pont de Nemours and Company) and applied a new license:

Copyright (C) 2002 ImageMagick Studio, a non-profit organization dedicated to making software imaging solutions freely available.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files ("ImageMagick"), to deal in ImageMagick without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of ImageMagick, and to permit persons to whom the ImageMagick is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of ImageMagick.

The software is provided "as is", without warranty of any kind, express or implied, including but not limited to the warranties of merchantability, fitness for a particular purpose and noninfringement. In no event shall ImageMagick Studio be liable for any claim, damages or other liability, whether in an action of contract, tort or otherwise, arising from, out of or in connection with ImageMagick or the use or other dealings in ImageMagick.

Except as contained in this notice, the name of the ImageMagick Studio shall not be used in advertising or otherwise to promote the sale, use or other dealings in ImageMagick without prior written authorization from the ImageMagick Studio.

3) From 1991 to October 1999 (through ImageMagick 4.2.9), ImageMagick was developed and distributed by E. I. du Pont de Nemours and Company: Copyright 1999 E. I. du Pont de Nemours and Company

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files ("ImageMagick"), to deal in ImageMagick without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of ImageMagick, and to permit persons to whom the ImageMagick is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of ImageMagick.
The software is provided “as is”, without warranty of any kind, express or implied, including but not limited to the warranties of merchantability, fitness for a particular purpose and noninfringement.

In no event shall E. I. du Pont de Nemours and Company be liable for any claim, damages or other liability, whether in an action of contract, tort or otherwise, arising from, out of or in connection with ImageMagick or the use or other dealings in ImageMagick.

Except as contained in this notice, the name of the E. I. du Pont de Nemours and Company shall not be used in advertising or otherwise to promote the sale, use or other dealings in ImageMagick without prior written authorization from the E. I. du Pont de Nemours and Company.

4) The GraphicsMagick Base64Decode() and Base64Encode() functions are based on source code obtained from OpenSSH. This source code is distributed under the following license: Copyright (c) 2000 Markus Friedl. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

5) Many of the pattern images in coders/logo.c are derived from XFig, which is distributed under the following license:

| FIG : Facility for Interactive Generation of figures |
| Copyright (c) 1985-1988 by Supoj Sutanthavibul |
| Parts Copyright (c) 1989-2000 by Brian V. Smith |
| Parts Copyright (c) 1991 by Paul King |

Any party obtaining a copy of these files is granted, free of charge, a full and unrestricted irrevocable, world-wide, paid up, royalty-free, nonexclusive right and license to deal in this software and documentation files (the “Software”), including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons who receive copies from any such party to do so, with the only requirement being that this copyright notice remain intact.
6) The documentation for the composition operators is copied from the rlecomp manual page, which is authored by Rod Bogart and John W. Peterson. Rlecomp is part of the Utah Raster Toolkit distributed by the University of Michigan and the University of Utah. The copyright for this manual page is as follows: Copyright (c) 1986, University of Utah

This software is copyrighted as noted below. It may be freely copied, modified, and redistributed, provided that the copyright notice is preserved on all copies.

There is no warranty or other guarantee of fitness for this software, it is provided solely "as is". Bug reports or fixes may be sent to the author, who may or may not act on them as he desires.

You may not include this software in a program or other software product without supplying the source, or without informing the end-user that the source is available for no extra charge.

If you modify this software, you should include a notice giving the name of the person performing the modification, the date of modification, and the reason for such modification.

7) The source code comprising swab.c is originally derived from libtiff which has the following license:

| Copyright (c) 1988-1997 Sam Leffler
| Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

8) The C++ API known as "Magick++", and which resides in the Magick++ directory, is distributed under the following license: Copyright 1999 - 2003 Bob Friesenhahn <bfriesen@simple.dallas.tx.us>

Permission is hereby granted, free of charge, to any person obtaining a copy of the source files and associated documentation files ("Magick++"), to deal in Magick++ without restriction, including without limitation of the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of Magick++, and to permit persons to whom the Magick++ is furnished to do so, subject to the following conditions:

This copyright notice shall be included in all copies or substantial portions of Magick++. The copyright to Magick++ is retained by its author and shall not be subsumed or replaced by any other copyright.
The software is provided "as is", without warranty of any kind, express or implied, including but not limited to the warranties of merchantability, fitness for a particular purpose and noninfringement. In no event shall Bob Friesenhahn be liable for any claim, damages or other liability, whether in an action of contract, tort or otherwise, arising from, out of or in connection with Magick++ or the use or other dealings in Magick++.

9) The GraphicsMagick HaldClutImagePixels() function in magick/hclut.c is based on source code from the HaldCLUT package by Eskil Steenberg (http://www.quelsolaar.com/technology/clut.html) which is distributed under the following license: Copyright (c) 2005 Eskil Steenberg. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

10) GraphicsMagick makes use of third-party "delegate" libraries to support certain optional features. These libraries bear their own copyrights and licenses, which may be more or less restrictive than the GraphicsMagick license. For convenience, when GraphicsMagick is bundled with (or compiled with) "delegate" libraries, a copy of the licenses for these libraries is provided in a "licenses" directory.
This distribution contains the sixth public release of the Independent JPEG Group’s free JPEG software. You are welcome to redistribute this software and to use it for any purpose, subject to the conditions under LEGAL ISSUES, below.

Serious users of this software (particularly those incorporating it into larger programs) should contact IJG at jpeg-info@uunet.uu.net to be added to our electronic mailing list. Mailing list members are notified of updates and have a chance to participate in technical discussions, etc.

This software is the work of Tom Lane, Philip Gladstone, Jim Boucher, Lee Crocker, Julian Minguillon, Luis Ortiz, George Phillips, Davide Rossi, Guido Vollbeding, Ge' Weijers, and other members of the Independent JPEG Group. IJG is not affiliated with the official ISO JPEG standards committee.

OVERVIEW
========

This package contains C software to implement JPEG image compression and decompression. JPEG (pronounced "jay-peg") is a standardized compression method for full-color and gray-scale images. JPEG is intended for compressing "real-world" scenes; line drawings, cartoons and other non-realistic images are not its strong suit. JPEG is lossy, meaning that the output image is not exactly identical to the input image. Hence you must not use JPEG if you have to have identical output bits. However, on typical photographic images, very good compression levels can be obtained with no visible change, and remarkably high compression levels are possible if you can tolerate a low-quality image. For more details, see the references, or just experiment with various compression settings. This software implements JPEG baseline, extended-sequential, and progressive compression processes. Provision is made for supporting all variants of these processes, although some uncommon parameter settings aren't implemented yet.

For legal reasons, we are not distributing code for the arithmetic-coding variants of JPEG; see LEGAL ISSUES. We have made no provision for supporting the hierarchical or lossless processes defined in the standard.

We provide a set of library routines for reading and writing JPEG image files, plus two sample applications "cjpeg" and "djjpeg", which use the library to perform conversion between JPEG and some other popular image file formats. The library is intended to be reused in other applications.

In order to support file conversion and viewing software, we have included considerable functionality beyond the bare JPEG coding/decoding capability; for example, the color quantization modules are not strictly part of JPEG decoding, but they are essential for output to colormapped file formats or colormapped displays. These extra functions can be compiled out of the library if not required for a particular application. We have also included "jpegtran", a utility for lossless transcoding between different JPEG processes, and "rdjpgcom" and "wrjpgcom", two simple applications for inserting and extracting textual comments in JFIF files.

The emphasis in designing this software has been on achieving portability and flexibility, while also making it fast enough to be useful. In particular, the software is not intended to be read as a tutorial on JPEG. (See the REFERENCES section for introductory material.) Rather, it is intended to be reliable, portable, industrial-strength code. We do not claim to have achieved that goal in every aspect of the software, but we strive for it.
We welcome the use of this software as a component of commercial products. No royalty is required, but we do ask for an acknowledgement in product documentation, as described under LEGAL ISSUES.

LEGAL ISSUES
============

In plain English:

1. We don't promise that this software works. (But if you find any bugs, please let us know!)

2. You can use this software for whatever you want. You don't have to pay us.

3. You may not pretend that you wrote this software. If you use it in a program, you must acknowledge somewhere in your documentation that you've used the IJG code.

In legalese:

The authors make NO WARRANTY or representation, either express or implied, with respect to this software, its quality, accuracy, merchantability, or fitness for a particular purpose. This software is provided "AS IS", and you, its user, assume the entire risk as to its quality and accuracy.

This software is copyright (C) 1991-1998, Thomas G. Lane.

All Rights Reserved except as specified below.

Permission is hereby granted to use, copy, modify, and distribute this software (or portions thereof) for any purpose, without fee, subject to these conditions:

(1) If any part of the source code for this software is distributed, then this README file must be included, with this copyright and no-warranty notice unaltered; and any additions, deletions, or changes to the original files must be clearly indicated in accompanying documentation.

(2) If only executable code is distributed, then the accompanying documentation must state that "this software is based in part on the work of the Independent JPEG Group".

(3) Permission for use of this software is granted only if the user accepts full responsibility for any undesirable consequences; the authors accept NO LIABILITY for damages of any kind.

These conditions apply to any software derived from or based on the IJG code, not just to the unmodified library. If you use our work, you ought to acknowledge us.

Permission is NOT granted for the use of any IJG author's name or company name in advertising or publicity relating to this software or products derived from it. This software may be referred to only as "the Independent JPEG Group's software".

We specifically permit and encourage the use of this software as the basis of commercial products, provided that all warranty or liability claims are assumed by the product vendor.

ansi2knr.c is included in this distribution by permission of L. Peter Deutsch, sole proprietor of its copyright holder, Aladdin Enterprises of Menlo Park, CA.
ansi2knr.c is NOT covered by the above copyright and conditions, but instead by the usual distribution terms of the Free Software Foundation; principally, that you must include source code if you redistribute it. (See the file ansi2knr.c for full details.) However, since ansi2knr.c is not needed as part of any program generated from the IJG code, this does not limit you more than the foregoing paragraphs do.

The Unix configuration script "configure" was produced with GNU Autoconf.

It is copyright by the Free Software Foundation but is freely distributable.

The same holds for its supporting scripts (config.guess, config.sub, ltconfig, ltmain.sh). Another support script, install-sh, is copyright by M.I.T. but is also freely distributable.

It appears that the arithmetic coding option of the JPEG spec is covered by patents owned by IBM, AT&T, and Mitsubishi. Hence arithmetic coding cannot legally be used without obtaining one or more licenses. For this reason, support for arithmetic coding has been removed from the free JPEG software. (Since arithmetic coding provides only a marginal gain over the unpatented Huffman mode, it is unlikely that very many implementations will support it.)

So far as we are aware, there are no patent restrictions on the remaining code.

The IJG distribution formerly included code to read and write GIF files.

To avoid entanglement with the Unisys LZW patent, GIF reading support has been removed altogether, and the GIF writer has been simplified to produce "uncompressed GIFs". This technique does not use the LZW algorithm; the resulting GIF files are larger than usual, but are readable by all standard GIF decoders.

We are required to state that "The Graphics Interchange Format(c) is the Copyright property of CompuServe Incorporated. GIF(sm) is a Service Mark property of CompuServe Incorporated."

Contents of png.txt file (from GraphicsMagick):

This copy of the libpng notices is provided for your convenience. In case of any discrepancy between this copy and the notices in the file png.h that is included in the libpng distribution, the latter shall prevail.

COPYRIGHT NOTICE, DISCLAIMER, and LICENSE:

If you modify libpng you may insert additional notices immediately following this sentence.

libpng versions 1.0.7, July 1, 2000, through 1.2.0, September 1, 2001, are Copyright (c) 2000 Glenn Randers-Pehrson and are distributed according to the same disclaimer and license as libpng-1.0.6 with the following individuals added to the list of Contributing Authors

Simon-Pierre Cadieux

Eric S. Raymond

Gilles Vollant

and with the following additions to the disclaimer:

There is no warranty against interference with your enjoyment of the library or against infringement. There is no warranty that our efforts or the library will fulfill any of your...
particular purposes or needs. This library is provided with all faults, and the entire risk of satisfactory quality, performance, accuracy, and effort is with the user.

libpng versions 0.97, January 1998, through 1.0.6, March 20, 2000, are Copyright (c) 1998, 1999 Glenn Randers-Pehrson, and are distributed according to the same disclaimer and license as libpng-0.96, with the following individuals added to the list of Contributing Authors:

Tom Lane
Glenn Randers-Pehrson
Willem van Schaik

libpng versions 0.89, June 1996, through 0.96, May 1997, are Copyright (c) 1996, 1997 Andreas Dilger

Distributed according to the same disclaimer and license as libpng-0.88, with the following individuals added to the list of Contributing Authors:

John Bowler
Kevin Bracey
Sam Bushell
Magnus Holmgren
Greg Roelofs
Tom Tanner

libpng versions 0.5, May 1995, through 0.88, January 1996, are Copyright (c) 1995, 1996 Guy Eric Schalnat, Group 42, Inc. For the purposes of this copyright and license, "Contributing Authors" is defined as the following set of individuals:

Andreas Dilger
Dave Martindale
Guy Eric Schalnat
Paul Schmidt
Tim Wegner

The PNG Reference Library is supplied "AS IS". The Contributing Authors and Group 42, Inc. disclaim all warranties, expressed or implied, including, without limitation, the warranties of merchantability and of fitness for any purpose. The Contributing Authors and Group 42, Inc. assume no liability for direct, indirect, incidental, special, exemplary, or consequential damages, which may result from the use of the PNG Reference Library, even if advised of the possibility of such damage. Permission is hereby granted to use, copy, modify, and distribute this source code, or portions hereof, for any purpose, without fee, subject to the following restrictions:

1. The origin of this source code must not be misrepresented.

2. Altered versions must be plainly marked as such and must not be misrepresented as being the original source.
3. This Copyright notice may not be removed or altered from any source or altered source distribution.

The Contributing Authors and Group 42, Inc. specifically permit, without fee, and encourage the use of this source code as a component to supporting the PNG file format in commercial products. If you use this source code in a product, acknowledgment is not required but would be appreciated.

A "png_get_copyright" function is available, for convenient use in "about" boxes and the like:

```c
printf("%s", png_get_copyright(NULL));
```

Also, the PNG logo (in PNG format, of course) is supplied in the files "pngbar.png" and "pngbar.jpg (88x31) and "pngnow.png" (98x31).

Libpng is OSI Certified Open Source Software. OSI Certified Open Source is a certification mark of the Open Source Initiative.

Glenn Randers-Pehrson
randeg@alum.rpi.edu

September 1, 2001

Contents of tiff.txt file (from GraphicsMagick):

Copyright (c) 1988-1997 Sam Leffler

Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics. THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND,

EXPRESSION, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Contents of zlib.txt file (from GraphicsMagick):

zlib 1.1.3 is a general purpose data compression library. All the code is thread safe. The data format used by the zlib library is described by RFCs (Request for Comments) 1950 to 1952 in the files ftp://ds.internic.net/rfc/rfc1950.txt (zlib format), rfc1951.txt (deflate format) and rfc1952.txt (gzip format). These documents are also available in other formats from ftp://ftp.uu.net/graphics/png/documents/zlib/zdoc-index.html

All functions of the compression library are documented in the file zlib.h (volunteer to write man pages welcome, contact jloup@gzip.org). A usage example of the library is
given in the file example.c which also tests that the library is working correctly. Another example is given in the file minigzip.c. The compression library itself is composed of all source files except example.c and minigzip.c.

To compile all files and run the test program, follow the instructions given at the top of Makefile. In short "make test; make install" should work for most machines. For Unix: "configure; make test; make install"

For MSDOS, use one of the special makefiles such as Makefile.msc.

For VMS, use Make_vms.com or descrip.mms.

Questions about zlib should be sent to <zlib@quest.jpl.nasa.gov>, or to Gilles Vollant <info@winimage.com> for the Windows DLL version.

The zlib home page is http://www.cdrom.com/pub/infozip/zlib/.


Before reporting a problem, please check those sites to verify that you have the latest version of zlib; otherwise get the latest version and check whether the problem still exists or not.

Mark Nelson <markn@tiny.com> wrote an article about zlib for the Jan. 1997 issue of Dr. Dobb's Journal; a copy of the article is available in http://web2.airmail.net/markn/articles/zlibtool/zlibtool.htm

The changes made in version 1.1.3 are documented in the file ChangeLog.

The main changes since 1.1.2 are:

- fix "an inflate input buffer bug that shows up on rare but persistent occasions" (Mark)
- fix gzread and gztell for concatenated .gz files (Didier Le Botlan)
- fix gzseek(..., SEEK_SET) in write mode
- fix crc check after a gzeek (Frank Faubert)
- fix miniunzip when the last entry in a zip file is itself a zip file (J Lilge)
- add contrib/asm586 and contrib/asm686 (Brian Raiter)
  
  See http://www.muppetlabs.com/~breadbox/software/assembly.html
- add support for Delphi 3 in contrib/delphi (Bob Dellaca)
- add support for C++Builder 3 and Delphi 3 in contrib/delphi2 (Davide Moretti)
- do not exit prematurely in untgz if 0 at start of block (Magnus Holmgren)
- use macro EXTERN instead of extern to support DLL for BeOS (Sander Stoks)
- added a FAQ file

plus many changes for portability.
Unsupported third party contributions are provided in directory "contrib". A Java implementation of zlib is available in the Java Development Kit 1.1:

http://www.javasoft.com/products/JDK/1.1/docs/api/Package-java.util.zip.html

See the zlib home page http://www.cdrom.com/pub/infozip/zlib/ for details.

A Perl interface to zlib written by Paul Marquess <pmarquess@bfsec.bt.co.uk> is in the CPAN (Comprehensive Perl Archive Network) sites, such as:


A Python interface to zlib written by A.M. Kuchling <amk@magnet.com> is available in Python 1.5 and later versions, see:

http://www.python.org/doc/lib/module-zlib.html

A zlib binding for TCL written by Andreas Kupries <a.kupries@westend.com> is avaliable at http://www.westend.com/~kupries/doc/trf/man/man.html

An experimental package to read and write files in .zip format, written on top of zlib by Gilles Vollant <info@winimage.com>, is available at http://www.winimage.com/zLibDll/unzip.html and also in the contrib/minizip directory of zlib.

Notes for some targets:

- To build a Windows DLL version, include in a DLL project zilib.def, zlib.rc and all .c files except example.c and minigzip.c; compile with -DZLIB_DLL

The zlib DLL support was initially done by Alessandro Iacopetti and is now maintained by Gilles Vollant <info@winimage.com>. Check the zlib DLL home page at http://www.winimage.com/zLibDll

From Visual Basic, you can call the DLL functions which do not take a structure as argument: compress, uncompress and all gz* functions.

See contrib/visual-basic.txt for more information, or get http://www.tcfb.com/dowseware/cmp-z-it.zip

- For 64-bit Irix, deflate.c must be compiled without any optimization. With -O, one libpng test fails. The test works in 32 bit mode (with the -n32 compiler flag). The compiler bug has been reported to SGI.

- zlib doesn't work with gcc 2.6.3 on a DEC 3000/300LX under OSF/1 2.1 it works when compiled with cc.

- on Digital Unix 4.0D (formely OSF/1) on AlphaServer, the cc option -std1 is necessary to get gzprintf working correctly. This is done by configure.

- zlib doesn't work on HP-UX 9.05 with some versions of /bin/cc. It works with other compilers. Use "make test" to check your compiler.

- gzdopen is not supported on RISCOS, BEOS and by some Mac compilers.

- For Turbo C the small model is supported only with reduced performance to avoid any far allocation; it was tested with -DMAX_WBITS=11 -DMAX_MEM_LEVEL=3

- For PalmOs, see http://www.cs.uit.no/~perm/PASTA/pilot/software.html

Acknowledgments:
The deflate format used by zlib was defined by Phil Katz. The deflate and zlib specifications were written by L. Peter Deutsch. Thanks to all the people who reported problems and suggested various improvements in zlib; they are too numerous to cite here.

Copyright notice:

(C) 1995-1998 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied warranty. In no event will the authors be held liable for any damages arising from the use of this software.

Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it and redistribute it freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you wrote the original software. If you use this software in a product, an acknowledgment in the product documentation would be appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the original software.

3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly        Mark Adler
jloup@gzip.org          madler@alumni.caltech.edu

If you use the zlib library in a product, we would appreciate *not* receiving lengthy legal documents to sign. The sources are provided for free but without warranty of any kind. The library has been entirely written by Jean-loup Gailly and Mark Adler; it does not include third-party code.

If you redistribute modified sources, we would appreciate that you include in the file ChangeLog history information documenting your changes.

Progress OpenEdge v11.3 may incorporate International Classes for Unicode (International Components for Unicode) v2.4 from IBM. Such technology is subject to the following terms and conditions:  ICU License - The ICU project is licensed under the X License (see also the x.org original), which is compatible with GPL but non-copyleft. The license allows ICU to be incorporated into a wide variety of software projects using the GPL license. The X license is compatible with the GPL, while also allowing ICU to be incorporated into non-open source products.  License ICU License - ICU 1.8.1 and later COPYRIGHT AND PERMISSION NOTICE Copyright (c) 1995-2003 International Business Machines Corporation and others All rights reserved. Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the “Software”), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, provided that the above copyright notice(s) and this permission notice appear in all copies of the Software and that both the above copyright notice(s) and this permission notice appear in supporting documentation. THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Progress OpenEdge v11.3 may incorporate Jaxen v1.1-beta-3 from jaxen.org. Such technology is subject to the following terms and conditions: Project License $Id: LICENSE.txt 1128 2006-02-05 21:49:04Z elharo $ Copyright 2003-2006 The Werken Company. All Rights Reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the name of the Jaxen Project nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Progress OpenEdge v11.3 may incorporate Jing 20030619 portion of Progress Extensions for Eclipse v2.2.1. Such technology is subject to the following terms and conditions: Jing Copying Conditions. Copyright (c) 2001-2003 Thai Open Source Software Center Ltd. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the name of the Thai Open Source Software Center Ltd nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE. Third-party JARs - This distribution includes some additional JAR files, which have their own copying conditions:

saxon.jar Comes from the Saxon 6.5.2 distribution and is covered by these conditions
xercesImpl.jar xml-apis.jar Come from the Xerces-J 2.4.0 distribution and are covered by the Apache Software License isorelax.jar Comes from ISO RELAX 2003/01/08 distribution and is covered by the following license: Copyright (c) 2001-2002, SourceForge ISO-RELAX Project (ASAMI Tomoharu, Daisuke Okajima, Kohsuke Kawaguchi, and MURATA Makoto) Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions: The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software. THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Progress OpenEdge v11.3 may incorporate Sun's Jmaki framework v1.0 and Sun's Jmaki framework v1.0.3 from Sun Microsystems, Inc. Such technology is subject to the following terms and conditions: Copyright 1994-2006 Sun Microsystems, Inc. All Rights Reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
Redistribution of source code must retain the above copyright notice, this list of conditions and the following disclaimer. Redistribution in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the name of Sun Microsystems, Inc. or the names of contributors may be used to endorse or promote products derived from this software without specific prior written permission. This software is provided "AS IS," without a warranty of any kind. ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE HEREBY EXCLUDED. SUN MICROSYSTEMS, INC. ("SUN") AND ITS LICENSORS SHALL NOT BE LIABLE FOR ANY DAMAGES SUFFERED BY LICENSEE AS A RESULT OF USING, MODIFYING OR DISTRIBUTING THIS SOFTWARE OR ITS DERIVATIVES. IN NO EVENT WILL SUN OR ITS LICENSORS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR DIRECT, INDIRECT, SPECIAL, CONSEQUENTIAL, INCIDENTAL OR PUNITIVE DAMAGES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OF OR INABILITY TO USE THIS SOFTWARE, EVEN IF SUN HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. You acknowledge that this software is not designed, licensed or intended for use in the design, construction, operation or maintenance of any nuclear facility.

Progress OpenEdge v11.3 may incorporate Jmaki framework v1.8.0 from Sun Microsystems, Inc. Such technology is subject to the following terms and conditions: Copyright 1994-2006 Sun Microsystems, Inc. All Rights Reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: * Redistribution of source code must retain the above copyright notice, this list of conditions and the following disclaimer. *
Appendix A: Third Party Acknowledgements

Redistribution in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the name of Sun Microsystems, Inc. or the names of contributors may be used to endorse or promote products derived from this software without specific prior written permission. This software is provided "AS IS," without a warranty of any kind. ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE HEREBY EXCLUDED. SUN MICROSYSTEMS, INC. ("SUN") AND ITS LICENSORS SHALL NOT BE LIABLE FOR ANY DAMAGES SUFFERED BY LICENSEE AS A RESULT OF USING, MODIFYING OR DISTRIBUTING THIS SOFTWARE OR ITS DERIVATIVES. IN NO EVENT WILL SUN OR ITS LICENSORS BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL, CONSEQUENTIAL, INCIDENTAL OR PUNITIVE DAMAGES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OF OR INABILITY TO USE THIS SOFTWARE, EVEN IF SUN HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. You acknowledge that this software is not designed, licensed or intended for use in the design, construction, operation or maintenance of any nuclear facility.

Progress OpenEdge v11.3 may incorporate JSTL v1.0 from Sun Microsystems, Inc. Such technologies are subject to the following terms and conditions: Code sample License Copyright 1994-2006 Sun Microsystems, Inc. All Rights Reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: Redistribution of source code must retain the above copyright notice, this list of conditions and the following disclaimer. Redistribution in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the name of Sun Microsystems, Inc. or the names of contributors may be used to endorse or promote products derived from this software without specific prior written permission. This software is provided "AS IS," without a warranty of any kind. ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE HEREBY EXCLUDED. SUN MICROSYSTEMS, INC. ("SUN") AND ITS LICENSORS SHALL NOT BE LIABLE FOR ANY DAMAGES SUFFERED BY LICENSEE AS A RESULT OF USING, MODIFYING OR DISTRIBUTING THIS SOFTWARE OR ITS DERIVATIVES. IN NO EVENT WILL SUN OR ITS LICENSORS BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL, CONSEQUENTIAL, INCIDENTAL OR PUNITIVE DAMAGES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OF OR INABILITY TO USE THIS SOFTWARE, EVEN IF SUN HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. You acknowledge that this software is not designed, licensed or intended for use in the design, construction, operation or maintenance of any nuclear facility.

Progress OpenEdge v11.3 may incorporate Looks v2.1.2 from JGoodies. Such technology is subject to the following terms and conditions: The BSD License for the JGoodies Looks - Copyright (c) 2001-2007 JGoodies Karsten Lentzsch. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: o Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the name of JGoodies Karsten Lentzsch nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written
permission. THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Progress OpenEdge v11.3 may incorporate OpenSSL v0.9.8 from The OpenSSL Project. Such technology is subject to the following terms and conditions: OpenSSL License. Copyright (c) 1998-2006 The OpenSSL Project. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. All advertising materials mentioning features or use of this software must display the following acknowledgment: "This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)." 4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact openssl-core@openssl.org. 5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their names without prior written permission of the OpenSSL Project. 6. Redistributions of any form whatsoever must retain the following acknowledgment: "This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)." THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

OpenSSL includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product includes software written by Tim Hudson (tjh@cryptsoft.com). Original SSLeay License. Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved. This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The implementation was written so as to conform with Netscapes SSL. This library is free for commercial and non-commercial use as long as the following conditions are aheared to. The following conditions apply to all code found in this distribution, be it the RC4, RSA, Ihash, DES, etc., code; not just the SSL code. The SSL documentation included with this distribution is covered by the same copyright terms except that the holder is Tim Hudson (tjh@cryptsoft.com). Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be removed. If this package is used in a product, Eric Young should be given attribution as the author...
of the parts of the library used. This can be in the form of a textual message at program startup or in documentation (online or textual) provided with the package.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain the copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. All advertising materials mentioning features or use of this software must display the following acknowledgement: "This product includes cryptographic software written by Eric Young (eay@cryptsoft.com)." The word 'cryptographic' can be left out if the routines from the library being used are not cryptographic related :-). 4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application code) you must include an acknowledgement: "This product includes software written by Tim Hudson (tjh@cryptsoft.com)." THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The licence and distribution terms for any publically available version or derivative of this code cannot be changed. i.e. this code cannot simply be copied and put under another distribution licence [including the GNU Public Licence.]

Progress OpenEdge v11.3 may incorporate Quartz Enterprise Job Scheduler v1.3.2 from James House. Such technologies are subject to the following terms and conditions: Copyright James House (c) 2001-2003 All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. THIS SOFTWARE IS PROVIDED BY THE AUTHOR AND CONTRIBUTORS ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION). HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. This product uses and includes within its distribution, software developed by the Apache Software Foundation (http://www.apache.org/).

Progress OpenEdge v11.3 may incorporate relaxngDatatype.jar portion of Progress Extensions for Eclipse v2.2. Such technology is subject to the following terms and conditions: Copyright (c) 2001, Thai Open Source Software Center Ltd, Sun Microsystems. All rights reserved. Redistribution and use in source and binary forms,
with or without modification, are permitted provided that the following conditions are met: Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the names of the copyright holders nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Progress OpenEdge v11.3 may incorporate SLF4J v1.6.2 and SLF4J Log4J v1.6.1 from slf4j.org. Such technology is subject to the following terms and conditions:

Copyright (c) 2004-2008 QOS.ch All rights reserved. Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions: The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software. THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Progress OpenEdge v11.3 may incorporate STAX API (JSR 173) v3.1.1 from Woodstox Project. Such technology is subject to the following terms and conditions:

Copyright (c) 2004-2010, Woodstox Project (http://woodstox.codehaus.org/) All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of the Woodstox XML Processor nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Progress OpenEdge v11.3 may incorporate Trang 20030619 portion of Progress Extensions for Eclipse v2.2.1. Such technology is subject to the following terms and conditions: Copyright (c) 2002, 2003 Thai Open Source Software Center Ltd. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the name of the Thai Open Source Software Center Ltd nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REAGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Progress OpenEdge v11.3 may incorporate xpp3-1.1.3.4.O portion of Progress Extensions for Eclipse v2.2.1. Such technology is subject to the following terms and conditions: Indiana University Extreme! Lab Software License Version 1.1.1 Copyright (c) 2002 Extreme! Lab, Indiana University. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment:

"This product includes software developed by the Indiana University Extreme! Lab (http://www.extreme.indiana.edu/)."
Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party acknowledgments normally appear.

4. The names "Indiana University" and "Indiana University Extreme! Lab" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact http://www.extreme.indiana.edu/.

5. Products derived from this software may not use "Indiana University" name nor may "Indiana University" appear in their name, without prior written permission of the Indiana University.

THIS SOFTWARE IS PROVIDED "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHORS, COPYRIGHT HOLDERS OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Progress OpenEdge v11.3 may incorporate XStream v1.3.1 from XStream. Such technology is subject to the following terms and conditions: Copyright (c) 2003-2006, Joe Walnes Copyright (c) 2006-2007, XStream Committers All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the name of XStream nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Progress OpenEdge v11.3 may incorporate YAJL v0.4.0 from Lloyd Hilaiel. Such technology is subject to the following terms and conditions: Copyright 2007, Lloyd Hilaiel. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. Neither the name of Lloyd Hilaiel nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED BY THE AUTHOR "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Progress OpenEdge v11.3 may incorporate GNU ZLIB v1.1.4 and GNU ZLIB v1.2.3 from Jean-loup Gailly & Mark Adler. Such technology is subject to the following terms and conditions: Copyright notice: (C) 1995-2002 Jean-loup Gailly and Mark Adler This software is provided 'as-is', without any express or implied warranty. Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it and redistribute it freely, subject to the following restrictions: 1. The origin of this software must not be misrepresented; you must not claim that you wrote the original software. If you use this software in a product, an acknowledgment in the product documentation would be appreciated but is not required. 2. Altered source versions must be plainly marked as such, and must not be
misrepresented as being the original software. 3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly        Mark Adler
jloup@gzip.org          madler@alumni.caltech.edu

Progress OpenEdge v11.3 may incorporate ZLIB.NET Free v1.0.4 from ComponentAce. Such technology is subject to the following terms and conditions:
Copyright (c) 2006-2007, ComponentAce http://www.componentace.com All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the name of ComponentAce nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Progress OpenEdge v11.3 may incorporate LALR Parser Generator in Java v0.10k. Such technology is subject to the following terms and conditions: CUP Parser Generator Copyright Notice, License, and Disclaimer – Copyright 1996-1999 by Scott Hudson, Frank Flannery, C. Scott Ananian - Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the names of the authors or their employers not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. The authors and their employers disclaim all warranties with regard to this software, including all implied warranties of merchantability and fitness. In no event shall the authors or their employers be liable for any special, indirect or consequential damages or any damages whatsoever resulting from loss of use, data or profits, whether in an action of contract, negligence or other tortious action, arising out of or in connection with the use or performance of this software.

Progress OpenEdge v11.3 includes the RSA Data Security, Inc. MD5 Message-Digest Algorithm. Copyright ©1991-2, RSA Data Security, Inc. Created 1991. All rights reserved. (MD5 Encryption Library v3.0 and MD5 Encryption vMD5C.C) These technologies are subject to the following terms and conditions: RSA Data Security MD5 message-digest algorithm RSA Data Security, Inc. MD5C.C - RSA Data Security, Inc., MD5 message-digest algorithm Copyright (C) 1991-2, RSA Data Security, Inc. Created 1991. All rights reserved. License to copy and use this software is granted provided that it is identified as the "RSA Data Security, Inc. MD5 Message-Digest Algorithm" in all material mentioning or referencing this software or this function. License is also granted to make and use derivative works provided that such works are identified as "derived from the RSA Data Security, Inc. MD5 Message-Digest
Algorithm™ in all material mentioning or referencing the derived work. RSA Data Security, Inc. makes no representations concerning either the merchantability of this software or the suitability of this software for any particular purpose. It is provided "as is" without express or implied warranty of any kind. These notices must be retained in any copies of any part of this documentation and/or software.
# Index

## A
- Allocation 26
- Area working set 110
- Areas 25
  - viewing 68
- Authentication systems 124

## B
- Buffer pool 81

## C
- Color legend 78
- Committing changes 113

## Configuration
- database connections 27
- for remote hosts 29

## Connections
- configuring for a database 27

## D
- Data Definition file
  - loading 44, 106
  - preview 107
- Database Administration Console
  - features 18
  - working with 18
- Database Administration menu 23
- Database connections
  - configuring 27
  - filtering 37
  - setting up 31
- Databases
  - adding domains 121
  - adding users 118
  - connection details 41
  - deleting domains 123
  - deleting users 120
  - Dumping data from groups 62
  - Dumping data from tables 56
  - dumping group contents 62
  - dumping table contents 56
  - enabling for multi-tenancy 40
  - features 42
  - Loading data to groups 52
  - Loading data to tables 45
  - loading group contents 52
  - loading table contents 45
  - managing multi-tenant 39
  - modifying domains 123
  - modifying users 120
  - security summary 42
  - table security for users 126
- Deallocating tenant tables 102
- Default tenant 25
- Disabling access to tenant data 100
- Domains
  - adding for a tenant 90
  - adding to databases 122
  - deleting 123
  - modifying database 123
viewing 69, 74
Dumping database contents 56

E
editgroup 168

Enabling access to tenant data 100

Enhancements
  Database Administration Console 18
  navigation 22
Exporting sequences 152, 157

F
Filtering
  database connections 37
  tenant partitions 74, 77

G
Group Contents
  dumping 62
  Loading 52
Group program
  creating 163
Groups 25
  adding tenants 169
  creating 163
  guidelines for using 162
  removing tenants from 174
  searching for 173
  viewing details 172
  viewing in a list 171
  working with 161

L
Loading a data definition file 44, 106
Loading database contents 45

M
Managed database 28
Managing multi-tenant databases 39

Multi-tenancy
  allocation 26
  areas 25
  common terminology 25
  enabling databases for 40
  enabling tables for 97
  groups 25
  partitions 25
  task viewlet 24
  tenants 25
  tuning performance 66

Multi-tenancy tasks viewlet 115

P
Partitions 25
  allocating tenant 80
  filtering 74
Permissions
  reviewing for users 129
  user 126

R
Regular tenant 25
Remote configuration requirements 29

S
Schema
  updating 105
  uploading new 106
  viewing 70
Scripted database 28
Security
  for database table users 126
Security administrators 36, 131
Security summary 42

Sequences
  creating multi-tenant 151
  details 44
  editing values 154
  exporting current values 152
  exporting for a tenant 157
  functionality and user credentials 150
  loading data definition file of 151
  restoring values 156
  types 150
  values 150
  viewing list of 152
  working with 149

Setting up local host machine for remote
configuration 30
Storage area assignments 112
Super-tenant 25
T

Table Contents
dumping 56
loading 45

Tables
deallocating 102
enabling for multi-tenancy 94

Tenant
creating 82

Tenant configuration program 81

Tenant program 93
creating 82

Tenant templates
allocation considerations 138
creating 139
creating tenant from 146
editing 148
filtering partitions 144
using 138
viewing in a list 145
working with 137

Tenants 25
adding domains 90
adding users 92
creating 80
deleting 94
editing 88

enabling or disabling data access for 100
removing from groups 174
viewing 70
working with 79

Terminology
multi-tenancy 25

U

Ungluing from OpenEdge 29

Unmanaged database connection 28

User credentials
for database connection 31

Users
adding to a database 118
adding to a tenant 92
database table security 126
deleting from a database 120
modifying for a database 120
reviewing permissions 129
viewing 73

V

Viewing
multi-tenant areas, domains,
schemas, tenants, groups 67